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Note
Before using this information and the product it supports, read the information in “Notices” on page 184.
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Edition notice
This edition applies to version 5, release 5, modification 0 of the IBM OMEGAMON products and to version 6, 
release 3, Fix Pack 6 and above of IBM Tivoli Management Services on z/OS (product number 5698-A79) and to 
all subsequent releases and modifications until otherwise indicated in new editions.
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Product overview

The OMEGAMON® enhanced 3270 user interface (enhanced 3270UI) is the latest generation of user interfaces 
for the OMEGAMON® monitoring products on z/OS®. Using the enhanced 3270UI in conjunction with 
OMEGAMON® monitoring agents and the Tivoli® Enterprise Monitoring Server, you can monitor the performance 
of the z/OS® systems, applications, and devices in your environment and identify and troubleshoot problems 
with those monitored resources.

The enhanced 3270UI offers the following features:

Plex-wide and single-system views of data

Autodiscovery of and autoconnection to data sources

Dynamic behavior and operation

User-customizable workspaces

Data filtering

Cross-product embedded data.

Near-term History

The enhanced 3270UI supports screen sizes up to 62 x 160, sorting by column, and lateral and vertical 
scrolling.

In the interface, data is presented in workspaces. The monitoring products that support the enhanced 3270UI 
provide predefined workspaces that you can use to quickly and easily diagnose problems with monitored 
resources and take action to correct them. You can customize the workspaces to suit your requirements, and 
design and create your own workspaces and navigation.

Because the enhanced 3270UI exploits data collected by OMEGAMON® monitoring agents, viewing data in the 
interface requires that at least one Tivoli Enterprise Monitoring Server is installed in your environment, in 
addition to any monitoring agents that support the interface. When you navigate to a workspace, one or more 
data queries are sent to the Tivoli Enterprise Monitoring Server. The monitoring server collects the data from the 
target agent or agents and sends the data to the interface for display in the workspace.

The following products support both the OMEGAMON Subsystem and the OMEGAMON Enhanced 3270 User 
Interface features:

OMEGAMON for CICS (KC5)

OMEGAMON® AI for Db2 (KD5)

OMEGAMON for IMS on z/OS (KI5)

OMEGAMON for z/OS (KM5)

OMEGAMON for Storage on z/OS (KS5)

The following products support the OMEGAMON Enhanced 3270 User Interface feature and are installed in the 
same CSI as the OMEGAMON Enhanced 3270 User Interface:

OMEGAMON for CICS TG (KGW)

OMEGAMON for JVM (KJJ)

OMEGAMON for Messaging - MQ (KMQ)

OMEGAMON for Messaging - Integration Bus (KQI)

OMEGAMON for Networks (KN3)

The following product supports the OMEGAMON Enhanced 3270 User Interface feature and are installed in a 
separate CSI from the OMEGAMON Enhanced 3270 User Interface:

IBM Db2 Query Monitor for z/OS V3.2 (KQQ)

The following products support TSO and ISPF interface OMNIMON Base feature as an alternative to logging onto 
Classic OMEGAMON via VTAM interface:

OMEGAMON for CICS (KC5)
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OMEGAMON® AI for Db2 (KD5)

OMEGAMON for IMS on z/OS (KI5)

What's new in the OMEGAMON enhanced 3270 user interface 
(previous updates)

The topics in this section introduce new features and enhancements to the OMEGAMON enhanced 3270 user 
interface.

OMEGAMON enhanced 3270 user interface V7.5.0 PTF UA93322 (3Q17)
OMEGAMON enhanced 3270 user interface 7.5.0 PTF is UA93322 introduces new enhancements since the 
previous version.

The following enhancements have been made to the OMEGAMON enhanced 3270 user interface (enhanced 
3270UI) 7.5.0:
Situation Editor enhancement

A more user-friendly way of editing the formula of a situation via the Situation Formula workspace 
(KOBSEDPA). The formula is displayed in the workspace as a set of rows and columns. Each column is the 
name of a monitoring system attribute or the name of another situation. When you edit the cells by typing 
the E action character in the cell, a series of pop-up windows will display with the following items to choose 
from:

Available tables and columns

Available functions (VALUE, AVERAGE, etc.)

Available operators (EQ, NE, etc.)

Available values (strings, numbers, and ENUM values.)

OMEGAMON enhanced 3270 user interface PTF UA83356 for APAR 
OA51564

APAR OA51564 introduces new enhancements since the previous version.

The following enhancements have been made to the OMEGAMON enhanced 3270 user interface (enhanced 
3270UI) with APAR OA51564 (PTF UA83356):
Situation Editor

You can use the Situation Editor to create, view, and edit situations (including the formula, distribution, 
expert advice, action, and until conditions) that can monitor important conditions in your environment. Each 
situation monitors your environment constantly by testing a formula at time intervals that you set up, for 
example, every 5 minutes. You can view the overall status of your environment in the Situation Status tree.
Type / to select option rows. Move between areas in the Situation Editor by selecting a tab on top.

Some screens contain highlighted push buttons, through which you can access additional Situation Editor 
features.

Object Editor

You can use the Object Editor to organize managed systems and situations into name groups which you can 
reference in distribution lists.
The tree shows the types of object groups that are available and groups that have been created.

There are 2 types of groups available to be created.
Managed System

Tip: You can also access a list of the latest features and enhancements using the online help in the 
product, by expanding the HELP menu and selecting W Whats New.
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Any set of managed systems that are related, such as business function or by geography, can be 
organized into a managed system group for assigning to situation distributions. The tree lists all 
available managed system types including All Managed Systems for creating managed system groups 
that combine multiple managed system types.

Situation

For a set of frequently distributed situations, you can create a situation group to save time and ensure 
consistency in applying your best practices.

Security Requirements

The new Situation Editor and Object Editor functions that are introduced in this PTF are disabled by default 
due to possible performance impact of certain situations. The following security resource profiles must be 
defined for these editors.

KOBUI.ADMIN.SITEDITOR

KOBUI.ADMIN.OBJECTEDITOR

O4SRV.**

Use combinations of read, update, or none for the profiles to control the access to the editors.

To view the editors, the users must have either read or update permission to the corresponding 
editor profiles (KOBUI.ADMIN.SITEDITOR for the Situation Editor and 
KOBUI.ADMIN.OBJECTEDITOR for the Object Editor). Users with none permission to the profiles are 
not able to access the editors.

To save updates in the editors, the users must have read or update permission to the O4SRV.**
profile, as well as either read or update permission to the corresponding editor profiles. Users with 
none permission to the O4SRV.** profile are not able to save updates in the editors.

OMEGAMON enhanced 3270 user interface PTF UA82170 for APAR 
OA50563

APAR OA50563 introduces new enhancements since the previous version.

The following enhancements have been made to the OMEGAMON enhanced 3270 user interface (enhanced 
3270UI) with APAR OA50563 (PTF UA82170):
Memory Display/Zap workspace

You can display or modify the memory within any address space on a system where an OMEGAMON on z/OS 
agent connecting to the selected HUB TEMS is running. To list memory, select the Memory option from the 
enhanced 3270UI View pull-down menu (fastpath V.M). The Memory Display/Zap workspace is displayed.
This workspace can also be invoked from another workspace in the enhanced 3270UI. To invoke this panel 
in context, the ASID and ADDRESS variables must be set before invoking the Memory Display/Zap 
workspace via the ACTION statement in the callers' workspace. Both the ASID and Address fields must be 
integer values when the Memory Display/Zap workspace is invoked.

The new first workspace after log in

The new first workspace is a tabbed dialog from which you can choose the tab that you want to see first. 
You can choose the first tab by using Edit › Preferences, or invoking Help › What's New. By default, the first 
tab shows workspace KOBSEVTS.
The first tab shows information about active situations that are running in the connected Hub TEMS. If the 
OMEGAMON Dashboard edition is installed in the e3270UI address space, the situations are displayed as a 
status tree instead of a simple summary. The status tree shows historical information of each situation so 
that you can assess the overall health situation from one screen.

Other tabs display information of different OMEGAMON agents. Place your cursor on the tab and press Enter 
to enter the tab. If you have the 3270 emulator configured for mouse operations, double-click the tab that 
you want to enter.

Note: Situation groups can be added to other situation groups.
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OMEGAMON enhanced 3270 user interface PTF UA80299 for APAR 
OA49686

APAR OA49686 introduces new enhancements since the previous version.

The following enhancements have been made to the OMEGAMON enhanced 3270 user interface (enhanced 
3270UI) with APAR OA49686 (PTF UA80299):
Product support

New support has been added for the following products:

OMEGAMON for JVM on z/OS

OMEGAMON for Messaging on z/OS: IBM Integration Bus Monitoring agent

KOBSTART alternate workspace

The OMEGAMON Products workspace (KOBSEVTS, which displays events) is a useful alternative to the 
existing Enterprise Summary workspace (KOBSTART) as the first workspace when you log on. You can 
select this workspace as your initial workspace with the following steps:

Click on E (Edit)

Click on P (Preferences)

Click on the Session/Logon tab

Select one of the following options:

Change "First workspace to be displayed" to KOBSEVTS

Click on "Help" and follow instructions to make the currently viewed tab of the workspace be 
your new first workspace

User filter support

User filter support has been expanded to include all subpanels in a workspace.

Performance improvements

APAR OA49686 (PTF UA80299) introduces the following performance improvements for environments 
where the ITM installation contains many distributive systems:

Much less data is requested and processed when performing a registry refresh

CPU load reduction in Hub TEMS and TOM

TCP traffic volume reduction between the TOM, DRA address spaces, and Hub TEMS

Performance data availability improvement in TOM

OMEGAMON enhanced 3270 user interface PTF UA76751 for APAR 
OA46867

APAR OA46867 introduces new enhancements since the previous version.

The following enhancements have been made to the OMEGAMON enhanced 3270 user interface (enhanced 
3270UI) with APAR OA46867 (PTF UA76751):
Concurrent user sessions

Up to 100 concurrent enhanced 3270 user interface sessions are supported.

Support for non-APL emulators

There are new options for running emulators with limited or no APL characters, and a Screen Test for 
determining which APL characters are supported.

BACK and HOME buttons

For enhanced navigation, the BACK and HOME buttons are available on every workspace.

On-screen indicator for off-screen threshold condition
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For enhanced problem determination, the highest severity off-screen threshold condition is indicated by the 
color of the left or right arrow.

Ability to cancel enhanced 3270 user interface users

If correct SAF authorizations are in place, users can be selectively cancelled from the list shown in Tools -> 
Active 3270 Users.

Product table and attribute displays

Creating new workspaces is facilitated by Object Definition Interchange (ODI) support, which lists products, 
tables and column definitions that can be used in QUERY statements.

Filter indications

Filters icons are shown on-screen in the column heading as Green (Defined) or Yellow (Active), to indicate if 
all data rows in the subpanel are displayed. The icons are also zoom-selectable for editing.

OMEGAMON enhanced 3270 user interface V7.3.0

Enhanced 3270UI near-term history display
The Enhanced 3270UI now supports the display of near-term history collected by OMEGAMON® XE and 
IBM® Tivoli® Monitoring agents. Near-term history display provides the ability to investigate problems in the 
recent past. Security authorization checks have been extended to include access and updates to near-term 
history collection.
If your security implementation is configured to deny access to undefined SAF resources by default, you 
must update your configuration to secure near-term history (NTH) configuration actions. To secure history 
updates, the O4SRV.** resource must be added to either the global security class (RTE_SECURITY_CLASS) or 
the query class (KOB_SAF_QUERY_CLASS_NAME) if it is used. To secure access to the near-term history 
workspaces, the KOBUI.ADMIN.DEFINEHISTORY.<hub name> resource must be added to the security 
class used to control user interface interactions such as navigation.

To enable collection of NTH data, you must allocate data sets to store the collected data, configure 
maintenance of those data sets, and configure what data is collected.

Dynamic hub switching
You can now dynamically specify which hub you want to view data from. Previously, you had to modify the 
user profile to change hubs. Now you can switch hubs from the interface without modifying the profile.

Multi-hub support
You can use the multi-hub support feature to select a secondary hub monitoring server connection.

Continuous operation
The address space no longer needs to be recycled when an agent is upgraded.

Support for IPv6
Support for IPv6 has been added to the existing IP capability, enabling configurations that employ IPv4 
only, IPv6 only, or mixed IPv4 and IPv6.

Enhanced 3270UI embedded data
The Enhanced 3270UI embedded-data feature can be used to bring relevant data from other products into 
the workspace of the hosting product. The embedded-data feature imports data from other products in a 
seamless manner that can enable the user to navigate in context directly to other product workspaces.

New user preference options

You can choose whether your tab key can be used to move between action bar options and also 
whether it can be used to move to and between push buttons.

You can configure various history configuration settings.

Display of alias commands
You can use the View menu to see a list of Alias commands that can be used on the action and command 
lines.
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OMEGAMON enhanced 3270 user interface V7.0.0 Interim Feature 1 
(APAR OA42127)

APAR OA42127 introduces new enhancements since the previous version.

The following enhancements have been made to the OMEGAMON enhanced 3270 user interface (enhanced 
3270UI) for OMNIMON Base V7.0.0:

Security authorization checks have been extended and enhanced. For more information, see “Security” on 
page 17.

User preferences can be customized by using the User Profile Member workspace. For more information, 
see “Customizing a user profile” on page 53.

You can use the new KOBSITEC workspace to display IBM® Tivoli® Monitoring Situations status information 
in the enhanced 3270UI. The status information is similar to the information provided by the Tivoli®
Enterprise Portal Situation Event Console, that is, situation status for current situations events and 
situation event history. For more information, see “Customizing KOBSITEC as the initial workspace” on 
page 55.

Workspaces are introduced to support viewing and browsing the Runtime environment (RTE). For more 
information, see “Runtime environment viewing” on page 91.

Workspace source can be viewed and browsed. For more information, see “Viewing a workspace source” 
on page 93

Cloning and customization

The capability to view and copy product provided workspaces, thresholds, and profiles is introduced. 
You modify workspaces, thresholds, and profiles by first cloning (making a copy) and then editing the 
copy by using a file editor such as the ISPF editor. For more information, see “Workspace viewing and 
cloning” on page 59, “Preparing for threshold member cloning” on page 80, and “Profile viewing and 
cloning” on page 94.

Guidance on the customization of product provided workspaces is included. For more information, see 
“Customization of product provided workspaces” on page 64.

The action bar has updated menu and context-sensitive capabilities. For more information, see “Menus” on 
page 24.

The User Interface drawer is introduced. For more information, see “Drawer” on page 23.

Hub connectivity administration is used to validate that a requested hub Tivoli® Enterprise Monitoring 
Server is reachable through a TCP/IP connection during the operation of the enhanced 3270UI. For more 
information, see “Hub connectivity administration” on page 98.

OMEGAMON® Enhanced 3270 user interface component summary
The following OMEGAMON® components facilitate the display of data in the OMEGAMON® Enhanced 3270 user 
interface (enhanced 3270UI).

OMEGAMON® Agents

The OMEGAMON® V5.1.1 and V5.3.0 agents (for example, OMEGAMON® for CICS® or OMEGAMON® for z/
OS®, among others) deliver capability that builds on the enhanced 3270UI infrastructure to provide 
OMEGAMON® capability on the enhanced 3270UI.

Hub Tivoli Enterprise Monitoring Server

Monitoring servers are part of the Tivoli® Management Services infrastructure that is shared by 
OMEGAMON® agents. The enhanced 3270UI requires Tivoli® Management Services V6.3.2 or higher.

The hub monitoring server is the monitoring server that acts as the focal point for data collection and 
distribution; it communicates with monitoring agents, with the enhanced 3270UI, and with other Tivoli®
Management Services components.

Monitoring servers that communicate only with the monitoring agents that report to them and with the hub 
monitoring server are referred to as remote monitoring servers. The hub monitoring server receives data 
requests from the enhanced 3270UI through the data retrieval agent (KOBAGENT) and drives OMEGAMON®
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agents for data collection and retrieval. The hub monitoring must be seeded with OMEGAMON® V5.3.0 
agent data.

OMEGAMON® Enhanced 3270 user interface address space

The enhanced 3270UI address space provides data retrieval and user interface 3270 interaction functions. 
One or more enhanced 3270UI can be deployed in a specific z/OS® Sysplex.

OMEGAMON® Enhanced 3270 user interface data retrieval agent (KOBAGENT)

This component runs in any z/OS® monitoring server or Tivoli® OMEGAMON® Agent address space. The 
enhanced 3270UI data retrieval agent receives data requests from the enhanced 3270UI and connects to 
the hub monitoring server to drive data collection by OMEGAMON® V5.3.0 monitoring agents.
There must be at least one enhanced 3270UI data retrieval agent that is deployed and running in the 
Sysplex where components of a specific configuration (hub or remote monitoring servers and agents) are 
running to enable enhanced 3270UI data retrieval and display. The enhanced 3270UI must also run in the 
same Sysplex as the OMEGAMON® Enhanced 3270 user interface data retrieval agent.

The components that are mentioned earlier must be installed, configured, started, and running to enable 
successful rendering of OMEGAMON® agent data on the enhanced 3270UI. The OMEGAMON® agent 
configuration step that adds support for the V5.3.0 monitoring agent to the hub monitoring server must be 
performed to enable successful rendering of OMEGAMON® agent data on the enhanced 3270UI.

Communications and data retrieval
The enhanced 3270UI uses WLM Services to discover Data Retrieval Agents that are running in its Sysplex. The 
interface uses TCP/IP services to communicate with Data Retrieval Agents.

The Data Retrieval Agent uses TCP/IP services to communicate with the hub monitoring server. The Data 
Retrieval Agent uses WLM Services to register or publish their existence within the Sysplex.

The OMEGAMON® monitoring agents use TCP/IP or SNA services to communicate with the monitoring servers. 
The monitoring agents register with the hub monitoring server as part of the startup process.

The enhanced 3270UI uses VTAM services when you log on and communicate with the interface. You log on to 
the enhanced 3270UI through a VTAM APPLID that is opened during startup of the interface.

The following figure shows the OMEGAMON® configuration that includes deployment of these enhanced 3270 
interface components:

OMEGAMON® Enhanced 3270 user interface address space

OMEGAMON® Enhanced 3270 user interface Data Retrieval Agent (KOBAGENT)
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Figure 1: OMEGAMON configuration that includes deployment of the enhanced 3270 interface components

Minimal configuration
The following minimal configuration must be addressed to enable the enhanced 3270UI to select and connect 
to a hub monitoring server:
OMEGAMON® Enhanced 3270 user interface logon profile

You must create one or more custom logon profiles. These profiles specify the settings for the hub 
monitoring server from which data is collected. The RKOBPROF DD statement in the enhanced 3270UI 
started task JCL procedure specifies the data set that contains the site and user logon profile settings. The 
customized site or user profiles are stored as members of the rte.UKOBDATF data set. When you log on, the 
enhanced 3270UI looks for a profile member named user_id (the ID of the logged on user) or CUASITE (a 
site-customized profile) to establish profile settings for the session.
You can establish a site or user_id named logon profile member by copying (and renaming) the KOBCUA 
product provided profile member from the target thilev.TKOBDATF library or the runtime rte.TKOBDATF
data set to the runtime rte.UKOBDATF data set.

From Tivoli® Management Services Version 6.3.2 (APAR OA42127), you can use the User Profile Member
workspace to customize user profiles. For more information about customizing a user profile, see 
“Customizing a user profile” on page 53.

For an alternative method of creating and customizing a logon profile, see “Profile viewing and cloning” on 
page 94.

Hub monitoring server settings

Tivoli® Management Services V6.3.2 (APAR OA42127) or later.

The settings for the hub monitoring server settings are specified in the logon profile member. By 
default, the following setting statements are provided:

HUBNAME=HUBNAME                  
HUBIPADDRESS=::ffff:HUBADDRESS   
HUBPORTNUMBER=HUBPORTNUMBER 

Edit the profile member copy to specify the wanted hub settings; locate and update the statements.

For example:
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HUBNAME=HUB1:CMS   
HUBIPADDRESS=::ffff:9.44.44.22
HUBPORTNUMBER=55555

Tivoli® Management Services V6.3 or earlier (pre-APAR OA42127).

The settings for the hub monitoring server settings are specified in the logon profile member. By 
default, the settings are provided as commented statements:

/* HUBNAME=HUBNAME                  
/* HUBIPADDRESS=::ffff:HUBADDRESS   
/* HUBPORTNUMBER=HUBPORTNUMBER 

Edit the profile member copy to specify the wanted hub settings; locate, uncomment, and update the 
statements; for example, remove the leading /* and move the setting statements to begin in column 
one.

For example:

HUBNAME=HUB1:CMS   
HUBIPADDRESS=::ffff:9.44.44.22
HUBPORTNUMBER=55555

HUBNAME

The configured name of the hub monitoring server. The monitoring server might be configured to run on 
the z/OS or distributed system; for example, Linux. Often a hub monitoring server is configured to run 
on distributed systems that employs a mixed-case or all lowercase naming convention. The value that 
is specified in your profile setting statements must match the case of the configured value.

HUBIPADDRESS

The TCP/IP address of the host system where the hub monitoring server runs. The setting must be an 
TCP/IP address as shown in the preceding example; do not specify a TCP/IP host name.

HUBPORTNUMBER

The TCP/IP port number of the configured hub monitoring server. The default port number is 1918.

Component startup and operation
The following components comprise the startup and operation environment for the OMEGAMON® Enhanced 
3270 user interface and the OMEGAMON® agents:
OMEGAMON® Enhanced 3270 user interface address space

Although startup of the enhanced 3270UI address space is relatively fast, it is ideally the last component in 
the startup sequence; because the interface requires that all other components in its environment (the 
OMEGAMON® monitoring agents, the Data Retrieval Agent, and the hub and or remote monitoring servers) 
be initialized and running before it is able to retrieve data.

OMEGAMON® Enhanced 3270 user interface local registry

The enhanced 3270UI startup process discovers registered Data Retrieval Agents and connects to related 
hub monitoring servers to establish a local registry of data source information; that is, managed systems 
names and managed system lists. After startup, by default, the registry is refreshed on a 5-minute interval.

OMEGAMON® agent and OMEGAMON® Enhanced 3270 user interface Data Retrieval Agent

The OMEGAMON® V5.3.0 agent address spaces run both an instance of the product agent and also an 
instance of an enhanced 3270UI Data Retrieval Agent. The Data Retrieval Agent uses WLM services to 
publish or register its existence. The product agent registers with the hub monitoring server; these 
registration processes facilitate enhanced 3270UI discovery of OMEGAMON® agents. Some OMEGAMON®
agents, such as OMEGAMON® for z/OS®, run under a remote z/OS® monitoring server; the enhanced 3270UI 
Data Retrieval Agent also runs under remote z/OS® monitoring servers.

OMEGAMON® agent startup process

There might be cases where an OMEGAMON® agent startup process requires up to 10 minutes to complete 
startup and registration. As a result, the enhanced 3270UI cannot retrieve data for that agent during this 
period.
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OMEGAMON® agent recycle

There might be cases where an OMEGAMON® agent address space is terminated (for example, LPAR 
shutdown, goes offline) and, in some cases, the agent is performing the role of a proxy agent. As a result, 
the enhanced 3270UI cannot retrieve data for that agent until the offline agent condition is resolved; for 
example, in a multi-LPAR configuration another agent assumes the proxy-agent role.

Hub Tivoli® Enterprise Monitoring Server

To enable the enhanced 3270UI data retrieval, the hub Tivoli® Enterprise Monitoring Server must be:

Running Tivoli® Management Services V6.3.2 or higher

Seeded with IBM OMEGAMON® for Db2 Performance Expert on z/OS V5.3.0 or higher agent data

Started and connectable through TCP/IP; listening on the configured TCP/IP port

Be connected or online IBM OMEGAMON® for Db2 Performance Expert on z/OS V5.3.0 or higher agents

Configuration
The enhanced 3270 user interface is controlled and configured by a set of runtime libraries and parameter files. 
The configuration process defines the address space controls and logical VTAM connections required to run the 
interface.

The interface can be configured by using PARMGEN or Configuration Manager. For instructions on configuring 
the interface, see Configuring products and components on z/OS.

See “Administration” on page 91 for information on customizing interface settings and modifying workspaces.

Supported emulators and screen sizes
The enhanced 3270 user interface can be used with any 3270 emulator that supports the APL character set. 
The interface supports screen sizes of 24 x 80, 32 x 80, 43 x 80, 27 x 132, and 62 x 160.

Although a 24 x 80 screen size is supported, given its limited area, use a larger screen size if possible. The 
minimum suggested screen size is 43 x 80.

Some 3270 emulators do not support the APL characters that the enhanced 3270 user interface requires. An 
option is available for running the enhanced 3270 user interface with limited APL characters. To view all APL 
characters that are used by the enhanced 3270 user interface, select the Help > Screen Test menu option. To 
determine if your 3270 emulator supports the APL characters used by the interface, compare the results from 
selecting Help > Screen Test to the following screen shot, where all APL characters are supported:

To change the level of APL graphics support for your emulator, select the Edit > Preferences menu option. On 
the ISPF tab, select one of the following options for your emulator:
FULL

Full APL graphics support.

LINE

APL graphics support for box lines only.

Note: Some (non-IBM) emulators can require LOGMODE settings such as D4A32XX3.

https://www.ibm.com/docs/SSAUBV/common/configuring_intro_kc.htm
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Logging on and off
The enhanced 3270 user interface supports authorization, when you log on. A valid user ID defined to the 
security system in force on the system is required. Typically, this ID is a TSO ID.

Logging on
You log on to the enhanced 3270 user interface by using its Applid (for example, LOGON APPLID(OMEGUI), 
and then enter your user ID and password at the logon panel. Typically, this ID is the TSO user ID. Your site 
might also require a group name and password. The interface also supports a password phrase (passphrase) of 
9 or more characters, up to the available screen width.

Before you begin
The enhanced 3270 user interface address space, the OMEGAMON monitoring agents for which you want data, 
and the hub Tivoli Enterprise Monitoring Server from which you will be requesting data, must be started before 
you log on to the interface. If security is configured for the interface, you need a user ID. The user ID must be 
defined to the system authorization facility (SAF) and can be different from the ID used to log on to the Tivoli 
Enterprise Portal interface.

About this task
To log on, use the following procedure.

Procedure
Start a new VTAM 3270 session.

At the VTAM logon panel, enter the following command, where applid is the VTAM Applid that is 
assigned to the enhanced 3270 user interface address space:
LOGON APPLID(applid)
The enhanced 3270 user interface logon panel is displayed:

Enter your user ID and password (typically, this ID is one of your TSO IDs). Mixed-case IDs are supported. 
The interface also supports password phrases up to the available width of the screen. Your site can also 
require a group name and password.

Press Enter.
The initial workspace is displayed. By default, you see an overview workspace for all installed products 
that support the user interface (KOBSTART). However, a different initial workspace might be specified in 
your site or user profile. If a hub monitoring server is not specified in your profile, the Hub Connectivity 
Administration workspace is displayed. For more information, see “Logon administration and 
customization” on page 56.

Logging off
There are several ways to log off from the enhanced 3270 interface. Use any of the methods described.

Procedure
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From the action line or the command line of any workspace, enter EXIT, LOGOFF, QUIT, or =X.

From the initial logon workspace, press F3 to display an Exit menu with the choice of exiting or resuming. 
Enter 1 or X to exit, or 2 or R to resume working with the interface.

From the File menu, select Exit, then press Enter.

Security
The enhanced 3270 user interface (enhanced 3270UI) authenticates user identity by using the system 
authorization facility (SAF) interface. All authentication or authorization failures are logged. All Take Action 
requests are logged.

System Authorization Facility
The existence of the SAF user ID and its validity are always checked. The enhanced 3270UI also runs a number 
of SAF authorization checks to check whether the user has authority to do the following activities:

Log on to this instance of the enhanced 3270 user interface

End User activities

View data for a specific attribute group (table) on a specific managed system

Transmit a Take Action request to a specific managed system

Change auto-update preferences

Entry of any command on the command line

Create and modify a profile member name with the same name as the user ID of the user

Use a specific hub Tivoli® Enterprise Monitoring Server

Administrative activities

List enhanced 3270 user interface users, and optionally end a user's session

Save a data set member

Start or stop user interface tracing

Start or stop internal tracing

Modify (Save As) any PDS member that is named with a different user ID to that of the current user

Near-term history configuration

User permissions and the amount of security that is imposed are assigned by site administrators. Authorization 
works as follows:

If no SAF security class is supplied (value for RTE_SECURITY_CLASS is missing or blank), users can log on 
to the OMEGAMON® enhanced 3270UI, can access data through queries, but cannot issue Take Action 
commands.

If a SAF security class is supplied, but the class is not defined and active in SAF, no one can log on to the 
OMEGAMON® enhanced 3270UI.

If a SAF security class is supplied, and is defined and active in SAF, but no logon profile is defined, no one 
can log on to the OMEGAMON® enhanced 3270UI.

If a user is able to log on, and a different security class than the one used for logon is used for queries or for 
Take Action commands (but is not activated or resources are not defined in that security class), everyone 
can view data for any managed system and perform other commands and activities, but all Take Action 
commands are denied.

If a security class name is configured, resource profiles must be defined to control log on, data access, and 
Take Actions, and users must be given access to those profiles.

Enabling e3270UI PassTicket generation
Requests to either display or zap memory from the e3270UI require a secured sign-on from the enhanced 
3270UI to the OMEGAMON on z/OS monitoring agent. The enhanced 3270UI will generate a PassTicket (a one 
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time only password) and send it to the OMEGAMON on z/OS monitoring agent in the data request. In this way 
the monitoring agent can authenticate the request that comes from the user logged into the enhanced 3270UI.

In order for a PassTicket to be generated, the PTKTDATA security class must be activated. To activate the 
PTKTDATA class and the SETROPTS RACLIST processing, run the following command.

SETROPTS CLASSACT(PTKTDATA) RACLIST(PTKTDATA) GENERIC(PTKTDATA) 

By using the PassTicket key class the security administrator can associate a RACF secured sign-on secret key 
with a particular mainframe application that uses RACF for user authentication. All profiles that contain 
PassTicket information are defined to the PTKTDATA class.

Configuring security resource profiles
See Enable security for the OMEGAMON enhanced 3270 user interface for information about how security 
works and how to configure security resource profiles.

Starting from OMEGAMON enhanced 3270 user interface PTF UA83356 for APAR OA51564, you can use the 
Situation Editor and Object Editor for situation and group management. However, the new Situation Editor and 
Object Editor functions that are introduced in this PTF are disabled by default due to possible performance 
impact of certain situations. The following security resource profiles must be defined for these editors.

KOBUI.ADMIN.SITEDITOR

KOBUI.ADMIN.OBJECTEDITOR

O4SRV.**

Use combinations of read, update, or none for the profiles to control the access to the editors.

To view the editors, the users must have either read or update permission to the corresponding editor 
profiles (KOBUI.ADMIN.SITEDITOR for the Situation Editor and KOBUI.ADMIN.OBJECTEDITOR for the 
Object Editor). Users with none permission to the profiles are not able to access the editors.

To save updates in the editors, the users must have read or update permission to the O4SRV.** profile, 
as well as either read or update permission to the corresponding editor profiles. Users with none
permission to the O4SRV.** profile are not able to save updates in the editors.

Data Facility Storage Management System (DFSMS)
The following activities are separately secured by the Data Facility Storage Management System (DFSMS):

Display a member list for a data set

Browse the contents of a data set member

Save a data set member

User Experience
When users are not authorized to run an activity, they are prevented from running the activity regardless of the 
attempted method, for example, whether by using a menu item, command line, or function key.

When users attempt to run an activity that they are not authorized to, a message similar to the following is 
displayed on their screen:

Figure 2: Security system denied request message.

The administrator can check the SYSPRINT log file to see additional details about the request that is denied. For 
example, for the message shown an entry similar to the following can be found in the SYSPRINT log file:

https://www.ibm.com/docs/en/SSAUBV/zcommonconfig/complete_security_e3270_cpcg.html
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USER2    KOBUICS2I SAF R15=00000008 CLASS($KOBTEST) RESOURCE(KOBUI.ADMIN.TRACE.UI.BASIC ) 
RC=00000008 RSN=00000000

Getting help
You can view column and menu help, and a general Help Directory in the enhanced 3270 user interface. If help 
information is available for a specific workspace you are viewing, then that Help information will be displayed in 
place of the Help Directory when you enter the HELP command.

Column help
You can get help for any workspace column by positioning your cursor in the field with the column name and 
pressing F1. A menu is displayed containing a description of the attribute for the data that is being displayed. A 
question mark (?) entered in column 1 of a summary type subpanel also displays help for the column. For an 
example, see “Help for column headings” on page 31.

Menu help
The action bar Help menu displays information about the following enhanced 3270 user interface items:

Commands

PFKeys

Icons

Navigation

Auto Update

Refresh

Screen Test

Help Contents

About OMEGAMON

What's New

For more information about menus, see “Menus” on page 24.

The enhanced 3270 user interface displays all of the information from the Help menu in a tree structure in the 
Help and Workspace Directory.

Help and Workspace Directory
You can use this workspace to view all menu help and navigate to OMEGAMON and enhanced 3270 user 
interface workspaces.

Within a workspace, there are three ways to navigate to the Help and Workspace Directory (KOBHLDIR)
workspace:

Issue the HELP command from any workspace.

Issue an h.h fast path mnemonic in the upper left portion of your screen.

Expand the HELP menu and select H Help Contents.

The KOBHLDIR workspace is presented in a tree structure, meaning you can expand branches by selecting the 
plus sign (+) and collapse branches by selecting the minus sign (-). Within this workspace, you are able to 
access all topics from the HELP menu and navigate to several Overview workspaces within the current 
enhanced 3270 user interface session.

The following is an example of the Help and Workspace Directory (KOBHLDIR) workspace:
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Figure 3: Help Tree.
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Workspaces

Workspaces are panels that display collected data and analytic, diagnostic, or explanatory information. 
Workspaces can contain up to 15 subpanels, displaying various type of data or information. Workspace panels 
can be overlaid by pop-up panels that present navigation or action options, help for a particular field, or 
additional information. You navigate among workspaces by zooming to preset destinations, entering an action 
code in an input field, or by selecting a destination from an action popup panel.

Parts of the workspace
A typical workspace consists of an action bar, a header, up to 15 subpanels, and a footer.

Action bar
The action bar is the first line of the workspace. The bar has an input field on the left side, and a set of dropdown 
menus across the length of the line. You can use the input line to enter navigation and action commands and 
mnemonics of up to 16 bytes. The date and time of the session is displayed to the right of the action bar.

Header

The workspace header consists of the following parts:
Command line

The command line beneath the action bar is also used to enter navigation, action commands and 
mnemonics, but allows as many bytes as can fit on your screen (that is, the number of bytes allowed 
depends on the size of the screen).

Panel ID

The identifier of the workspace. The panel ID is the name of the PDS member in which the workspace panel 
is defined. The panel ID is located in the upper left corner of the workspace below the Command line.
You can use the panel ID to navigate to a specific workspace. An alias may be assigned to a panel ID by 
IBM® or by your site to simplify navigation.

Workspace title

A descriptive title that identifies the content of the workspace as a whole.

Auto Update status

An indicator of whether automatic refresh is in effect or not. This field is adjustable by the user. If the auto 
update feature is enabled, the field displays the refresh interval in effect. If the auto update feature is 
disabled, the field displays Off. If auto update is automatically suspended, the field displays SUS.

Plex ID

This field identifies the plex (IMSplex, Sysplex, CICSplex) for which data is being displayed. The label and 
purpose of this field may vary from workspace to workspace and from monitoring product to monitoring 
product. The field may be blank, for example in a multiproduct workspace such as KOBSTART, or if the 
fields are locked.

System ID

This field, under the Plex ID, identifies the subsystem, LPAR, or region for which data is being displayed. 
The label and purpose of this field may vary from workspace to workspace and from monitoring product to 
monitoring product. The field may be blank, for example in a multiproduct workspace such as KOBSTART, 
or if the fields are locked.

Note: You are free to copy, modify, use, and distribute the data and information in all workspaces in the 
RKANWENU dataset.
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Subpanels
There are four types of subpanels: detail, summary, ISPF, and HTML.

In detail panels, multiple data points for a single resource are displayed. The name of the attributes for which 
data is being displayed appears to the left of the value.

In summary subpanels, data for multiple resources is presented in tabular form, one row for each resource, with 
columns providing values for the system or application attributes being monitored by the agent, such as Disk 
Name and Disk Read/Writes Per Second.

If defined thresholds are reached, data is highlighted with colors indicating the status of the item.

Figure 4: Workspace with detail and summary subpanels

Summary and detail subpanels can contain some or all of the following elements:
Header

A descriptive title for the subpanel.

Collapse and Expand controls

Selecting the

control collapses the contents of the subpanel so only the header is displayed. If the subpanel is collapsed, 
selecting the  icon expands the subpanel. See “Collapsing and expanding subpanels” on page 36 for more 
information.

Columns ___ field (summary subpanels only)

A writeable field that indicates at which column of data the scrollable part of the display begins. Entering a 
column number in the field and pressing Enter scrolls the display to that column. If no further columns are 
available, the field is blue.

Left, right, up, down scrolling arrows (summary subpanels only)

Scrolls the width or depth of the subpanel. If there is a threshold condition off to the left or right of the data 
that is presented on the screen, the left or right arrow will reflect the color of the highest severity off-screen 
threshold.

Minimize, maximize, close controls
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Minimize removes the subpanel from the workspace and puts the subpanel title in the minimize bar at the 
bottom of the workspace. Placing your cursor under the title in the bar and pressing Enter expands the 
subpanel to its former position.

Maximize expands the subpanel to fill the entire screen. The icon changes to indicate that the subpanel is 
maximized.

The

Close control closes the subpanel entirely.

See “Minimizing and maximizing subpanels” on page 36 and “Closing subpanels” on page 37 for more 
information.

Rows ___ field (summary subpanels only)

Indicates at which row of data the display begins. If the field is green, entering a row number in the field 
and pressing Enter scrolls the display to that row. If no additional rows are available, the field is blue.

Subpanel footer

Contains additional information about the data in the subpanel.

ISPF and HTML subpanels consist of an optional header and text that provides additional information about the 
workspace, such as why the user was brought to this workspace.

Footer
The workspace footer contains a minimize bar. If subpanels are minimized, their headers appear in the bar. If 
there is more data available than is displayed on the screen, a MORE indicator is displayed. Up or down arrows 
beside the text indicate the direction of the additional data that is not currently displayed on the screen. If Trace 
is enabled, a TRACE indicator is displayed; however, if there is more data to be displayed, the MORE indicator 
takes precedence over the TRACE indicator.

Figure 5: Minimize bar with ECSA subpanel minimized to bar and MORE indicator with down arrow

Drawer
The drawer is an alternative way to go quickly to administrative workspaces, and products from the footer area. 
The drawer can be opened to reveal navigation icons or closed to hide the icons.
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In the closed position, the drawer is signified by the Open Drawer icon <<.

To open the drawer move your cursor to the Open Drawer icon, and press Enter, or double-click the icon, if this 
method is enabled for your 3270 emulator session. For more information about enabling double-clicking, see 
“Associating a mouse click with the Enter key” on page 182.

When the drawer is open, a number of icons are available. To go to the workspace or action that is associated 
with a specific icon, move your cursor to the icon and press Enter, or double-click the icon. The following icons 
are available:
HUB

Use this icon to go to the Hub Connectivity Administration workspace.

RTE

Use this icon to go to the Runtime Environment workspace.

NAV

This icon opens a lateral navigation area in the footer area. In the lateral navigation area, push buttons 
represent products or workspaces that you can navigate to, for example, these push buttons can be used to 
navigate to installed products:
To go to a specific product, move your cursor to the icon and press Enter, or double-click the icon.

ODI

Use this icon to display the list of products that are installed in the Enhanced 3270 User Interface. You can 
display the products, tables and column definitions that are defined in the Object Definition Interchange. 
When creating new workspaces, for example, this view shows you the actual table and column names to 
use in a QUERY statement.

When the drawer is open, the Close Drawer icon >> is available. To close the drawer, move your cursor to the 
Close Drawer icon >>, and press Enter, or double click the icon, if this method is enabled for your 3270 
emulator session. For more information about enabling double-clicking, see “Associating a mouse click with the 
Enter key” on page 182.

Menus
The enhanced 3270 user interface contains a menu bar at the top of the screen. Any item in the menu bar can 
be selected by pressing the Enter key while the cursor is on the item. A pull-down menu will then appear 
showing additional menu items.

You can access the menus in three ways:

Place your cursor on the menu item and press Enter.

Select the menu item with your mouse if this method is enabled for your 3270 emulator session (usually a 
double click or a single click from a mouse button). For more information about enabling mouse selection, 
see “Associating a mouse click with the Enter key” on page 182.

You can use fast path commands to select a menu item by entering an abbreviated command on the 
action line or command line. The letters that you enter in the abbreviated fast path command are listed 
under each menu. For example, you can enter the fast path command v.s as an alternative to selecting 

•

•

Tip:

To open the lateral navigation area, press the PF9 key.

When the lateral navigation area opens, the drawer closes.
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the menu option View › S Workspace Source. Similarly, you can enter the fast path command e.p as an 
alternative to selecting the menu option Edit › P Preferences.

The following menus are available:
File

The options that are enabled are context-sensitive. Some options might not be available either because 
they are not available from the current workspace or because they are not available in this version.
N New

This option is not available in this version.

O Open

Opens the Runtime Environment (Workspaces) workspace, which provides directory lists for the user 
workspace data set (UKANWENU DD) and the runtime environment workspace data set (RKANWENU 
DD). You can use this workspace for browsing and locating workspaces.

S Save

This option is not available in this version.

A Save As

Saves a copy of the current workspace. This option is available when viewing a workspace PDS member 
or an in-memory PDS member.

P Print Screen

Writes a copy of the current screen to SYSOUT1.

X Exit/Logoff

Exits the current interface session.

Edit

The Edit menu offers the following selections:
S Situations

Invokes the Situations Editor, which you use to create situations that monitor important conditions in 
your enterprise.

O Objects

Invokes the Object Group Editor, which you use to organize managed systems and situations into 
groups that you can reference in distribution lists.

P Preferences

Displays user profile information. For more information, see “Customizing a user profile” on page 53.

W First Workspace

Invokes the Customize your First Workspace Display, where you specify which system or subsystems 
to include on the status tree and select which views to include for each product tab.

View

The View menu offers the following selections:
F Filters

Displays a list of filterable items for the current workspace, if any are defined.

T Thresholds

Displays the Runtime Configuration workspace for viewing Threshold definitions members. The 
workspace displays information for the RTE data sets that contain the threshold definition members.

Tip: Product-provided threshold definition members are named IBMSITE, CUASITE, or 
KppTHRESH, where pp is the two-digit product code identifier; for example, M5 for the 
OMEGAMON® for z/OS® product.
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A Alias Commands

Displays a list of alias commands that you can type on the action line or command line to go directly to a 
workspace view.

S Workspace Source (On Disk)

Displays the contents of the RKANWENU PDS member used to create the current on-screen workspace.

W Workspace Source (In-memory)

Displays the in-memory, resolved (parsed) version of the RKANWENU PDS member for the current on-
screen workspace.

M Memory

Invokes the Memory Display/Zap workspace, which is part of the OMEGAMON for z/OS product. Use 
this workspace to browse memory in target subsystems, such as CICS, IMS, and Db2.

H History Configuration

Use this option to configure historical data collection for an application.

R History Refresh

Use this option to refresh the historical data view. This option is available only when viewing history 
data.

I History Timespan

Use this option to select the time period to view for historical data.

Q Last Query Performance

Displays time measurements for the last workspace ENTER key cycle. You can also use the SHOWQUERY
command to display this information.

P Session Performance

Displays SQL performance metrics for the entire enhanced 3270 user interface session. You can also 
use the PERF command to display this information.

Tools

The Tools menu offers the following options:
I Trace (User Interface)

Engages trace for the current session. You select the process that you want to enable trace on from a 
pop-up menu.

A Trace (Address Space)

Engages trace for the entire address space. You select the component that you want to enable trace on 
from a pop-up menu.

R Registry Refresh

Refreshes the registry that lists all managed system names, managed system lists, and data retrieval 
agents.

Important: Do not use this option except as directed by IBM® Software Support.

Warning: When you engage trace, the volume of messages that are written to the output log files 
increases (typically JES output). If trace is engaged for an extended period, the output can 
exceed site limits and cause an enhanced 3270 user interface address space termination.

Important: Do not use this option except as directed by IBM® Software Support.



27

T Threshold Refresh

Refreshes the threshold definitions from disk.

U Active 3270 Users

Displays a list of active users and details about their sessions.

H Current Hub Information

Displays information about your hub connection.

P Products Installed in Hub

Displays the products that are installed on the hub.

S Switch Between Hubs

Switches the hub to use for queries, if secondary hub support is in effect.

D Discard the Secondary Hub

Removes the secondary hub assignment for this session, with the option of updating the user's profile, 
if secondary hub support is in effect.

E Runtime Environment

Displays information about the Runtime Environment (RTE).

G Global Timeout Control

Displays the workspace query timeout value.

V Internal Variables

Displays a list of internal variables.

O ODI (Object Definitions)

Displays the list of products that are installed in the enhanced 3270 user interface. You can display the 
products, tables and column definitions that are defined in the Object Definition Interchange. When 
creating new workspaces, for example, this view shows you the actual table and column names to use 
in a QUERY statement.

F SDA (Self-Describing Agents)

Displays any self-describing agent (SDA) status information.

Navigate

Use the Navigate menu to navigate to different products. Products that are available are shown in the color 
white. Products that are not available are shown in the color blue. Products that are installed locally in the 
interface but are not available in the connected hub monitoring server are shown in the color yellow.
Z z/OS

z/OS® summary.

C CICS

CICS® summary.

G CICS/TG

CICS® Transaction Gateway summary.

I IMS

IMS™ summary.

D DB2

Db2® summary.

N Networks

Network health summary.

M MQ
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MQ summary.

B Integration Bus

Integration Bus summary.

S Storage

Storage summary.

J JVM

JVM summary.

H Home

First workspace.

E Events Console

Enterprise Status Tree.

Help

The Help menu displays help for the enhanced 3270 user interface. The following topics are covered:
C Commands

Help for commands and the command line.

P PFKeys

Help for the Program Function (PF) keys.

I Icons

Help for the enhanced 3270 user interface icons.

N Navigation

Help for navigating by using commands, PF keys, icons, and pull-down menu options.

U Auto Update

Help for the OMEGAMON® Auto Update feature.

R Refresh

Help for different types of refreshes: History, Registry and Thresholds.

S Screen Test

Helps determine if the 3270 emulator in use can display the APF characters used by the interface.

H Help Contents

A tree displaying the help topics and available workspaces for the current enhanced 3270 user 
interface session.

A About OMEGAMON

A pop-up window that lists the following information for the current enhanced 3270 user interface
session:

enhanced 3270 user interface version and level

User ID

VTAM® applid

Jobname

LPAR ID

Operating System

Sysplex

TCP/IP host and address
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Dashboard Edition (enabled or disabled)

OMEGAMON monitoring product and component versions

W Whats New

Navigates to the Help and Workspace Directory and expands the New Features branch, which displays 
recent updates to the enhanced 3270 user interface.

Registry Refresh
The registry refresh process is used to obtain current component information for display in the Enhanced 3270 
User Interface (enhanced 3270UI). The information gathered is about Hub Tivoli Enterprise Monitoring Servers, 
Data Retrieval Agents, Managed System Lists, and Managed System Names.

The enhanced 3270UI uses information (names, IP addresses, member lists, etc.) about hub monitoring 
servers, Data Retrieval Agents, Managed System Lists, and Managed System Names to satisfy queries issued 
from the enhanced 3270UI workspaces. This information changes over time as hub monitoring server, remote 
monitoring server, and managed systems are started, stopped, and recycled. The enhanced 3270UI must have 
up to date information about each of these components to successfully retrieve complete information for 
display in the enhanced 3270UI.

The process used by the enhanced 3270UI to obtain current information about these components is called 
Registry Refresh. The Registry is the cache of information (in each Tivoli Omegamon Manager address space) 
about each of these components (hub monitoring servers, Data Retrieval Agents, Managed System Lists, and 
Managed System Names) that is Refreshed periodically to maintain currency with component changes. 
Typically, this Registry Refresh occurs within a Tivoli Omegamon Manager address space every five minutes, and 
this refresh obtains current information about each of the components listed in the previous sentence. This 
refreshed information is obtained by performing queries to several monitoring server tables, namely the 
O4SRV.INODESTS and O4SRV.TNODELST tables.

If component changes occur between Registry Refreshes (an OMEGAMON agent is started or stopped, or a CICS 
region (a managed system) is started, for example), the Registry is out of date until the next Registry Refresh 
occurs, which means an enhanced 3270UI workspace that attempts to gather data from that OMEGAMON agent 
or about that CICS region will not result in complete data being returned to the enhanced 3270UI. If you view a 
workspace and there appears to be missing data rows for any part of the workspace, you can manually force a 
Registry Refresh.

There are three ways to force a Registry Refresh:

On the enhanced 3270UI command line, type: rrefresh

Select Tools › Registry Refresh from the menu bar.

Use the MVS modify command from the system console as follows: /F eif,REGREFRESH, where eif is the 
started task for the enhanced 3270UI address space.

Status indicators
Status lights are highlight colors that indicate the status of monitored system components. The status is 
determined by a set of thresholds applied against the component.

By default, the colors and the statuses they represent are as follows:
GREEN

OKGOOD

YELLOW

WARNING

RED

CRITICAL

BLUE

IDLE

TURQUOISE
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HIGHLIGHT

BLUE

UNKNOWN

Thresholds may also be defined in terms of ranges. The default colors and the ranges they represent are as 
follows:
GREEN

Ranges 1–3

YELLOW

Ranges 4–6

RED

Ranges 7–9

The values or range represented by each status are set in threshold definitions. You can change the colors 
assigned to each threshold in the interface profile for your site or for individual users (see “Customizing status 
indicators” on page 80. Each monitoring agent provides predefined thresholds with its workspaces. You can 
modify these preset threshold criteria to suit your site (see“Modifying predefined thresholds” on page 80). In 
subsequent releases, you will be able to set your own thresholds.

Example

In the following example, the Performance Index values are all in the Warning range:

Workspace colors
In workspaces, colors identify types of text and fields.

The following list defines the default colors for various elements of a workspace:
WHITE

Boxlines, items available for selection or zooming

YELLOW

Main header, subpanel header, subpanel footer

Note: By default, status of OK or GOOD is not indicated (that is, there is no highlighting).
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TURQUOISE

Column header, body text

GREEN

Input, command line

BLUE

Action bar, panel ID

These colors are controlled by the interface profile in effect for the user (the KOBCUA, CUASITE, or user profile). 
You can modify any of these colors.

Help for column headings
Help is provided for column headings in workspaces.

Within a workspace, you can place your cursor on a column heading or anywhere within the column, and press 
PF1 to view help about the column.

The following is an example for the Enterprise Summary KOBSTART workspace:
Place your cursor on the LPAR Group Capacity Limit column of the All Active Sysplexes panel.

Press PF1.

The help for LPAR Group Capacity Limit is displayed:

Figure 6: Column heading help.

A question mark (?) entered in column 1 of a summary type subpanel also displays help for the column.

Screen operations
Within a workspace, you can scroll up, down, left, and right in subpanels using PFKeys or commands, or by 
entering column or row numbers in input fields. In summary subpanels, you can also use scrolling icons. You 
can sort the data in columns and add, modify, and remove filters on eligible columns. You can also reset the 
context for the data displayed in the workspace.

Action codes
Action codes are entered in the input area associated with a field.

In summary subpanels, the items in the first column are typically selectable. To view a list of actions applicable 
to an item, type / on the input field in front of the item and press Enter:
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The Options Menu is displayed:

The Options Menu displays the available actions and the possible navigation alternatives for that item, along 
with the action code for those options. Type the list number or the letter for the action in the entry field on the 
menu and press Enter to select an option. The actions available and the action codes associated with them vary 
from workspace to workspace.

If you know the letter associated with a particular action item, you can enter it directly on the workspace. Type 
the letter in the input field in front of an item and press Enter. Entering S selects the default action (or 
navigational option). You can also select the default action by placing the cursor in the input field and pressing 
Enter.

Take Action commands
You can issue certain commands from the enhanced 3270 user interface. These commands are referred to as 
Take Action commands.

Individual commands may be listed in the Options Menu popup. They are prefixed by a hyphen (-):

Additional commands may be available in a list of Take Action commands accessed from the Action Command 
menu. The list of Take Action commands is invoked by entering an exclamation point (!) in the Action Command 
menu, or by entering it in the input field for the applicable item.
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Scrolling
The enhanced 3270 user interface uses two types of scrolling: local and global. The type of scrolling that takes 
effect depends on the location of the cursor.

If the cursor is set in a subpanel when a scrolling command is executed, scrolling is local; that is, only the 
subpanel in which the cursor is located is affected. If all the subpanels in the workspace are displayed and the 
cursor is set outside a subpanel (for example, on the command line), scrolling applies to all the subpanels in the 
workspace. If there are subpanels that are not displayed (so the MORE indicator appears at the bottom of the 
screen), vertical scrolling with the cursor set outside the subpanels scrolls down an entire screen to display the 
remaining subpanels. If a subpanel is maximized, the MORE indicator at the bottom of the screen is suppressed 
and full screen scrolling is disabled. You can only scroll the contents of the maximized subpanel.

Use any of the following methods to scroll within all subpanels or within a specific subpanel.

To scroll to the last or first n-number of rows or columns (where n is the maximum number of rows or 
columns that can be displayed on the screen), use any of the following methods:

Type DOWN M(AXIMUM), UP M, LEFT M, or RIGHT M on the COMMAND or action line and then press 
Enter.

Type M on COMMAND or action line and then press PF8 (down), PF7 (up), PF10 (right), PF11 (left), or 
use the corresponding assigned PFKeys.

Type TOP or BOTTOM on the COMMAND or action line and then press Enter to display the last or first 
n-rows

To scroll a specified number of rows or columns, use either of the following methods:

Type DOWN nnn, UP nnn, RIGHT nnn, or LEFT nnn on the COMMAND or action line and then press 
Enter.

Type nnn on the COMMAND or action line and then press PF7, PF8, PF10, PF11 (or the corresponding 
assigned PFKeys) to scroll down, up, right, or left.

Remember: To scroll within a specific subpanel, set your cursor in the subpanel before you press Enter or 
the appropriate PFKey.

Use the following methods to scroll within a specific subpanel:

To go to a specific column, overtype the "from" column number in the subpanel header and press Enter.

To go to a specific row, overtype the "from" row number in the subpanel header and press Enter.

To scroll to the next n-number of rows or columns, use the cursor-sensitive arrow controls in the subpanel 
header. Arrows highlighted in white are currently usable for the subpanel. Click on an arrow, then press 
Enter to scroll in the selected direction.

If there are subpanels that are not displayed, a MORE indicator appears at the bottom of the screen, next to the 
minimize bar. Arrows appear beside the MORE indicator to show if there is more data before or after the data 

displayed, or both . Placing the cursor on a directional arrow and pressing Enter scrolls the 
screen in that direction.
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Lateral column scrolling
Some columns contain more data than can be displayed in a fixed width. These columns may have lateral (left 
and right) scrolling enabled.

Columns with lateral scrolling enabled have left and right scrolling arrows in the column heading:

You can scroll by placing the cursor on an arrow and pressing Enter, or by placing the cursor in the data area of 
the column and pressing the PF10 or PF11 keys.

Selecting
Selecting items lets you perform actions associated with those items, such as navigating to a workspace that 
displays detailed information for the selected item, issuing a command that affects a selected resource. By 
default, selectable items are displayed in white.

In summary subpanels, the items in the first column may be selectable. Selectable items are preceded by an 
input field (_):

To select an action associated with the item, place the cursor on the input field using the arrow keys or the 
mouse and then perform one of the following actions:

Press Enter or type S and press Enter to execute the default action associated with the item. Typically, this 
is navigating to a related workspace.

Type / and press Enter to display a popup menu with a list of actions you can apply to the selected entry. 
On the popup menu, type the number or code of the action you want to perform and press Enter.

If you already know the action code for the action you want to perform, type it in the input field and press 
Enter to perform a specific action.

Type ! and press Enter to display a popup menu with a list of take action commands you can apply to the 
selected entry.

Sorting
You can sort data in eligible columns in ascending or descending order using the sort icons.

The column headings of columns that are eligible for sorting display a sort icon. The appearance of the sort icon 
depends upon the status of the sort.

Sort icon Status

Column is sortable, but sorting is not in effect.

Sorting is in effect and column is sorted in ascending order.

Note: Items that are selectable are zoomable, but zoomable items are not necessarily selectable. In 
detail subpanels, for example, items can only be zoomable. See “Zooming” on page 38 for more 
information.
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Sort icon Status

Sorting is in effect and column is sorted in descending order.

To sort using the icons, place the cursor over the heading of column you want to sort and press Enter. If sorting 
is in effect, pressing Enter reverses the sort order. If sorting is not in effect, pressing Enter sorts the list is 
descending order. To restore the original sort order, you must F3 out of the workspace and redisplay it.

Filtering
Columns in a summary subpanel may be designated as eligible for filtering. Some of these columns may have 
predefined filters. You can view a list of all the eligible columns and existing filters. You can add, modify, or 
remove filters for any column in the list. Only the columns in the first summary panel in a workspace can be 
filtered. Columns that are eligible for filtering are denoted with a green icon:

Columns that have a filter in effect are denoted with a yellow icon:

You can view the list of filter-eligible columns by pressing PF4, entering the FILTER command or clicking on the 
filter icon within the column header. The list of columns is displayed in a popup panel:

To enable, modify, or disable a filter:

Enter the number of the filter you want to modify.
A popup menu is displayed with the details of the filter definition:

Use UCTRAN to specify whether the uppercase translation option is to be set (Yes), or if the value is to be 
used as it is typed in (No). The UCTRAN option can be used to filter lower or mixed-case values. The 
default is Yes.

Take one of the following actions:

To add a filter, type the appropriate Compare operator and overtype N/A with the desired value, 
then press Enter.

To modify a filter, type the appropriate operator and value, then press Enter.
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To remove a filter, erase either the operator or the value in the existing expression, then press 
Enter.

If you press Enter, the filter list is redisplayed.

The following comparators are supported:

= or EQ (equal to)

<> or NE (not equal to)

> or GT (greater than)

< or LT (less than)

>= or GE (greater than or equal to)

<= or LE (less than or equal to)

The Value field supports strings or numbers. A trailing asterisk wildcard is supported, but not a leading asterisk. 
For example, C* but not *C. To indicate that a number is a substring rather than an integer, enclose the value in 
quotation marks. For example, in the preceding screen, specifying the value as “1234” displays all CICS regions 
whose names begin with the substring “1234”.

If no columns have been designated as eligible for filtering, you will see the following message after you enter 
the FILTER command or press F4:

Minimizing and maximizing subpanels
Minimizing a subpanel from its original size minimizes it to the minimize bar at the bottom of the workspace. 
Minimizing a subpanel allows additional subpanels, if any, to appear in the workspace. Maximizing a subpanel 
expands it to fill the entire screen, allowing you to see more data without scrolling.

To minimize a subpanel, set your cursor on the  icon and press Enter. The header of the subpanel appears in 
the minimize bar.

To restore the subpanel, set the cursor on the header in the minimize bar and press Enter.
To maximize a subpanel, set the cursor on the  Maximize icon and press Enter. The subpanel expands to fill 
the entire screen. While a subpanel is maximized, MORE and TRACE indicators are suppressed and full screen 
scrolling is disabled. You can only scroll the contents of the maximized subpanel. To reduce the subpanel to its 

original size, set the cursor on the Normalize icon  and press Enter.

Collapsing and expanding subpanels
Collapsing a subpanel leaves just the header on display and allows additional subpanels, if any, to be displayed 
in the workspace. If a subpanel is collapsed, only the subpanel heading is displayed. Expanding the subpanel 
displays the data rows and columns again.

A down arrow  in the left corner of a subpanel header indicates that the subpanel can be collapsed. Collapsing 
the subpanel turns the down arrow into a right arrow  (see “Figure: Workspace with collapsed subpanel” on 
page 37).
To collapse a subpanel, set your cursor on the down arrow  and press Enter. To expand a subpanel, set your 
cursor on the right arrow  and press Enter.
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Figure 7: Workspace with collapsed subpanel

If a collapsed subpanel contains no data, the text “No Data” will be displayed in the right corner of the title bar. 
In some collapsed subpanels that contain no data, the subpanel title might be replaced by explanatory text.

Closing subpanels
You can close subpanels to increase workspace real estate or focus only on data of concern. The subpanel will 
reappear the next time the workspace is accessed. If you want to be able to view the subpanel again without 
exiting the workspace, collapse or minimize the subpanel instead of closing it.

To close a subpanel, set your cursor on the  close icon in the subpanel header and press Enter.

Changing context
The Plex ID and SMF ID fields, which are located in the upper right corner of a workspace, display the currently 
selected plex and subsystem or region. If these fields are displayed in green, you can overtype them to switch 
the context to view data for another plex or subsystem.

For example, in the workspace shown below, you can overtype the SYS value in the SMF ID field with the SMF 
ID for another LPAR, then press Enter to see data for that LPAR instead of SYS.
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If these fields are blue, they cannot be overwritten.

Auto Update
The Auto Update feature refreshes the data displayed in a workspace at a set interval. By default, the feature is 
disabled. You can enable the feature by specifying an interval for the refresh.

The Auto Update field in the upper right corner of a workspace controls the refresh of data in the workspace:

If the feature is enabled, the Auto Update field displays the selected interval:

To turn on refresh, overtype the field with a desired interval, in seconds. To disable the refresh, overtype the 
interval with Off.

If the interface runs untouched in auto-update mode, it will eventually suspend auto update. A popup informs 
users that updates have been suspended, and the field displays SUS. The suspend interval is determined by the 
auto-update interval, so the larger the auto-update value, the longer the time before updating is suspended. The 
algorithm is n * 6 * 60 * 8, which equals 8 hours when auto update runs at a 10 second interval.

The Auto-Update suspension value can be customized in the user's profile, using the AUTOSUSPEND=nnnn
keyword, where nnnn is a number between 0 and 9999. If 0 is specified, the AUTOSUSPEND function is 
disabled.

Workspace navigation
In the enhanced 3270 user interface, you can navigate between workspaces by zooming, as well as by selecting 
options from an action menu. You can display a trace showing where you are and how you got there, you can 
return to where you started, and reset the tracing.

Zooming
One or more columns in a summary subpanel, or one or more items in a detail subpanel may be "zoomable". 
Zooming provides context-sensitive navigation to a predefined destination workspace. Zooming might even take 
you to a workspace for another OMEGAMON product.
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Items that are zoomable are highlighted in white. To zoom, click your cursor anywhere in the item and press 
Enter.
The contents of the destination workspace may be "filtered" based on the key values in the source workspace. 
For example, a destination workspace may show data for a specific CICSplex, Region, and Transaction ID.

Where am I?
Sometimes it is useful to know how you arrived at a particular workspace. For example, queries or processes 
might be driven silently to derive the data that is being displayed. The SHOWNAV or WHEREAMI commands 
display the current internal navigation trace table in a scrollable popup window. The table provides a history of 
the workspace navigation and the variables that are involved in arriving at the current workspace.

To view the navigation trace table, on the Command or action line, enter SHOWNAV or WHEREAMI.
Use the HOME command to return to the first workspace in a navigation chain . Returning to the first panel resets 
the navigation trace. Use the RESETNAV command to reset the trace table from the current workspace.

Situation Status Tree
This customizable workspace displays OMEGAMON situations in a tree structure on your OMEGAMON enhanced 
3270 User Interface (enhanced 3270UI). Through the Status Tree, you can see a complete picture of your 
enterprise monitoring status.

OMEGAMON monitoring agents generate events when certain performance thresholds, which are defined in 
your OMEGAMON Situations, are exceeded. You are able to view these situations through the Situation Status 
Tree. You can navigate to the Situation Status Tree the following ways:

Issue the events or alerts command from any workspace

Expand the HELP menu and select 10. Events Console

Issue an n.e fast path mnemonic in the action bar in the upper left hand portion of your screen

Expand the Enterprise Status branch in the Help and Workspace Directory. Drill down on KOBSITST

The status tree is an outline in which you can expand and collapse different branches in the tree. You expand 
and collapse branches to see greater or fewer details about the Situations that make up the status tree. The 
status tree can be compared to the Tivoli Enterprise Portal (TEP) Navigator.

Branches have a plus sign (+) or minus sign (-) near the left edge whenever that branch contains any children. 
The children for a branch are visible when a minus sign (-) is displayed.

Figure 8: Default Situation Status Tree

Note: To view and customize a Situation Status Tree, you must have OMEGAMON Dashboard Edition on 
z/OS V5.3.0 installed, and APARs OA48298 (PTF TBA) and OA47760 (PTF UA7724) applied.
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Enter a "/" in the Options field to display the pop-up menu of Status Tree Options. From this panel you can 
customize how your status tree is displayed. You can adjust the hierarchy of your branches, choose hour and 
date display formats, and adjust the width of your history columns.

Figure 9: Status Tree Options

With the Status Tree, you have flexibility similar to the TEP Navigator and TEP Custom Navigator views. You can 
group together situations based on Managed System Name or you can group situations together based on any 
combination of Managed System Name (msn), Situation Name (sit), Display Item (atom), Managed System 
Group (msl), and Affinities (aff).

For example, to create a part of the Status Tree where only situations that match a certain naming convention 
are displayed, you could supply a Status Tree filter like this:

{"type":"sit", "filter":{"sit":"My_SITNAMEs_xxx.*"}}

The Situations that are displayed in a Status Tree are ones that have become 'true' at some point within the time 
intervals being monitored. Enhanced 3270UI configuration values can be used to control the time span 
(minutes, hours or days) of situation data used for the Status Tree displays. When you change any of these 
configuration values, you must restart the enhanced 3270UI address space for the new values to be 
implemented.

Using the Status Tree, you are able to see which Situations are currently true, and which Situations have been 
true over some past time span. Viewing historical data helps you to more fully monitor the status of your 
systems and applications.

Example:

You can configure the Status Tree data collection to cover three days. Then on a Monday morning, for example, 
the system shows situation history since Friday morning. You can then select a particular status cell of interest, 
to get details of the situation history behind that status cell. If a status cell is red in a Sunday evening time slot, 
which might mean a critical problem, you can immediately drill down to the situation details that cover that 
point in time. The situation details tell you all the OMEGAMON values collected for that situation at that point in 
time. These details help you diagnose what was occurring in your environment.

The enhanced 3270UI provides a default Enterprise Status Tree that automatically discovers all of the 
OMEGAMON situations defined on your system; that is, defined to whichever Hub TEMS you are using. The 
default Enterprise Status Tree displays Situations in a hierarchy that consists of branches, where each branch is 
a different OMEGAMON performance monitor. For example, one branch is for the CICS® version of OMEGAMON, 
another is for z/OS®, and so on.

For more information on customizing the Status Tree, expand the New Features branch in the Help and 
Workspace Directory (KOBHLDIR) and select Status Tree to reach the KOBHLRTT workspace. For more 
information on reaching this workspace, see Help and Workspace Directory.

https://www.ibm.com/docs/SSAUBV/e3270/workspaces_help_contents_beacon.htm
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Situation Editor
The Situation Editor is a group of Workspaces that is used to create, view, and edit situations (including the 
formula, distribution, expert advice, action, and until conditions) that can monitor important conditions in your 
environment. Each situation monitors your environment constantly by testing a formula at time intervals that 
you set up, for example, every 5 minutes.

The following Workspaces are included in the situation editor.
Create New Situation (KOBSEDCN TREE)

Use the Create New Situation pop-up window (KOBSEDCN) to create a new situation. You supply the 
situation's name, description, and type.
Situations are one of two types: Standard or Correlated.
Select Conditions (KOBSEDPD TREE)

The Select Conditions workspace (KOBSEDPD) is where you select the tables and columns or 
embedded situations that make up your situation's formula. This workspace is displayed when you 
create a new situation and when you 'add columns' to an existing situation.

Correlated Situation Selection (KOBSEDCB TREE)

The Correlated Situation Selection workspace (KOBSEDCB) is where you select a 'Situation + Managed 
System' pair to be included in a correlated situation you are editing. This workspace is displayed when 
you first create a correlated situation and when you choose 'Add column' while editing a correlated 
situation.

Create Copy of a Situation (KOBSEDCC TREE)

Use the Create Copy of a Situation pop-up window (KOBSEDCC) to create a copy of an existing situation. 
You supply a new situation name and description.

Formula Tab (KOBSEDTF TREE)

The Formula tab displays a workspace (KOBSEDTF) that contains summary information about a situation 
like Agent, ID, Name, Description, and other fields. Typical things to do in the Formula tab are to edit the 
formula, to change the situation name, and to change the situation severity.
Name (KOBSEDEA TREE)

Use the Situation Name pop-up window (KOBSEDEA) to enter a name for the situation. The name may 
be up to 256 characters in length.

Description (KOBSEDEB TREE)

Use the Situation Description pop-up window (KOBSEDEB) to enter a description for the situation. The 
description may be up to 64 characters in length.

Severity (KOBSEDEC TREE)

Use the Situation Severity pop-up window (KOBSEDEC) to enter a severity value for the situation. The 
severity value is one of seven (7) choices.
When you display situations in the Enhanced 3270 User Interface Enterprise Status Tree (KOBSITST) or 
in the Current Situation Status screen (KOBSITMN), then the severity values are converted to colors, to 
help you locate the most important exceptional events on your system.

Display Items (KOBSEDED TREE)

The Display Items workspace (KOBSEDED) is where you can select one attribute (a column name from 
a table) that is a 'key' item, which enables you to see multiple events from a single situation.

Persistence (KOBSEDEE TREE)

Use the Situation Persistence pop-up window (KOBSEDEE) to enter a value for the number of times the 
condition must occur before the Situation turns 'true'.

Sampling Interval (KOBSEDEF TREE)

Note: To view the comprehensive list of instructions for customizing the Status Tree, you must visit the 
Help and Workspace Directory.
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Use the Situation Sampling Interval pop-up window (KOBSEDEF) to specify how often the situation's 
formula should be evaluated. The sampling interval must be at least 30 seconds.

Startup (KOBSEDEG TREE)

Use the Situation Startup pop-up window (KOBSEDEG) to specify if the situation should be started 
automatically (sampling should take place) when a monitoring system associated with this situation is 
'on line.'

Formula Editing (KOBSEDPA TREE)

Use the Situation Formula workspace (KOBSEDPA) to view and update the monitoring conditions that are 
tested during periodic sampling. This workspace is displayed when you select the Formula line item from 
the Formula tab workspace (KOBSEDTF).
Select Conditions (KOBSEDPD TREE)

The Select Conditions workspace (KOBSEDPD) is where you select the tables and columns or 
embedded situations that make up your situation's formula. This workspace is displayed when you 
create a new situation and when you 'add columns' to an existing situation.

Correlated Situation Selection (KOBSEDCB TREE)

The Correlated Situation Selection workspace (KOBSEDCB) is where you select a 'Situation + Managed 
System' pair to be included in a correlated situation you are editing. This workspace is displayed when 
you first create a correlated situation and when you choose 'Add column' while editing a correlated 
situation.

Choose a Function (KOBSEDP5 TREE)

Use the Formula Editing: Choose a Function pop-up window (KOBSEDP5) to select the function to use 
for the current formula cell.

Choose an Operator (KOBSEDP6 TREE)

Use the Formula Editing: Choose an Operator pop-up window (KOBSEDP6) to select the comparison 
operator to use for the current formula cell.

Enter a Value (KOBSEDP7 TREE)

Use the Formula Editing: Enter a Value pop-up window (KOBSEDP7) to directly type the value (a 
number or character string) for the current formula cell.

Value Choices (KOBSEDP8 TREE)

Use the Formula Editing: Value Choices pop-up window (KOBSEDP8) to select one or more values from 
a list of choices. Each item you select is then copied into the cell's value after you select the 'Accept' 
button.

Enter a Value (KOBSEDP9 TREE)

Use the Formula Editing: Enter a Value pop-up window (KOBSEDP9) to enter a value for the cell by 
typing into a special form for any of these functions:

STR

SCAN

Compare date and time (DATE)

Compare to time delta (TIME)

Distribution Tab (KOBSEDTD TREE)

Note: Only those functions that are valid for the cell's particular attribute and data type are 
displayed in this pop-up window.

Note: Only those operators that are valid for the cell's particular attribute, data type, and 
function are displayed in this pop-up window.
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The Distribution tab displays a workspace (KOBSEDTD) where you assign the managed systems and 
managed system groups where the situation should run.

Advice Tab (KOBSEDTE TREE)

The Advice tab displays a workspace (KOBSEDTE) where you can view and edit any advice associated with a 
situation. A value of '*NONE' or blanks is displayed if there is no advice defined for a situation.

Action Tab (KOBSEDTA TREE)

The Action tab displays a workspace (KOBSEDTA) that enables you to associate an 'action' (a command or a 
message) with a situation. When the situation turns 'true' then the action specified with the situation will be 
executed.
Action Type (KOBSEDAA TREE)

The Action Type pop-up window (KOBSEDAA) is where you select the type of action (a command or a 
message) to run when this situation turns 'true'. When the situation turns 'true' then the action specified 
with this situation will be executed.

When to Run the Action (KOBSEDAB TREE)

The When to Run the Action pop-up window (KOBSEDAB) is where you select what happens if the 
condition is true for more than one monitored item.

Where should the Action run (KOBSEDAC TREE)

The Where should the Action run pop-up window (KOBSEDAC) is where you select the location of the 
system on which the action should run.

How often should the Action run (KOBSEDAD TREE)

The How often should the Action run pop-up window (KOBSEDAD) is where you select how frequently 
the action should run if the condition stays true over multiple intervals.

System Command (KOBSEDAE TREE)

The Action: System Command pop-up window (KOBSEDAE) is where you enter the system command to 
run when this situation turns 'true'. When the situation turns 'true' then this system command is 
executed.

Universal Message (KOBSEDAF TREE)

The Action: Universal Message pop-up window (KOBSEDAF) is where you enter a message to be issued 
when this situation turns 'true'. When the situation turns 'true' then this message is issued to the 
Universal Message Console, which is viewable in the TEP or here:

_ (KOBITMLG WENU) ITM Operations Log and Universal Message Console

Select Attribute (KOBSEDAS TREE)

The Select Attribute workspace (KOBSEDAS) is where you select a column (also called an attribute) to 
be included in the action for the situation. (An action is optional for a situation.) This workspace is 
displayed when you are editing an action and then select the Attribute Substitution button.

Until Tab (KOBSEDTU TREE)

The Until tab displays a workspace (KOBSEDTU) that enables you to specify the conditions needed to 'close' 
this event. The Until settings provide a way to automatically close an event by turning a true situation to 
false when another situation is true or when the close interval expires. This is particularly useful for pure 
events that might occur frequently. If no options are selected in this workspace, the situation will remain 
'open' until the conditions that caused the situation to turn 'true' are no longer true.
Select Situation (KOBSEDSA TREE)

The Select Situation workspace (KOBSEDSA) is where you select a situation to be included in the Until 
settings for the situation. (Until settings are optional for a situation.) This workspace is displayed when 
you are using the Until workspace and select the Choose Situation button.
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Embedded data
The Enhanced 3270UI embedded data feature brings relevant data from other products into the workspace of 
the hosting product in a seamless manner that can enable the user to navigate in context directly to other 
product workspaces.

Each IBM® provided workspace within the Enhanced 3270 user interface (enhanced 3270UI) is hosted by a 
specific product, for example, OMEGAMON® for z/OS®, CICS®, IMS™, Db2®. A workspace from the OMEGAMON®
for z/OS® product, for example, will show details about a z/OS® address space.

The integration of relevant data from other products by the embedded data feature can speed up problem 
determination and help you to better understand the data. Embedded data makes it easier to diagnose 
problems, as relevant data is automatically provided by other monitors when available. This presentation of 
data helps you to learn the relationships between components and data.

An enhanced 3270UI workspace typically consists of one or more sub panels.

When a workspace from one product includes a sub panel definition from another product, the sub panel 
appears if:

The other product is installed and configured for the current environment.

The agent for the other product is running and reporting to the same Tivoli® Monitoring environment.

The other product has data relevant to the data that is being displayed by the hosting product.

The user does not do anything to see this additional data. If it is there, it appears and if not then it does not.

For example, you might be looking at the OMEGAMON® for z/OS® Address Space Details workspace for a 
specific address space. If the address space you are looking at is a CICS® region that IBM® Tivoli® Monitoring 
knows about, you can see data from the CICS® agent on the workspace if the OMEGAMON® for z/OS® Address 
Space Details workspace includes an appropriate sub panel from the OMEGAMON® for CICS® product.

Figure 10: Representation of a workspace from one product that contains embedded data from another product.

Navigating from embedded data subpanels
You might be able to navigate from enhanced 3270UI embedded data sub panels directly into relevant 
workspaces for that product. When available, you can use this feature to quickly move to relevant product areas 
to see more data without having to return to the higher level views and then find the data in another product 
area.
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Near-term History
Near-term History provides the capability to investigate problems that occurred in the recent past by using the 
enhanced 3270 user interface. Near-term History provides intuitive access to historical data collected by both 
agents and IBM® Tivoli® Monitoring.

There are two types of historical workspace available, the historical summary and the historical snapshot.

Viewing the Historical Summary workspace
Begin troubleshooting problems that occurred in the recent past by using the Historical Summary workspace to 
view a summary of historical data.

About this task
The Historical Summary shows a historical view of a selected data row from a real-time data summary display. 
It shows data for the selected row of data that goes back over time.

Procedure
Open a Historical Summary workspace view by entering the historical navigation character (H) for a row 
on an existing summary display.
For example, to open a historical CICSplex Regions Summary view, place your cursor before a CICS 
Region Name in the normal CICSplex Regions Summary workspace, type H and press Enter.

Figure 11: CICSplex Regions Summary workspace

The Historical Summary workspace opens. The workspace shows a historical view of the selected data 
row. A HISTORY indicator is highlighted in the header and footer areas to clearly distinguish that the 
workspace contains historical rather than current data.
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Figure 12: Example of a Historical Summary workspace

View the data row summaries that go back through time to identify a time period when problems 
occurred.

In the view that is shown in “Figure: Example of a Historical Summary workspace ” on page 46 the 
summary row of historical data at the Recording Time 09:50:00 indicates that a short-on-storage 
(SOS) condition occurred for region CICSF31A. The Transaction Rate and Maximum Tasks 
Percent are also highlighted as being above threshold alarm values.

Use indications such as the SOS and threshold alarms in the previous bullet to identify when 
problems occurred and to look at the highlighted time interval in more detail. For example, you can 
select the 09:50:00 interval and view more detailed snapshots of the data available for that 
period. For more information about viewing historical snapshot data, see “Viewing the Historical 
Snapshot workspace” on page 47.

You can configure the time interval between the recorded data snapshots. For more information 
about configuring the historical data collection, see “Configuring near-term history data collection 
for an application” on page 49

You can configure the time-span over which data snapshots are shown in the history summary 
workspace. For more information about configuring the history time-span view, see “Configuring 
the history time-span” on page 48.

Restriction: If a workspace is not configured to show a historical summary, the following message 
is displayed after you enter H and press Enter from the workspace.

Place your cursor over the message and press Enter to go to the relevant historical configuration 
workspace. For more information about configuring the historical data collection, see “Configuring 
near-term history data collection for an application” on page 49
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Viewing the Historical Snapshot workspace
Troubleshoot problems that occurred in the recent past in more detail by viewing a historical snapshot of a 
workspace at a specific point in time.

Before you begin
Use the Historical Summary workspace to begin troubleshooting problems that occurred in the recent past. For 
more information about the Historical Summary workspace, see “Viewing the Historical Summary workspace” 
on page 45.

About this task
The snapshot view can be either a summary, detail, or combined summary and detail panel.

Procedure
Place your cursor before a specific Recording Time Interval in a historical summary workspace, type /
and press Enter to view the Options Menu.
The Options Menu is displayed.

Choose an option from the Options Menu to open the associated Historical Snapshot workspace.
For example, to open the CICS Region Overview (History) workspace that is shown in “Figure: Example 
of a Historical Snapshot workspace ” on page 48,

Place your cursor before a Recording Time Interval in the historical CICSplex Regions Summary
workspace, “Figure: Example of a Historical Summary workspace ” on page 46, type / and press 
Enter. The Options Menu is displayed.

Type s and press Enter to choose the CICS Region Overview.

A historical snapshot view of the CICS Region Overview workspace opens. A HISTORY indicator is 
highlighted in the header and footer area to clearly distinguish that the workspace contains historical 
rather than current data.

The time of the current snapshot is highlighted in the footer area. Scrolling arrows are available either 
side of the current snapshot time. Use these arrows to scroll forwards or backwards to the next or 
previous snapshot. Alternatively you can enter the commands NEXT and PREVIOUS on the command line.

Tip: The options that are displayed usually mirror the options available from the equivalent real-
time workspace.
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Figure 13: Example of a Historical Snapshot workspace

Configuring near-term history
You can configure near-term history data collections, their frequency and various other parameters associated 
with the collections.

Configuring the history time-span
You can configure the time-span over which data snapshots are shown in the history summary workspace.

Before you begin
Go to the history summary workspace for the product you want to monitor.

Procedure
Make one of the following choices:

From the menu bar select View › History Timespan.
Move your cursor over the HIS icon in the drawer and press Enter.

The History Selection pop-up window opens.

Restriction: If the first subpanel in a workspace (generally the most important) is not eligible to 
show a historical snapshot, the equivalent real-time workspace opens. However, if the first 
subpanel is eligible to show a historical snapshot and another subpanel is not eligible, the 
following message is displayed for the ineligible subpanel.

Place your cursor over the message and press Enter to go to the general historical configuration 
workspace to show which attribute groups can be configured for near-term history data collection. 
For more information about configuring the historical data collection, see “Configuring near-term 
history data collection for an application” on page 49.
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Figure 14: History Selection pop-up window

You can select from the following history time-span configuration options
Historical Last nnn Minute(s)

This option when selected shows the history data summary over the last nnn minutes. You can 
configure the number of minutes that are specified by nnn by entering a value and selecting OK. The 
default value is 10 minutes.

Historical Last nnn Hour(s)

This option when selected shows the history data summary over the last nnn hours. You can 
configure the number of hours that are specified by nnn by entering a value and selecting OK. The 
default value is 2 hours.

Historical Time Range

This option when selected shows the history data summary over the time range that is specified in 
the Start and End fields. You can configure the start and end times, and dates, by entering values in 
these fields and selecting OK.

Selecting an application to configure for Near-term History
You can select an application to configure for Enhanced 3270UI near-term history data collection

Procedure
From the menu bar select View › History Configuration.
The PDS Historical Collection Control workspace opens.

Figure 15: PDS Historical Collection control workspace

Place your cursor before the application name that you want to configure for near-term history data 
collection and press Enter.
The Historical tables workspace opens. For more information about configuring historical tables, see 
“Configuring near-term history data collection for an application” on page 49

Configuring near-term history data collection for an application
You can configure Enhanced 3270UI near-term history data collection for application-specific attribute groups. 
You can specify that the data for the attribute groups is collected over specific Managed Systems and Managed 
System Lists. You can also specify whether the data is stored at the monitoring server or at the monitoring 
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agents. Storing data at the monitoring agents is preferred. The historical configuration procedure creates Tivoli 
Monitoring situations that are employed to control historical data collection.

Before you begin
Go to an application-specific workspace and select View › History Configuration from the menu bar, or select 
an application to configure for Near-term History. For more information about selecting an application to 
configure for Near-term History, see “Selecting an application to configure for Near-term History” on page 49. 
After you do one of these actions, the Historical tables configuration workspace opens. The attribute groups 
that can be configured for near-term history data collection for your chosen application are listed in the 
workspace.

Figure 16: Historical tables workspace

Procedure
Place your cursor before the attribute group name that you want to configure for near-term history data 
collection and press Enter.
The OMEGAMON History Configuration workspace opens. The view defaults to the General tab.

Restriction: You cannot use the procedure that is described here to change or delete historical data 
collections that use Tivoli Data Warehouse. Collections that use Tivoli Data Warehouse are configured 
with another interface, such as the Tivoli Enterprise Portal. If you do try to change or delete collections 
that use Tivoli Data Warehouse, a pop-up message warns that you cannot configure the collection with 
the enhanced 3270UI. Use the Tivoli Enterprise Portal to change or delete such collections.
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Figure 17: General tab of the OMEGAMON History Configuration workspace.

Enter a name for this data collection in the Collection Name field and press Enter.

Select the Interval time that you want for this collection, by placing your cursor before an interval time, 
typing s, and pressing Enter.
The selected interval changes color.

The location of the collection might be configurable. If so, the following shows in the middle of the 
screen:

Select the Collection Location by placing your cursor before TEMA (monitoring agent), or TEMS
(monitoring server), and pressing Enter.
In many cases, the location is predetermined for many attributes. In this case, the view looks as follows:

or

In this case, no selection can be made. If the Tivoli Enterprise Portal was used to create the collection, it 
is possible that collection is configured in a way that cannot be replicated by the TOM. In this case, the 
following can occur.

No changes are allowed to this collection.

Select the Distribution tab and press enter to go to that tab.
The Distribution tab opens.
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Figure 18: Distribution tab of the OMEGAMON History Configuration workspace.

Use this tab to set up your data collection to run either on specific Managed Systems or for a Managed 
System List.

Select one or more Managed Systems or Managed System Lists for your collection by placing your cursor 
before the system or list name, typing s, and pressing Enter.
The selected distribution's collection status changes from Excluded to Including to indicate that you 
are including them in the collection.

To save your collection, place your cursor over OK and press Enter. To exit without saving your collection, 
place your cursor over CANCEL and press Enter. Alternatively, if you navigate away from the General or 
Distribution tabs, your changes will not be saved.

Result
You are returned to the Historical tables configuration workspace. If you saved your data collection, it is listed 
under the Attribute Group and Collection name that you chose at step “2” on page 51.

Tip: Specifying a Managed System List usually indicates collection for one or more Managed 
Systems.
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User Preferences

The OMEGAMON® enhanced 3270 user interface provides administrative workspaces to assist subject matter 
experts and other users to set up and customize their preferences.

Workspaces that assist subject matter experts and other users to set up and customize their preferences are:

User profile customization

Log on Administration and customization

Customizing a user profile
To customize your user profile, use the User Profile Member workspace.

Procedure
From the menu bar select Edit › Preferences.
The User Profile Member workspace opens.

Figure 19: User Profile Member workspace

The User Profile Member workspace contains a number of tabbed panels that contain user profile 
settings that you can change and save. The following settings are available:
Date/Time

This panel contains the following date and time format settings
Date begins with

Enter MM for the American format, MM/DD/YYYY.

Enter DD for the European format, DD/MM/YYYY.

Enter YY for the Mathematical format, YYYY/MM/DD.

Date separator

Enter your preferred separator character. You can use any displayable character.

Time Clock

Enter 12 or 24 for 12 or 24 hour clock format
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Time separator

Enter your preferred time clock separator character. You can use any displayable character.

Colors

This panel contains color assignments for various workspace elements and indicators. You can enter 
your preferred color in the input field for each item.

Session/Logon

This panel contains settings that apply to your logon session to the interface.
First workspace to be displayed

Specifies the workspace that you want to be displayed at logon, the default is KOBSTART.

First NAV1 Plex-level Value

Specifies the plex (Sysplex, CICSplex, IMSplex) for which data is displayed on the first 
workspace. The value is a simple text string.

First NAV2 System-level Value

Sets the system, subsystem, or region within the plex for which data is displayed. The value is a 
simple text string.

Engage Trace

You can choose whether to engage trace at the start of your logon session by entering Y or N.

Global Query Timeout Value

Specifies the number of seconds that a workspace waits before timing out all queries combined. 
Each subpanel is apportioned a percentage of this value that is based on each query definition. 
You can enter a number in the range of 0 - 999. If you enter 0, the timeout mechanism is 
disengaged.

Auto/Update

This panel contains auto update settings that determine the refresh frequency of the data that is 
displayed in a workspace.
Auto Update Frequency

You can enter the auto update frequency. The allowable range is 5 - 999 seconds.

Auto Update Suspend Cycle Count

You can enter the number of refresh cycles that are allowed before auto update is automatically 
suspended. The allowable range is 10 - 9999 refresh cycles.

Hub Check

Hub Check when no data is displayed

The interface detects when a workspace displays no data, and can automatically check the 
connection to the hub Tivoli® Enterprise Monitoring Server. The Hub Check when no data is 
displayed setting controls the number of consecutive No Data displays before a hub connectivity 
check is triggered. The allowable range is 0 - 9 cycles. A setting of 0 means no hub connectivity 
check. Any positive number drives the hub connectivity check, and if the hub is found to be 
unresponsive, the interface goes to Hub connectivity administration. For more information about 
Hub connectivity administration, see “Hub connectivity administration” on page 98.

Limit Hub Check to Auto/Update

To limit the Hub connectivity check to when Auto Update is enabled, set to Y, otherwise set to N.

>>

Click the >> tab to access more menu items (detailed in the following entries).

<<

Click the << tab to return to the previous set of tabs.

ISPF
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This panel contains options for controlling the behavior of the tab key on your keyboard, within the 
enhanced 3270 user interface.
Tab to action bar

To use the tab key to navigate between action bar options, set to Y, to disable, set to N.

Tab to point-and-shoot fields

To use the tab key to navigate to push buttons, set to Y, to disable, set to N.

History

Use this panel to configure the time period that is shown in your historical data.
Historical Last nnn Minute(s)

This option when selected shows the history data summary over the last nnn minutes. You can 
configure the number of minutes that are specified by nnn by entering a value and selecting OK. 
The default value is 10 minutes.

Historical Last nnn Hour(s)

This option when selected shows the history data summary over the last nnn hours. You can 
configure the number of hours that are specified by nnn by entering a value and selecting OK. 
The default value is 2 hours.

Make one of the following choices:

Click OK to save and view your settings for the current session only. Your settings are saved for the 
current session and you are returned to the workspace you were in before you set preferences.
Click Save if you are satisfied with your settings and want to save them permanently to a profile 
member. The Profile Save As dialog box opens:

Figure 20: User Profile Member workspace

Your user ID is already entered in the Member Name field.
Press Enter to save the profile to the member name in the Member Name field. If the member 
already exists, it is updated. If it does not exist, a new member with that name is created.

Customizing KOBSITEC as the initial workspace
The ITM Situation Status & Message log (KOBSITEC) workspace can be a useful alternative to the default initial 
workspace, if you use Tivoli Enterprise Portal Server situation monitoring.

About this task
You can use the ITM Situation Status & Message log (KOBSITEC) workspace to display IBM Tivoli Monitoring 
Situations status information in the enhanced 3270 user interface. The status information is similar to the 
information provided by the Tivoli Enterprise Portal Situation Event Console, that is, situation status for current 
situations events and situation event history. KOBSITEC also enables navigation to OMEGAMON products high-
level workspace via the situation status row action selection. To change the default initial workspace KOBSTART
to KOBSITEC, use the following procedure.

Procedure
Use the procedure that is detailed in “Customizing a user profile” on page 53 to change the setting First 
workspace to be displayed to KOBSITEC.
When you log on the KOBSITEC workspace is now displayed as the initial workspace.

Optional: Enter =KOBSITEC in the action bar or command line and press Enter to go directly to the 
KOBSITEC workspace.
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Result

Figure 21: ITM Situation Status & Message log workspace.

The ITM Situation Status & Message log (KOBSITEC) workspace provides the following subpanel attributes:
Status

The Tivoli Monitoring Situation event status; for example, OPEN, ACKNOWLEDGED, REOPENED.

Situation Name

A unique name that identifies the Tivoli Monitoring Situation.

MSN Event Source

The name of the managed system where the situation is being monitored.

HUB Event Time

A time stamp that indicates the time the event occurrence or situation condition was recorded by the Hub 
Tivoli Enterprise Management Server.

Agent Event Time

A time stamp that indicates the time the event occurrence or situation condition was observed by the 
originating managed system.

Display Item

A related attribute that helps identify a unique instance of a situation event in the case where there are 
multiple instances/rows (that is, events) for a specific situation.

Type

The type of situation event, that is, a pure type where the situation has no sampling interval and the related 
alert notification is unsolicited, or, a sampled type where the situation condition is sampled on a specified 
interval.

Logon administration and customization
When you log on to the enhanced 3270 user interface (enhanced 3270UI) for the first time, Hub Connectivity 
Administration can assist you to specify a hub Tivoli® Enterprise Monitoring Server connection.

Procedure
Log on to the user interface in the standard way.
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For more information about logging on, see “Logging on” on page 16.
If a hub monitoring server is specified in your profile, and that hub is available, a connection is made to 
the hub and your initial workspace is displayed. By default, the initial workspace is the Enterprise 
Summary (KOBSTART) workspace. If a hub monitoring server is not specified in your profile, the Hub 
Connectivity Administration workspace is displayed.

Figure 22: Hub Connectivity Administration workspace that shows a hub connection is not specified for the 
current profile

To select the NEXT icon on the Hub Connectivity Administration workspace, move your cursor to the 
icon and press Enter or double-click the icon.
The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known 
to the enhanced 3270UI.

Figure 23: Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace
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On the All Known Hubs (KOBHUBS) workspace, place your cursor next to a hub monitoring server name 
and press Enter.
The Action Confirmation panel is displayed. The panel lists information about the hub monitoring server 
to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to confirm the 
action or N to cancel the action.

Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and 
shows two green information boxes that indicate a successful TCP/IP connection.

Figure 24: Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection

To save the hub monitoring server name to your user profile, select SAVE.

To use the selection for your current enhanced 3270UI session, select OK.

Result
Your session goes to the first workspace name specified in your logon profile, by default the Enterprise 
Summary (KOBSTART) workspace.

Tip: You can browse overview status information about each hub from this workspace. For more 
information about the All Known Hubs (KOBHUBS) workspace, see “The All Known Hubs 
workspace” on page 109.
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Customization

The OMEGAMON® enhanced 3270 user interface (enhanced 3270UI) provides workspaces to help subject 
matter experts customize workspace views for site specific and required use.

Customizing workspaces
Every OMEGAMON product that supports the enhanced 3270 user interface (enhanced 3270UI) provides a set 
of predefined workspaces that can be used to resolve common problems. These workspaces can be modified to 
display exactly the information that you want to most effectively use the OMEGAMON monitoring agents in your 
environment. You can also create your own custom workspaces.

Workspace viewing and cloning
The OMEGAMON® enhanced 3270 user interface (enhanced 3270UI) provides the capability to view and clone 
product provided workspaces.

Workspace viewing and cloning can be used to provide the user with the capability to customize the standard 
product defined workspaces that are delivered with the enhanced 3270UI. Modify or create workspaces by first 
cloning (copying) the workspace. Then, use a file editor such as the ISPF editor to edit the cloned workspace.

Preparing for workspace cloning
In preparation for workspace cloning by an enhanced 3270UI user, complete the following administrative steps:

Ensure that the interface user has the required authority.
The cloning process copies a standard product provided workspace from a configuration runtime 
environment data set to a user workspace data set. The runtime environment data set is read only and 
the user workspace data set is writeable. The user that wants to clone a workspace must have the 
authority to create new members in the user workspace data set. The default user workspace name is 
<hilev>.<rtename>.UKANWENU.

Ensure that the user workspace data set is the first data set that is specified in the RKANWENU DD
statement. The user workspace data set is pointed to by the enhanced 3270UI started task JCL UKANWENU 
DD statement.
If you ensure that the user workspace data set is the first data set, workspace testing is facilitated when 
customization changes are applied.

Minimize potential disruptions to other enhanced 3270UI users.
Because the cloning and customization process modifies product provided workspaces, the process must 
be done in a configuration that is not disruptive to ongoing normal usage of the enhanced 3270UI. For 
example, a separate enhanced 3270UI address space with a unique instance of the user workspace data 
set might be employed during the customization and testing process. Following customization and 
testing, the changes might be deployed to a shared development or production configuration by copying 
the customized workspaces into a corresponding data set that is specified in the shared development or 
production configuration enhanced 3270UI started task JCL.

Related information

Cloning a workspace
Browsing, locating and cloning a workspace

Important: It is important that the same <hilev>.<rtename>.UKANWENU data set is specified first 
in both the UKANWENU DD and RKANWENU DD statements.
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Cloning a workspace
Make a copy of a workspace and save it to your private data set.

Before you begin
You must complete some administrative steps before you clone a workspace. For more information about 
completing these steps, see “Preparing for workspace cloning” on page 59.

Procedure
Go to the workspace to be cloned.
The workspace name is beneath the command-line entry area of the workspace display. For example, in 
the following workspace view the workspace name is KOBSTART.

Figure 25: Identify the workspace name

Select View › Workspace Source
The Partitioned Dataset Member (KOBPDSD) view opens showing a view of the KOBSTART workspace 
content.

Select File › Save As to clone the workspace that is being viewed.
For example, to clone the KOBSTART workspace, place the cursor on File on the menu bar and press 
Enter. Then, from the File menu, select option 4, Save As by typing a or 4 and pressing Enter.

Figure 26: Cloning a workspace by using the File › Save As menu option.

When you press Enter, the Member Save As dialog box opens:

Figure 27: Cloning a workspace - the Member Save As dialog box

Enter the workspace name that you want to use for the cloned workspace.
If you are cloning a product provided workspace under the assumption that it is to supersede the product 
provided instance of the same workspace, the Save As name that you enter must be identical to the name 

Fastpath: You can fast path to File › Save As by entering f.a in the action line.
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of the product provided workspace, for example as shown in “Figure: Cloning a workspace - the Member 
Save As dialog box” on page 60.
The saved workspace is written to the user workspace data set. The original product provided workspace 
is preserved intact in the runtime environment data set.
When you press Enter, the Save As action is confirmed and you are returned to the Partitioned Dataset 
Member (KOBPDSD) view.

Optional: Go to the Runtime Environment (Workspaces) workspace to view your saved workspace
For more information about browsing and locating workspaces, see “Browsing, locating and cloning a 
workspace” on page 61

What to do next
When the workspace cloning is complete, the next step is to edit and test the workspace, customizing its 
contents to your requirements. Use a file editor such as the ISPF editor to edit the workspace.

Related information

Preparing for workspace cloning
Customization of product provided workspaces
Browsing, locating and cloning a workspace

Browsing, locating and cloning a workspace
You can use the Runtime Environment (Workspaces) workspace to browse the available workspaces and to 
locate a specific workspace for cloning.

Before you begin
You must complete some administrative steps before a workspace is cloned. For more information about these 
steps, see “Preparing for workspace cloning” on page 59.

Procedure
Go to the Runtime Environment (Workspaces) workspace to browse the available workspaces.
There are a number of ways you can go to this workspace:

Select File › Open. To do this, place the cursor under File on the menu bar and press Enter. Then, 
from the File menu select option 2.
Select Tools › Runtime Environment from the menu bar. The Runtime Environment workspace 
opens. Then, move your cursor over the Workspaces button and press Enter.
Move your cursor over the RTE icon in the drawer and press Enter. The Runtime Environment
workspace opens. Then, move your cursor over the Workspaces push button and press Enter.

When you make one of the previous three choices, the Runtime Environment (Workspaces) KOBWENUS
workspace opens. This workspace presents two workspace subpanels that provide directory lists for the 
user workspace data set (UKANWENU DD) and the runtime environment workspace data set (RKANWENU DD).
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Figure 28: Runtime Environment (Workspaces), locating the workspace member.

Enter the Locate command at the command line, specifying the workspace that you want to search for 
as an argument and press Enter.
For example, if you enter Locate KOBSTART, the directory view positions similarly to “Figure: Runtime 
Environment (Workspaces), locating the workspace member.” on page 62.

Place the cursor in the input field of the workspace name that you want to clone and press Enter.
For example, to select the KOBSTART workspace, place the cursor in the input field that precedes the 
workspace name and press Enter.
The Partitioned Dataset Member (KOBPDSD) view opens showing a view of the KOBSTART workspace 
content.

Select File › Save As to clone the workspace that is being viewed.
For example, to clone the KOBSTART workspace, place the cursor under File on the menu bar and press 
Enter. Then from the File menu, select option 4, Save As by typing a or 4 and pressing Enter.

Figure 29: Cloning a workspace by using the File › Save As menu option.

When you press Enter, the Member Save As dialog box opens:

Fastpath: You can shorten the Locate command to L. For example, you can enter L KOBSTART to 
search for the KOBSTART workspace.

Fastpath: You can fast path to File › Save As by entering f.a in the action line.
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Figure 30: Cloning a workspace - the Member Save As dialog box

Enter the workspace name that you want to use for the cloned workspace.
If you are cloning a product provided workspace under the assumption that it is to supersede the product 
provided instance of the same workspace, the Save As name that you enter must be identical to the name 
of the product provided workspace, for example as shown in “Figure: Cloning a workspace - the Member 
Save As dialog box” on page 63.
The saved workspace is written to the user workspace data set. The original product provided workspace 
is preserved intact in the runtime environment data set.
When you press Enter, the Save As action is confirmed and you are returned to the Partitioned Dataset 
Member (KOBPDSD) view.

Press PF3 (End) to return to the Runtime Environment (Workspaces) KOBWENUS workspace.

Result
The workspace directory view for the user workspace data set now lists the cloned workspace:

Figure 31: User workspace data set that shows a cloned workspace

Note: When you clone a product provided workspace, the cloned instance of the workspace is used by 
the enhanced 3270 user interface. Cloned or user customized workspaces are identified by an asterisk 
(*), which is displayed after the workspace name:
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What to do next
When the workspace cloning is complete, the next step is to edit and test the workspace, customizing its 
contents to site requirements. Use a file editor such as the ISPF editor to edit the workspace.

Related information

Preparing for workspace cloning
Customization of product provided workspaces

Customization of product provided workspaces
Guidance on customizing cloned workspaces.

Before customizing a workspace, you must first clone it. For more information about cloning a workspace, see 
“Cloning a workspace” on page 60.

Use a file editor such as the ISPF editor to customize a workspace. Save the cloned workspace in the user 
workspace data set, that is, the data set pointed to by the enhanced 3270 user interface (enhanced 3270UI) 
started task JCL UKANWENU DD statement.

The following examples are workspace customization actions that a user might want to perform.

Change the order of columns that are displayed in a summary data subpanel.

Change the columns that are displayed. For example, remove some columns in a summary subpanel, and 
eliminate some of the attribute values in a detailed data subpanel.

Change the workspace header.

Change the workspace default (on entry) cursor position.

Change the workspace default sort columns.

Change the statically defined columns in a summary subpanel.

Change the Agent filter that is specified in a subpanel query.

Add local Filters to a summary subpanel.

Change the number or order of subpanels that are displayed in the workspace.

Combine data from two or more input tables and generate output in a singular view.

You can achieve these types of customization by editing and changing workspace definition statements and 
associated keywords in the cloned workspace source. For more information, see “Customizing a workspace” on 
page 66.

Figure 32: A cloned workspace is denoted by an asterisk character (*) after the workspace name

Important: Product provided workspaces rely on both the workspace content and supporting REXX code 
to control context and navigation. Customization changes must avoid modifications that might have 
unintended results; for example; loss of context.
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Related information

Cloning a workspace

Modifying the initial workspace
By default, the OMEGAMON enhanced 3270 user interface (enhanced 3270UI) is configured to specify the 
Enterprise Summary (KOBSTART) workspace as the initial workspace displayed after a user logs on. You can 
change which workspace is displayed when you first log on, or customize the Enterprise Summary workspace to 
better suit your needs.

About this task
Customizing the initial workspace involves two tasks:

Creating a custom definition for the workspace

Modifying the user's logon profile to specify the custom definition

The definition of the Enterprise Summary workspace imbeds a subpanel for each the products that supports the 
enhanced 3270UI. The default imbed statements in the KOBSTART workspace definition are:
Names and descriptions of default imbeds in Enterprise Summary workspace

Table 2: Default imbed statements in the Enterprise Summary (KOBSTART) workspace

Imbed statement Description

IMBED=KM5STRTI Imbed for OMEGAMON for z/OS

IMBED=KCPSTRTI Imbed for OMEGAMON for CICS

IMBED=KGWSTRTI Imbed for OMEGAMON for CICS Transaction Gateway

IMBED=KDPSTRTI Imbed for OMEGAMON for Db2/PE on z/OS

IMBED=KIPSTRTI Imbed for OMEGAMON for IMS on z/OS

•

•

•

Tip: Consider the following things before you change workspace definitions or view the source definition 
for a specific workspace:

The absence of workspace definitions statements and or associated keywords (modifiers) is usually 
an indication that defaults are being used. For example, in the DISPLAYCOLS statement, there is no 
requirement for the specification of the CAPTION or WIDTH keywords. These keywords would more 
likely be used when the defaults are not adequate or preferable.

The syntax that is used in the workspace definition language is important. Keyword spelling, column 
name spelling, commas, spaces, quotation marks, parentheses, and other syntax cannot be ignored 
or excluded; for example, quotation marks and parentheses must be balanced. Although the 
enhanced 3270UI provides comprehensive parsing of the workspace source definitions statements, 
runtime errors and in some cases unexpected results might occur if the syntax is incorrect. For more 
information about the workspace definition language, see “Workspace panel definitions” on page 
143.

The workspace definition language specifications employ the internal column name to refer to a 
specific application product and table column/attribute. Taking note of the displayed workspace 
column order position along with the workspace DISPLAYCOLS definition (specified column order 
position) can be useful as a technique for correlating displayed columns with their corresponding 
internal column names.

Remember: When customizing product provided workspaces, when the changes are 
deployed for use by a wider audience, the changes affect all users of a given enhanced 
3270UI address space. Consider the other users when customizations of this type are done. 
The customization must benefit all of your users.
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Imbed statement Description

IMBED=KMQSTRTI Imbed for OMEGAMON for Messaging on z/OS

IMBED=KS3STRTI Imbed for OMEGAMON for Storage on z/OS

IMBED=KN3STRTI Imbed for OMEGAMON for Networks

Subpanels are displayed only for products that are installed. However, you might not want to see data for all of 
those products, or you might want to display additional subpanels. You can delete some of the imbedded 
subpanels and specify other subpanels that you want to imbed. Complete the following steps to customize the 
workspace definition.

Procedure
Copy or clone the product-provided KOBSTART member and rename it as appropriate, for example 
ZOSFWS.
Use the workspace viewing and cloning feature of the interface to complete this step. For more 
information about workspace viewing and cloning, see “Workspace viewing and cloning” on page 59.

Copy or clone the product-provided KOBCUA member and rename it as appropriate: CUASITE for a site 
profile or user_id for a user-specific profile.
Use the workspace viewing and cloning feature of the interface to complete this step. For more 
information about workspace viewing and cloning, see “Workspace viewing and cloning” on page 59.

Edit the copied instance to apply the required customization.
For example, you might modify the list of imbeds to delete the KCPSTRTI, KGWSTRTI, KDPSTRTI, 
KIPSTRTI imbed statements. These changes create an initial workspace that contains data for only the 
OMEGAMON for z/OS, OMEGAMON for Storage, and OMEGAMON for Networks products.
For more information about customizing workspaces, see “Customization of product provided 
workspaces” on page 64

Save your modified workspace.

Modify any appropriate logon profile members to specify the modified workspace definition as the initial 
workspace.
In this example, you change the logon profile setting from FIRSTWS=KOBSTART to FIRSTWS=ZOSFWS.

Save your updated logon profile members.

Result
When you log on to the enhanced 3270 user interface using any of the modified profiles, the ZOSFWS 
workspace is displayed.

Customizing a workspace
Complete some preparation steps before customizing a workspace.

Before you begin
Identify and clone the workspace to be customized. For more information about locating and cloning a 
workspace, see “Browsing, locating and cloning a workspace” on page 61. In the procedure that follows, the 
starting point is a cloned workspace. The workspace that is used as an example is the ITM Situation Status & 
Message Log (KOBSITEC) workspace. When you successfully clone a workspace, it is identified by an asterisk 
(*), which is displayed after the workspace name, as shown in the following example:
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Figure 33: A cloned workspace is denoted by an asterisk (*) after the workspace name

About this task
This task lists the preparation steps that you must complete each time that you want to customize a cloned 
workspace.

Procedure
Preparation steps:

Go to the cloned workspace.
For example, the Situations Status and History (KOBSITEC) workspace.

Go to the workspace source view by selecting View › Workspace Source from the workspace view.
The contents of the workspace source, (KOBSITEC) in this example is displayed in the Partitioned Dataset 
Member (KOBPDSD) workspace view.
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Figure 34: Workspace source view of the product provided ITM Situation Status & Message Log
(KOBSITEC) workspace.

Start an ISPF file editor session in parallel to your enhanced 3270UI session. To start an ISPF editor 
session, use a TSO logon, then locate and edit the workspace to be customized from your user workspace 
data set.
For example, the KOBSITEC workspace in the user workspace data set (hilev.rtename.UKANWENU).

Customization steps:

Choose and complete the customization that you want from the following choices:

Change a workspace and subpanel header See “Changing a workspace and subpanel header” on 
page 68

Change the order of displayed columns See “Changing the order of displayed columns” on page 
70

Change a column caption and width See “Changing a column caption and width” on page 71

Remove a subpanel See “Removing a subpanel” on page 73

Adjust the number of filterable columns 
and filter location

See “Adjusting the filterable columns” on page 74

What to do next
For more information about other definition statements that can be used to customize workspaces, see “Other 
workspace customization” on page 77.

Related information

Browsing, locating and cloning a workspace
Cloning a workspace

Changing a workspace and subpanel header
Customize a workspace by changing the workspace and subpanel headers.

Before you begin
Follow the preparation steps that are detailed in “Customizing a workspace” on page 66.

Procedure
To change the workspace header statement, use the ISPF file editor session.
For example, in the KOBSITEC workspace you can find the workspace header definition statement just 
after the <WORKSPACE> tag statement:

000014 /*****************************************
000015 <WORKSPACE>
000016 HEADER='ITM Situation & Message log'

For example, you might change the header definition as follows:

000014 /*****************************************
000015 <WORKSPACE>
000016 HEADER='Situation Status and History'

To change subpanel headers, use the ISPF file editor session.
For example, in the KOBSITEC workspace, further on in the workspace source, you can find the first 
subpanel header definition statement:
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000021                                
 000022 /******************************
 000023 /*                             
 000024 /*            SUBPANEL 1       
 000025 /*                             
 000026 /******************************
 000027                                
 000028 <SUBPANEL>
 000029 TYPE=SUMMARY                      
 000030 HEADER='Current Situation Event status' 
 000031 TOFROMHEADER=Y                    

For example, you might change the first subpanel header definition as follows:

000021                                
 000022 /******************************
 000023 /*                             
 000024 /*            SUBPANEL 1       
 000025 /*                             
 000026 /******************************
 000027                                
 000028 <SUBPANEL>
 000029 TYPE=SUMMARY                      
 000030 HEADER='Current Situation Alerts' 
 000031 TOFROMHEADER=Y   

Further on in the example workspace source, you can find the second subpanel header definition 
statement:

 000102                            
 000103 /**************************
 000104 /**                        
 000105 /**           SUBPANEL 2 - 
 000106 /**                        
 000107 /**************************
 000108 
 000109 <SUBPANEL>
 000110 TYPE=SUMMARY                       
 000111 HEADER='Situation Event Message Log'  
 000112 TOFROMHEADER=Y                                               

For example, you might change the second subpanel header definition as follows:

 000102                            
 000103 /**************************
 000104 /**                        
 000105 /**           SUBPANEL 2 - 
 000106 /**                        
 000107 /**************************
 000108 
 000109 <SUBPANEL>
 000110 TYPE=SUMMARY                       
 000111 HEADER='Situation Alerts History'  
 000112 TOFROMHEADER=Y                                               

Use the ISPF file editor session to save your workspace source changes.

Press PF3 (End) in your enhanced 3270 user interface session to close the workspace source view.
As the PF3 (End) action is processed, a refreshed view of the modified workspace is displayed, that is, the 
KOBSITEC workspace in this example:
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Figure 35: Customized workspace view that shows updated workspace and subpanel headings for the ITM 
Situation Status & Message Log (KOBSITEC) workspace

Changing the order of displayed columns
Customize a workspace by changing the order of the displayed columns.

Before you begin
Complete workspace customization preparation. For more information about these preparation steps, see 
“Customizing a workspace” on page 66.

Procedure
Use the ISPF file editor session to locate the DISPLAYCOLS workspace definition statement.
For example, in the KOBSITEC workspace, scroll beyond the DISPLAYCOLS statement to find the first 
<SUBPANEL> tag statement:

                                                   
 000079 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7), 
 000080 SITNAME(CAPTION='Situation_Name',WIDTH=30),   
 000081 ORIGINNODE(CAPTION='MSN_Event_Source'),           
 000082 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),     
 000083 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),   
 000084 ATOMIZE(WIDTH=30,SCROLL),                         
 000085 TYPE(CAPTION='Type')'                             
                                                  

Use the ISPF file editor session to change the order of the display columns.
You might want to change the order of display columns. For example, to move the MSN Event Source
header definition from the third column position to the second column position, adjust the DISPLAYCOLS
statement as follows:

Tip: While the KOBSITEC workspace is refreshed when a PF3 (End) action is processed, a refresh 
might not occur for a different workspace. If a refresh does not occur, you can exit and reenter the 
modified workspace to see your changes.
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 000079 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7), 
 000080 ORIGINNODE(CAPTION='MSN_Event_Source'),           
 000081 SITNAME(CAPTION='Situation_Name',WIDTH=30),       
 000082 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),     
 000083 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),   
 000084 ATOMIZE(WIDTH=30,SCROLL),                         
 000085 TYPE(CAPTION='Type')'    

Use the ISPF file editor session to save your workspace source changes.

Press PF3 (End) in your enhanced 3270 user interface session to close the workspace source view.
As the PF3 (End) action is processed, a refreshed view of the modified workspace is displayed, that is, the 
KOBSITEC workspace in this example:

Figure 36: Customized workspace view that shows the MSN Event Source moved to the second column 
position

Changing a column caption and width
Customize a workspace by changing a column caption and width.

Before you begin
Complete workspace customization preparation. For more information about preparation steps, see 
“Customizing a workspace” on page 66.

Procedure
Use the ISPF file editor session to locate the DISPLAYCOLS workspace definition statement.
For example, scroll beyond the first <SUBPANEL> tag statement in the KOBSITEC workspace to find the 
DISPLAYCOLS statement:

Tip: The KOBSITEC workspace is refreshed following a PF3 (End) action. A different workspace 
might not be refreshed following a PF3 (End) action. If a refresh does not occur, you can exit and 
reenter the modified workspace to see your changes.
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 000079 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7), 
 000080 SITNAME(CAPTION='Situation_Name',WIDTH=30),       
 000081 ORIGINNODE(CAPTION='MSN_Event_Source'),           
 000082 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),     
 000083 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),   
 000084 ATOMIZE(WIDTH=30,SCROLL),                         
 000085 TYPE(CAPTION='Type')'                             
                                                  

Change a column heading caption name.
By default, the column heading caption is defined by the Object Definition Interchange (ODI) definition. 
However, it is possible to specify an override in the DISPLAYCOLS statement. For example, in the KOBSITEC
workspace subpanel definition, to change the Situation Name caption to say Name, you can adjust the 
DISPLAYCOLS specification as follows:

 
 000079 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7), 
 000080 SITNAME(CAPTION='Name',WIDTH=30),       
 000081 ORIGINNODE(CAPTION='MSN_Event_Source'),           
 000082 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),     
 000083 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),   
 000084 ATOMIZE(WIDTH=30,SCROLL),                         
 000085 TYPE(CAPTION='Type')'    

Change a column width.
You might want to adjust the space on the screen that is available for a specific column. For example, in 
the modified KOBSITEC workspace subpanel definition, to change the Name column width, you might 
adjust the DISPLAYCOLS specification as follows:

 
 000079 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7), 
 000080 SITNAME(CAPTION='Name',WIDTH=32),       
 000081 ORIGINNODE(CAPTION='MSN_Event_Source'),           
 000082 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),     
 000083 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),   
 000084 ATOMIZE(WIDTH=30,SCROLL),                         
 000085 TYPE(CAPTION='Type')'    

Use the ISPF file editor session to save your workspace.

Press PF3 (End) in your enhanced 3270 user interface session to close the workspace source view.
As the PF3 (End) action is processed, a refreshed view of the modified workspace is displayed, that is, the 
KOBSITEC workspace in this example:

Figure 37: Customized workspace view that shows a column with a modified caption and width
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What to do next
In the example, the first caption change in the modified KOBSITEC workspace introduced an inconsistency 
between the first and second subpanel views because both panels contain a Situation Name column. You might 
want to apply the same changes to the second panel for consistency. You can apply the same changes to the 
second subpanel by scrolling down in the editor to the next DISPLAYCOLS statement and repeating the 
procedure.

Removing a subpanel
You can customize a workspace to remove a workspace subpanel that is not of interest to you.

Before you begin
Complete workspace customization preparation. For more information preparation steps, see “Customizing a 
workspace” on page 66.

About this task
For more information about subpanel start and end statements, see “Number and order of workspace 
subpanels” on page 79. The following procedure details the removal of a subpanel from a workspace.

Procedure
Use the ISPF file editor session to locate the second <SUBPANEL> workspace definition statement.
For example, in the KOBSITEC workspace, scroll to the SUBPANEL 2 heading to find the second <SUBPANEL>
statement:

                                                   
 000102                                                                        
 000103 /********************************************************************/ 
 000104 /**                                                                 */ 
 000105 /**           SUBPANEL 2 - Message Log                              */ 
 000106 /**                                                                 */ 
 000107 /********************************************************************/ 
 000108                                                                        
 000109 <SUBPANEL>
 000110 TYPE=SUMMARY                       
 000111 HEADER='Situation Alerts History'  
 000112 TOFROMHEADER=Y                     
 000113 SCROLLBAR=Y

Add a <WORKSPACEEND> tag statement before the <SUBPANEL> tag statement.
The <WORKSPACEEND> tag statement signifies the end of the workspace eliminating the following 
<SUBPANEL> definition:

000102                                                                        
 000103 /********************************************************************/ 
 000104 /**                                                                 */ 
 000105 /**           SUBPANEL 2 - Message Log                              */ 
 000106 /**                                                                 */ 
 000107 /********************************************************************/ 
 000108 <WORKSPACEEND>                                                                
      
 000109 <SUBPANEL>
 000110 TYPE=SUMMARY                       
 000111 HEADER='Situation Alerts History'  
 000112 TOFROMHEADER=Y                     
 000113 SCROLLBAR=Y

Use the ISPF file editor session to save your workspace source changes.

Press PF3 (End) in your enhanced 3270 user interface session to close the workspace source view.
As the PF3 (End) action is processed, a refreshed view of the modified workspace is displayed, that is, the 
KOBSITEC workspace in this example:

Tip: The KOBSITEC workspace is refreshed following a PF3 (End) action. A different workspace 
might not be refreshed following a PF3 (End) action. If a refresh does not occur, you can exit and 
reenter the modified workspace to see your changes.
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Figure 38: Customized workspace view that shows the second subpanel removed from the (KOBSITEC) 
workspace

Adjusting the filterable columns
Customize a workspace by adjusting the number of filterable columns and the filter location.

Before you begin
Complete workspace customization preparation. For more information about preparation steps, see 
“Customizing a workspace” on page 66.

About this task
For more information about filterable columns and filter definitions, see “Local or agent filter definitions” on 
page 79. The following procedure details how to adjust the number of filterable columns in a workspace. The 
procedure uses the ITM Situation Status & Message Log (KOBSITEC) workspace as an example.

Procedure
Use the ISPF file editor session to locate the FILTERCOLS workspace definition statement.
For example, in the KOBSITEC workspace scroll towards the end of the first subpanel definition to find the 
FILTERCOLS statement:

                                                   
 000084 ATOMIZE(WIDTH=30,SCROLL),     
 000085 TYPE(CAPTION='Type')'         
 000086                               
 000087 FILTERCOLS='SITNAME'          
 000088                               
 000089 SORTCOLS=ALL                  

Modify the FILTERCOLS definition statement to add another filterable column.
For example, in the KOBSITEC workspace, use the ISPF editor to make the following update:

Tip: The KOBSITEC workspace is refreshed following a PF3 (End) action. A different workspace 
might not be refreshed following a PF3 (End) action. If a refresh does not occur, you can exit and 
reenter the modified workspace to see your changes.
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000084 ATOMIZE(WIDTH=30,SCROLL),     
 000085 TYPE(CAPTION='Type')'         
 000086                               
 000087 FILTERCOLS='SITNAME, ORIGINNODE'          
 000088                               
 000089 SORTCOLS=ALL       

Optional: Add the FILTERWHERE=LOCAL statement to specify that filtering is locally applied.
For example, in the KOBSITEC workspace, use the ISPF editor to make the following update:

 000084 ATOMIZE(WIDTH=30,SCROLL),        
 000085 TYPE(CAPTION='Type')'            
 000086                                  
 000087 FILTERCOLS='SITNAME, ORIGINNODE' 
 000088 FILTERWHERE=LOCAL                

Use the ISPF file editor session to save your workspace source changes.

Press PF3 (End) in your enhanced 3270 user interface session to close the workspace source view.
As the PF3 (End) action is processed, a refreshed view of the modified workspace is displayed.

Press PF4, enter the FILTER command or click on the filter icon within the column header to start the 
filters dialog.
The filters dialog pop-up, shows the filterable columns, as shown in this example:

Figure 39: Filter dialog pop-up that shows the added filter column

Joining multiple tables into a singular view
You can customize workspaces by combining data from two or more input tables to generate a new output 
table.

Combining data from several input tables is referred to as a relational join, and is a way of aggregating the rows 
and columns from two or more tables into a new table with a singular view. You might consider joining several 
tables into a new table to create a consolidated view of certain performance data, rather than viewing the data 
in multiple subpanels and workspaces.

You are able to join data from up to 15 input tables. Those tables can be from a single version of OMEGAMON or 
from any number of different OMEGAMON products. For example, you might combine data from one 
OMEGAMON for z/OS® table with data from one OMEGAMON for IMS™ table and display the result in a single 
table of your own design.

Tip: The KOBSITEC workspace is refreshed following a PF3 (End) action. A different workspace 
might not be refreshed following a PF3 (End) action. If a refresh does not occur, you can exit and 
reenter the modified workspace to see your changes.
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Figure 40: Sample table join that shows a workspace with two OMEGAMON for z/OS tables and a CICS table joined.

Detailed instructions on table join customization are located in the online help for your enhanced 3270UI 
session. Follow these steps to navigate to the Help panel for the KOBJOIN1 workspace, where the 
customization process is documented.

Navigate to the Help and Workspace Directory KOBHLDIR. See Help and Workspace Directory for more 
information on how to reach the KOBHLDIR workspace.

Expand the New Features branch.

Figure 41: New Features

Drill down on the Joining Data row.

You arrive at the Help panel for the KOBJOIN1 workspace. Expand each branch to find step-by-step 
instructions on the customization process.

Figure 42: KOBHLRTT workspace with Input Tables branch expanded.

https://www.ibm.com/docs/SSAUBV/e3270/workspaces_help_contents_beacon.htm
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Other workspace customization
Learn about other workspace customizations and related workspace definition parameters.

The following information explains some common workspace definition statements that can be used to 
customize product provided workspaces. For an example of a detailed procedure to customize a workspace, see 
“Customizing a workspace” on page 66.

The initial and refresh cursor position for workspaces
The initial (on-entry) workspace cursor position is specified by the CURSOR= workspace definition statement. For 
example, CURSOR=HOME specifies that the initial cursor location is in the menu bar command field.

The CURSORREFRESH= workspace definition statement determines the cursor position behavior when the 
workspace is refreshed or when you return to the workspace, for example, after you enter PF3 (End). For 
example, CURSORREFRESH=ASIS specifies that the cursor position remains unchanged when you refresh or return 
to a workspace.

The possible values for the CURSOR= and CURSORREFRESH= statements are as follows:
HOME

Row 00, Column 1

COMMANDLINE

The cursor appears after the command-line prompt, Command ==>

SUBPANEL

The cursor appears in the first selectable field of the first subpanel.

ASIS

The cursor remains on the workspace wherever the user placed it.

Statically defined columns
Statically defined columns remain static during lateral scroll operations. These columns are usually the primary 
identification columns for a specific summary subpanel data row. For example, in the case of the KOBSITEC
workspace, the Status and Situation Name columns are defined as static. The statically defined columns are 
controlled by the STATICCOLS= subpanel definition statement. Thus STATICCOLS=2 specifies that the two 
leftmost columns in a subpanel display are defined as static; that is, the first two columns that are specified in 
the subpanel DISPLAYCOLS statement as shown in the following excerpt from the KOBSITECworkspace definition:

 STATICCOLS=2                                       
                                                    
 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7),  
 SITNAME(CAPTION='Situation_Name',WIDTH=30),        
 ORIGINNODE(CAPTION='MSN_Event_Source'),            
 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),      
 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),    
 ATOMIZE(WIDTH=30,SCROLL),                          
 TYPE(CAPTION='Type')'                              
                                                    

Number of columns displayed
The columns that are displayed in a specific workspace are specified by the DISPLAYCOLS= workspace definition 
statement. To remove a column from the workspace display, remove its specification in the DISPLAYCOLS
definition. To remove the Type column from the KOBSITEC workspace, remove the TYPE(CAPTION='Type')
specification from the DISPLAYCOLS definition as shown in the example:

Note: The comprehensive list of instructions for joining tables can only be found in the enhanced 3270UI 
Help Directory.
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 STATICCOLS=2                                       
                                                    
 DISPLAYCOLS='DELTASTAT(CAPTION='Status',WIDTH=7),  
 SITNAME(CAPTION='Situation_Name',WIDTH=30),        
 ORIGINNODE(CAPTION='MSN_Event_Source'),            
 GBLTMSTMP(CAPTION='HUB_Event_Time',DATETIME),      
 LCLTMSTMP(CAPTION='Agent_Event_Time',DATETIME),    
 ATOMIZE(WIDTH=30,SCROLL)'                          
                                                     

Allotted subpanel row count
For workspaces that provide multiple subpanel displays, there might be cases where it is preferable to adjust 
the screen space. For example, you might modify the minimum number of rows that are allotted to a specific 
subpanel. This can be illustrated by using the KOBSITEC workspace as an example. The KOBSITEC workspace 
provides two subpanels, the first subpanel provides a list of Open situations, the second subpanel provides a 
situation alerts history list. As currently defined, if a user logs on to the interface with the 3270 model 5 
emulation mode (27 rows), only the history (second) subpanel headers are displayed when the data rows in the 
first subpanel exceed five rows. The maximum rows that are allotted to a specific subpanel are defined by the 
subpanel LINESnn= parameter statements as shown in the following excerpt from the KOBSITEC workspace first 
subpanel definition:

 LINES24=4       
 LINES32=8       
 LINES43=12      
 LINES62=20      
 LINES90=25      
                 

To change the default space that might be allotted to the first workspace subpanel, for example, where most 
enhanced 3270 user interface users are using low maximum line emulation modes (such as a 3270 model 2 
with 24 available lines), you might adjust the LINES24 definition to LINES24=2. This change reduces the screen 
space that is allotted to the first subpanel and frees up two lines for use by the second subpanel. Alternatively, if 
the second subpanel is used infrequently and you want more space for the first subpanel, the alternative 
adjustment might be applied; that is, adjust the LINES24 definition to LINES24=8, allowing up to eight rows of 
detailed data to be viewed in the first subpanel. This example might be considered extreme. The enhanced 
3270 user interface recommended minimum screen size is 43x80, for example, a 3270 model 4 with 43 
available lines.

Workspace sort columns
The workspace subpanel sortable columns are specified by the SORTCOLS= definition statement. Given that the 
sort indexes are constructed after row data is retrieved and before the workspace is rendered, the product 
provided workspaces employ discretionary use of this definition statement, especially in cases where the 
anticipated returned row set can produce many rows. The product provided workspaces are designed to 
anticipate the most common use cases.

If, after you use the enhanced 3270 user interface for some time, you find that more sortable columns will 
improve the usability of a specific workspace, you might consider expanding the SORTCOLS= definition. For 
example, for the KOBSITEC workspace, if the current SORTCOLS= definition is SORTCOLS='SITNAME', to expand 
the definition to also include other subpanel columns such as, the MSN Event Source and HUB and Agent Event 
Time columns, you might change the definition to SORTCOLS='SITNAME, ORIGINNODE, GBLTMSTMP, 
LCLTMSTMP'.

The SORTCOLS definition statement must be defined with discretion, giving thought to potential loading costs. 
Although it is possible to define up to 30 SORTCOLS columns, or to define SORTCOLS=ALL to enable sorting on 

Important: The closing quotation mark (') that follows the TYPE column specification is not dropped. It is 
moved to the end of the ATOMIZE column definition. The closing quotation mark signifies the end of the 
DISPLAYCOLS definition statement.

Tip: The nn in LINESnn= represents the maximum available screen lines for a specific 3270 terminal.
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any subpanel column, this option is best avoided unless there is a certainty that the retrieved data comprises 
few data rows.

Note that the SORTCOLS specification can have limited use when a column display value is derived from an 
internal enumerated list, that is, where the display value is derived from the translation of an internal value. In 
this case, the sort index is produced from the internal column value. As a result, the column display values 
might seem to be grouped, but not necessarily in the expected display order.

Local or agent filter definitions
The workspace subpanel filterable columns is specified by the FILTERCOLS= definition statement. The following 
considerations are for using the FILTERCOLS definition statement:

FILTERCOLS specifications support the data result row set for each workspace subpanel that defines the 
FILTERCOLS statement.

There might be cases where a workspace provides multiple subpanels that share a retrieved data row set, 
that is, a reusable query. In that case, the filters specification supports all subpanels that share the specific 
result row set.

The FILTERCOLS workspace operates in conjunction with the FILTERWHERE= definition statement to specify 
where the filter is applied, either after the data is collected and returned to the enhanced 3270 user 
interface, or at the agent, during data collection and before the data is returned to the enhanced 3270 user 
interface. The default FILTERWHERE= definition is FILTERWHERE=AGENT, that is, filter at the agent.

When a FILTERCOLS statement is defined along with FILTERWHERE=AGENT (the default), the filters are 
applied at the agent. As a result, a FILTERCOLS statement with FILTERWHERE=AGENT does affect the load 
that is incurred for data retrieval. Assuming the filters are effective, they reduce the amount of data that is 
collected and returned to the enhanced 3270 user interface.

The FILTERCOLS statement must be used with discretion as they are not always effective. For example, 
they are most usable with column values that contain text strings. However, their use is limited for a 
numeric column value or a column value that is derived from an internal enumerated list, that is, where the 
display value is derived from the translation of an internal value.

For more information about adjusting the filterable columns, see “Adjusting the filterable columns” on page 74.

Number and order of workspace subpanels
The workspace subpanel definition start is specified by the presence of a subpanel start <SUBPANEL> tag 
statement. The subpanel definition end is specified in one of the following ways:

An implicit end that is defined by a <WORKSPACEEND> tag

An explicit end that is defined by a <SUBPANELEND> tag

An implicit end that is defined by a subsequent <SUBPANEL> tag that signifies the start of another 
subpanel

For more information about removing a subpanel, see “Removing a subpanel” on page 73

The following considerations are about the subject of removing and or reordering workspace subpanels:

Given that the subpanel definition boundaries are defined by the <SUBPANEL> and <SUBPANELEND> tag 
statements or by an implicit end of subpanel, you can make a subpanel order change by moving a block of 
all lines that define a specific subpanel from one location in the workspace definition to another location.

Remember: There are other workspace definition statements, for example, FILTERVIEW(S) and 
FILTERSTRIP, that are related to filters that can be specified in the product provided workspaces. Filter 
definition statements can be complex and changes to product-provided workspace filter definitions must 
be applied with discretion to avoid unintended side-effects.

Remember: The <WORKSPACEEND> tag signifies the end of the workspace definition.
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Workspace panel definitions - reference
For more information about workspace definition statements that might have content and order implications, 
see “Workspace panel definitions” on page 143

Customizing status indicators
Columns in the enhanced 3270 user interface workspaces use colors to highlight the status of data based on 
thresholding criteria. If no criteria are set for a status column, the column is displayed in the default status 
unknown color.

You can change the colors that are associated with a particular status or range in the interface profile, by setting 
the values for the CUASTATUS keywords.

The CUASTATUS keywords control the color assignments for attributes for which thresholds are defined. When 
thresholds are defined, one of six states or one of nine range values can be assigned to the item. The state that 
is assigned to the item when the threshold is reached is reflected in a status indicator. The following colors can 
be assigned as status indicators: red, white, blue, green, yellow, turquoise, and pink.

The SHOWOKGOOD keyword controls the display of a status indicator for the OKGOOD state. By default, the value for 
this keyword is NO to minimize the number of colors in the workspace. However, in some workspaces, you might 
prefer to display the status.

The possible states and ranges, with default values, are listed here:

<CUASTATUS>                                                            
OKGOOD=GREEN                                                            
WARNING=YELLOW
CRITICAL=RED
IDLE=BLUE
HIGHLIGHT=TURQUOISE
UNKNOWN=BLUE

SHOWOKGOOD=NO
RANGE1=GREEN
RANGE2=GREEN
RANGE3=GREEN
RANGE4=YELLOW
RANGE5=YELLOW
RANGE6=YELLOW
RANGE7=RED
RANGE8=RED
RANGE9=RED

Modifying predefined thresholds
Workspaces reflect the status of data on the basis of threshold criteria. Each product that supports the 
enhanced 3270 user interface provides predefined thresholds. You can modify these thresholds to more 
accurately reflect your site and user criteria.

Preparing for threshold member cloning
The OMEGAMON enhanced 3270 user interface provides the capability to clone threshold members. Before you 
can clone a threshold member, you must prepare by performing administrative steps.

Remember: For product provided workspaces, the order of workspaces can matter. For example, 
the retrieved data result set for workspace A might be shared by workspace B. Another example is 
when workspace B depends on a value that is set by workspace A. Another case, is for a silent
workspace, that is, a workspace that is not displayed but contributes to the navigation scenario. For 
example, a silent workspace can run intermediate steps that are required for a subsequent process. 
Take these considerations into account when customizing a workspace that for example, removes, 
adds, or reorders subpanels within a specific workspace.
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Before you begin
Threshold cloning can be used to customize the standard threshold members that are delivered with the 
enhanced 3270 user interface.

The cloning process copies a standard product-provided threshold member from a configuration runtime 
environment data set to a user threshold member data set. The runtime environment data set is a read-only 
data set; the user threshold member data set is a writeable data set. The user that wants to clone a threshold 
member must have the authority to create new members in the user threshold member data set. The default 
user threshold member data set name is <hilev>.<rtename>.RKANPARU.

About this task
In preparation for threshold member cloning by an enhanced 3270 user interface user, complete the following 
administrative steps.

Procedure
Ensure that the user who wants to clone a threshold member has the required authority.
The user must have the authority to create new members in the user threshold member data set. The 
default user threshold member data set name is <hilev>.<rtename>.RKANPARU.

Ensure that the user threshold member data set is the first data set that is specified in the RKANPAR DD
statement. The user threshold member data set is the data set that is pointed to by the enhanced 3270 
user interface started task JCL RKANPARU DD statement.
If you ensure that it is the first data set, threshold member testing is facilitated when customization 
changes are applied.

Minimize potential disruptions to other enhanced 3270 user interface users.
Because the cloning and customization process modifies product provided thresholds, it must be done in 
a configuration that is not disruptive to ongoing normal usage of the enhanced 3270 user interface. For 
example, a separate enhanced 3270 user interface address space with a unique instance of the user 
threshold member data set might be used during the customization and testing process. After the 
customization and testing, the changes might be deployed to a shared development or production 
configuration by copying the customized threshold members into a corresponding data set that is 
specified in the shared development or production configuration enhanced 3270 user interface started 
task JCL.

Cloning thresholds
Use the Configuration workspace to make a copy of a threshold member and save it to a user-defined 
thresholds data set.

Before you begin
You must complete some administrative steps before a threshold member is cloned. For more information 
about these steps, see “Preparing for threshold member cloning” on page 80.

a.

b.

c.

d.

Note: For security reasons, you might not be able to grant users write or update authorization to 
the <hilev>.<rtename>.RKANPARU data set. In that case, complete the following steps:

Create an alternative data set with attributes that match the <hilev>.<rtename>.RKANPARU
data set attributes.

Change the enhanced 3270 user interface started task JCL to include the alternative data 
set in the UKANPAR DD statement data set concatenation.

Grant users authorization to this data set.

Create the user ID custom threshold members in this data set.

Important: Be sure that you specify the same <hilev>.<rtename>.RKANPARU or alternative data 
set first in both the UKANPARU DD and RKANPAR DD statements.
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Procedure
Identify the threshold member that you want to clone.

Go to the Runtime Environment (Configuration) workspace to browse the available profiles.
There are a number of ways you can go to the Runtime Environment (Configuration) workspace:

From the menu bar, select Tools › Runtime Environment. The workspace opens. Then, move your 
cursor over the Thresholds button and press Enter.
Move your cursor over the RTE icon in the drawer and press Enter. The Runtime Environment
workspace opens. Then, move your cursor over the Thresholds button and press Enter.

The Runtime Environment workspace presents two workspace subpanels that provide directory lists for 
the user threshold member data set (UKANPAR DD) and the runtime environment profiles data set 
(RKANPAR DD).

Figure 43: Runtime Environment (Configuration), locating the threshold member.

On the command line, enter the Locate command. Specify the threshold member name that you want to 
search for as an argument and press Enter.
The directory view is positioned in the context of the threshold member name that you entered. The 
Locate command can be shortened to L. For example, if you enter L KM5THRSH on the command line 
and press Enter, the view is positioned similarly to “Figure: Runtime Environment (Configuration), 
locating the threshold member.” on page 82

Place the cursor in the input field of the profile name that you want to clone and press Enter.
For example, to select the KM5THRSH profile, place the cursor in the input field that precedes the profile 
name and press Enter.
The Partitioned Dataset Member (KOBPDSD) view opens showing a view of the KM5THRSH profile content.

To clone the threshold member that is being viewed, select File › Save As.
For example, to clone the KM5THRSH profile that is being viewed in the previous step, place the cursor 
under File on the menu bar and press Enter. Then, from the File menu select option 4, Save As by typing 
a or 4 and pressing Enter.

Fastpath: You can fast path to File › Save As by entering f.a in the action line.
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Figure 44: Cloning a threshold member by using the File › Save As menu option.

When you press Enter, the Member Save As dialog box opens:

Figure 45: Cloning a threshold member - the Member Save As dialog box.

Enter the threshold member name that you want to use for the cloned threshold member.
If you are cloning a product-provided threshold member to supersede the product provided instance of 
the same workspace, the Save As name that you enter must be identical to the name of the product 
provided-threshold member, as shown in “Figure: Cloning a threshold member - the Member Save As 
dialog box.” on page 83.
The saved threshold member is written to the user threshold data set. The original product-provided 
threshold member is preserved intact in the runtime environment data set.
When you press Enter, the Save As action is confirmed and you are returned to the Partitioned Dataset 
Member (KOBPDSD) view.

Press PF3 (End) to return to the Runtime Environment (Configuration) KOBPROFS workspace.

Result
The profile directory view for the user profile data set now lists the cloned profile, as shown in the following 
example:
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Figure 46: User threshold data set that shows a cloned profile

What to do next
When the threshold member cloning is complete, edit and test the threshold member, customizing its contents 
to user requirements. To do this use a file editor such as the ISPF editor.

Customizing thresholds
You can customize threshold criteria by user, by site, or by product.

Before you begin
Workspaces reflect the status of data on the basis of threshold criteria. Each product that supports the 
enhanced 3270 user interface provides predefined thresholds. You can customize these thresholds to more 
accurately reflect your site and user criteria.

Before you begin customization, review the following topics:

“Preparing for threshold member cloning” on page 80

“Cloning thresholds” on page 81

“Syntax for threshold specification” on page 86

About this task
This task describes how to create and refresh customized threshold definitions using the enhanced 3270 user 
interface.

Threshold definitions are categorized as follows:
User-specific

User-specific thresholds affect only a single user. The customized user-specific thresholds are defined in a 
member named user_id, which is the TSO or SAF user ID of the user.

To customize user-specific thresholds, you must create the user_id member and include only the changes 
that you want to make. Ideally, member user_id contains only the threshold overrides that are specific to 
the user and is not intended to include all threshold definitions.
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If you use member user_id for custom thresholds, you must have a user profile for the same ID in the 
UKOBDATF data set.

Site-wide

Site-wide thresholds affect all users and all products in the environment. The customized site-wide 
thresholds are defined in a member named CUASITE.

To customize site-wide thresholds, you must create the CUASITE member and include only the changes 
that you want to make. Ideally, member CUASITE contains only the site-wide threshold overrides and is not 
intended to include all threshold definitions.

Product-specific

Product-specific thresholds affect all users of a specific product. Each product provides predefined 
threshold definitions in member KppTHRSH of data set TKANPAR, where pp is the product code. For 
example, OMEGAMON for CICS has member KCPTHRSH, and OMEGAMON for z/OS has member KM5THRSH.

To customize product-specific thresholds, you must create a copy of member KppTHRSH that is a complete 
copy of the original predefined threshold member. You then update this copy with your changes, and it is 
used in place of the original predefined threshold member.

Thresholds are applied in the following order: user_id, CUASITE (or IBMSITE), KppTHRSH.

To determine the threshold or thresholds that apply to each workspace and subpanel, for each product with 
thresholds that you want to change, check the KppTHRSH member for comments similar to those in the 
following screen capture:

000009 ************************************************************************         
000010 * TABLE   : KCPPLX                                                     *         
000011 *                                                                      *         
000012 * PANEL ID: KCPPLXS - ENTERPRISE CICSPLEX SUMMARY                      *         
000013 * SUBPANEL: 1 - ALL ACTIVE CICSPLEXES                                  *         
000014 ************************************************************************         
000015 IF ( OMCICS.KCPPLX.TRANRATE    GT 1000/MIN                 OR                    
000016      OMCICS.KCPPLX.TRANRATE    LT 100/MIN                                        
000017    )                                                                             
000018    THEN DO                                                                       
000019         STATUS ( CRITICAL 9 )                                                    
000020    ENDDO                                                                         
000021 IF ( OMCICS.KCPPLX.TRANRATE    EQ 900/MIN<>1000/MIN        OR                    
000022      OMCICS.KCPPLX.TRANRATE    EQ 100/MIN<>300/MIN                               

After you have completed your customizations, you must refresh the threshold definitions in your environment. 
An administrator can dynamically refresh the site-wide and product-specific thresholds for all users using the 
MVS MODIFY command THRESHREFRESH; for any users that are logged on to the enhanced 3270 user 
interface, these changes take effect immediately and automatically. If you make any user-specific threshold 
customizations and are logged on to the enhanced 3270 user interface, you must use the Threshold Refresh
option in the interface for the changes to take effect; this option also refreshes the site-wide and product-
specific thresholds.

Complete the steps in the following procedure to customize and refresh your threshold definitions.

Note: Member IBMSITE contains site-wide, product-provided threshold definitions. Member 
IBMSITE is used only if member CUASITE is not found.

Note: The customization of user-specific and site-wide thresholds requires the use of members named 
user_id and CUASITE, respectively; the default user-threshold data set is 
<hilev>.<rtename>.RKANPARU. The enhanced 3270 user interface user profiles and site-customized 
profiles also use members named user_id and CUASITE, respectively; the profile members exist in the 
default user-profile data set <hilev>.<rtename>.UKOBDATF.

Note: There is no runtime validation of threshold syntax. If you customize thresholds and they are failing, 
check the enhanced 3270 user interface address space SYSPRINT log for errors.
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Procedure
Locate and clone the threshold member or members that contain the threshold or thresholds that you 
want to modify. Product-specific threshold members containing predefined thresholds are named 
KppTHRSH, where pp is the product code, in data set TKANPAR.

Use one or more of the following choices when creating cloned threshold members:

Create a cloned member named user_id for user-level thresholds. The user_id member must 
include only the subset of thresholds that you want to modify for a specific user. If you use 
user_id for the custom thresholds, you must have a user profile for the same ID in the UKOBDATF 
data set.
Create a cloned member named CUASITE for site-wide thresholds. The CUASITE member must 
include only the thresholds that you want to modify on a site-wide basis.
Create a cloned member named KppTHRSH to modify product-specific thresholds. This KppTHRSH
member must be a complete copy of the original predefined threshold of the same name.

Edit the new threshold member to change threshold definitions.
Use a file editor such as the ISPF editor to do this.

Refresh the threshold definitions using the following options:

To refresh all threshold definitions (including user-specific thresholds), from the Tools menu in the 
enhanced 3270 user interface, select option 4, Threshold Refresh.
All threshold definitions (customized and predefined) take effect immediately.

To refresh site-wide and product-specific thresholds for all users, you can issue the following 
operator command:

/F ui_stc_name,THRESHREFRESH

where ui_stc_name is the name of the enhanced 3270 user interface started task.
The site-wide and product-specific threshold changes take effect immediately and automatically 
for all users.

Disabling thresholds
Disable threshold specifications to eliminate status indicators but leave the unmodified threshold specification 
in place.

Procedure
To disable a threshold, edit the definition to specify STATUS(NOSTATE NORANGE). The evaluation still 
takes place but no data is highlighted in the workspace if the threshold criteria are met.

Syntax for threshold specification
Use the syntax, values, and parameters described here to modify predefined thresholds.

Specification of thresholds uses the following syntax:

Note: For details about cloning members in the enhanced 3270 user interface, see “Cloning 
thresholds” on page 81.

Note: For details about threshold syntax, see “Syntax for threshold specification” on page 86.

Note: The MVS MODIFY command THRESHREFRESH does not refresh user-specific 
thresholds. To refresh user-specific thresholds, you must use the Threshold Refresh option 
if you are logged on to enhanced 3270 user interface, or log off and log on.
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Parameters
Each threshold specification consists of six required elements and three optional elements that are used when a 
complex threshold is specified:
IF keyword

This keyword indicates the beginning of the threshold specification. Internal parsing considers all text 
between IF statements as a threshold specification. Only the first column in the IF statement is statused if 
it evaluates positively.

Left parenthesis – (
An optional left parenthesis is used to help group connected thresholds in a complex threshold 
specification. Specification of the left parenthesis is optional, but if specified it is treated based on the 
normal rules of operator precedence. That is, the highest level of precedence among parentheses and AND 
and OR operators. Each left parenthesis must be matched in the complex threshold specification by a 
corresponding right parenthesis or errors will be flagged during parsing.

application_name.table_name.column_name
This triplet must follow the IF keyword with each of the three components delimited by a period. The triplet 
must be contiguous, that is, must contain no embedded blanks.

Comparator
This 1-2 byte specification must follow the application.table_name.column.name triplet. Valid 
comparators are:
EQ

compare equal

=
compare equal

NE
compare not equal

!=
compare not equal

GT

Note: This parenthesis MUST be preceded and succeeded by at least one blank.
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compare greater than

>
compare greater than

LT
compare less than

<
compare less than

GE
compare greater than or equal

>=
compare greater than or equal

LE
compare less than or equal

<=
compare less than or equal

Comparison value or range of values
This value must follow the comparator with the following formats supported:

The value is considered a string if enclosed by double-quotes. Up to 70 characters may be specified.

Decimal integer, preceded by an optional sign character (+ or -), in the range -2^63 + 1 through 2^63 – 
1, that is, -9,223,372,036,854,775,807 to +9,223,372,036,854,775,807. A decimal point may be 
inserted in any position, including as first or last in the value: that is, 1234. and .1234 are valid.

Hexadecimal value in the range 0x8000000000000000 through 0x7FFFFFFFFFFFFFFF. After the 0x 
prefix, 1 – 16 hexadecimal digits can be specified; for example, 0x3F is valid.

Optionally, a range of values may be specified using a <> symbol immediately after and contiguous to 
the 1st decimal or hexadecimal value. The second, upper value in the range must follow the same 
specification rules as the first value in the range though a mixture of decimal and hexadecimal values 
can be specified if desired. The second value must immediately and contiguously follow the range 
symbol.

A suffix specifying the units that apply to the numeric value(s) can optionally be specified. The unit 
characters must immediately follow, and be contiguous with, the numeric value they apply to. Valid 
unit specifications are:
K

scales the numeric value by a factor of 1024

M

scales the numeric value by a factor of 1024*1024

G

Note: If a comparator other than EQ or “=” is used against a string the assumption is that a 
numeric string value is being thresholded. Currently, the UI data value and the threshold value 
are right-justified before comparison in these situations. This will provide expected threshold 
comparison results for numeric values that are specified with the same number of decimal 
places, scaling units but no parsing of the string is attempted in the evaluation to “normalize” 
the strings.

Note: The use of the <> symbol may be replaced by a compound IF statement such as IF 
(a.b.c >= value1 AND a.b.c <= value2).
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scales the numeric value by a factor of 1024*1024*1024

T

scales the numeric value by a factor of 1024*1024*1024*1024

P

scales the numeric value by a factor of 1024*1024*1024*1024*1024

E

scales the numeric value by a factor of 1024*1024*1024*1024*1024*1024

ms

milliseconds, scales the numeric value to seconds by a factor of 1000

csec

centiseconds, scales the numeric value to seconds by a factor of 100

sec

seconds, no scaling

/sec

units per second, scales to rate per hour internally (*3600)

/min

units per minute, scales to rate per hour internally (*60)

/hr

units per hour, no scaling

%

percentage, no scaling

Right parenthesis – )
An optional right parenthesis is used to help group connected thresholds in a complex threshold 
specification. Specification of the right parenthesis is optional but if specified will be treated based on the 
normal rules of operator precedence. That is, the highest level of precedence amongst parentheses and 
AND and OR operators. Each right parenthesis must be matched in the complex threshold specification by a 
corresponding left parenthesis or errors will be flagged during parsing.

Connector AND and OR keywords
The connector between any two individual thresholds, or parenthesized groups of thresholds, must be an 
AND or an OR keyword. If both are used in a complex threshold, normal rules of precedence and 
associativity apply. That is, AND has higher precedence than OR if no parentheses are used or both 
connectors are contained within a single left and right parentheses pair. Associativity is left to right.

THEN DO keywords
THEN DO must be specified after the threshold IF statements with a corresponding terminating ENDDO 
keyword. The THEN DO and ENDDO keywords are specified before and after one or more of the STATUS, 
ZOOMDEST or HELPDEST keywords and keyword values.

STATUS keyword
STATUS is an optional keyword that can follow the comparison DO THEN keywords.

(status_state, status_range)
This is a parenthesized, space-delimited pair of two keyword parameters that designate one or two statuses 
for interpretation by the user interface. Both designation types must be specified. Specific keywords 
indicating that one or more of the status designations does not apply to the current threshold (NOSTATE or 
NORANGE) are used in place of an actual value. At least one blank must be specified between the STATUS 
keyword and the left parenthesis.

Note: This parenthesis MUST be preceded and succeeded by at least one blank.
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status_state sets the state to be interpreted by the user interface. Valid specifications are:

GOOD

WARNING

CRITICAL

IDLE

NOSTATE

status_range sets a value in the range 0 through 9 (0 is equivalent to the NORANGE keyword) to 
augment the column data in the user interface subpanel. Valid specifications are:

Numeric value in the range 0 through 9

NORANGE

ENDDO keywords
ENDDO must be specified after the threshold STATUS statements with a corresponding initiating THEN DO 
keyword pair.

Acceptable formats

Hexadecimal
0xH - 0xHHHHHHHHHHHHHHHH
0XH - 0XHHHHHHHHHHHHHHHH
1-16 hexadecimal digits

Decimal
(+/-)(.)nnnnnnnnnnnnnnnnnnn - (+/-)nnnnnnnnnnnnnnnnnnn(.)
1-19 decimal digits with decimal point in any position including 1st or last character position

Scaling suffix
(1024) K (kilobytes), M (megabytes), G (gigabytes), T (terabytes), P (petabytes), E (exabytes)

Percentage
%

Time suffix
ms, csec, sec

Rate
/sec, /min, /hr

String
1-70 characters enclosed by double quotes

Note: The status_state value takes precedence over the status_range specified if both are 
specified.
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Administration

The OMEGAMON enhanced 3270 user interface provides workspaces to help administrators to view and 
customize the interface and to validate hub monitoring server connections.

The following workspaces assist administrators:

Runtime Environment (RTE) viewing

Workspace source viewing

Profile customization

Hub connectivity administration

Runtime environment viewing
Use the Runtime Environment workspace to view the Runtime environment and its partitioned data set 
members.

Procedure
Go to the Runtime Environment workspace to view the Runtime environment.
There are a number of ways you can go to the Runtime Environment workspace:

Select Tools › Runtime Environment. Do this action by placing the cursor under Tools on the menu 
bar and pressing Enter. Then, from the File menu select option 8.
Move your cursor over the RTE icon in the drawer and press Enter.

The Runtime Environment KOBJCLS workspace opens. The workspace presents a lists of data sets in the 
Runtime JCL.

Figure 47: Runtime Environment workspace

Use the scrolling arrows or the PF7 and PF8 keys to scroll through the list of available data sets.

Optional: Place your cursor on the input field before a data set, type i and press Enter to see more 
information about a data set.
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The Data Set Information workspace opens and shows you information about the data set, as shown in 
the following example:

Figure 48: Data Set Information workspace

Optional: Place your cursor on the input field before a data set name and press Enter to browse the 
members of a data set.
The Partitioned Dataset Summary workspace opens, as shown in the following example:

Figure 49: Partitioned Dataset Summary workspace

Optional: Place your cursor on the input field before a data set member name and press Enter to view the 
data set source.

Press PF3 (End) until you return to the Runtime Environment workspace.

Use the lateral navigation buttons on the Runtime Environment workspace to go to workspaces that 
show views of both user and runtime data sets for workspaces, profiles, and thresholds.

Figure 50: Lateral navigation push-buttons.

Restriction: JES data sets are listed in the Runtime Environment workspace but cannot be 
browsed.

Tip: The Exit button returns you to your logon workspace.
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Viewing a workspace source
Use a menu selection to view the source for a workspace.

Procedure
Go to the workspace whose source you want to view.

Select View › Workspace Source
The Partitioned Dataset Member (KOBPDSD) view opens showing a view of the workspace source. Use the 
function keys or the cursor sensitive arrow controls to scroll through the source view.

What to do next
If you want to modify the workspace source, you can first clone (make a copy) the workspace and then use a file 
editor such as the ISPF editor to edit the cloned workspace. For more information about cloning and 
customization of workspaces, see “Workspace viewing and cloning” on page 59 and “Customization of product 
provided workspaces” on page 64.

Customizing the interface
The appearance of various components of the interface are controlled by an interface profile. The interface 
profile controls the color assigned to various elements of the interface, the actions assigned to PFKEYs, the 
language in which information is present, and the initial workspace displayed after you log on. IBM supplies a 
default profile named KOBCUA. You can create site-specific or individual user profiles by copying and renaming 
the default profiles and changing the default values to suit your preferences. You can also create site-specific 
locale profiles for users at different locations.

For more information about locale profiles, see “Locale profiles” on page 97.

Interface profiles
Interface profiles, also referred to as logon profiles, control the appearance of workspaces and the source from 
which data is collected. There are three types of interface profiles: IBM default, site, and user.

Interface profiles specify session configuration values for the following workspace properties:

Locale (which controls display formats for date and time, monetary values, and separators)

The color of workspace elements such as headers, borders, and text

The color of status indicators

The initial workspace a user sees

The hub monitoring server from which data is collected

The number of cycles before the auto update is suspended.

The default KOBCUA profile contains session configuration defaults.

You can create a site-defined profile to define settings that are different from the IBM-supplied defaults. This 
customized profile becomes the default for all enhanced 3270 interface sessions at the installation. It takes 
precedence over the IBM-supplied profile. The installation-defined profile must be named CUASITE.

You can create a user profile to customize users' individual sessions. The user-defined profile takes precedence 
over the installation- and IBM-supplied profiles. Name the user profile with the user ID that will be used to log 
on to the interface. Users can use the User Profile Member workspace to customize their profiles. For more 
information about customizing a user profile, see “Customizing a user profile” on page 53.

The IBM-supplied profile is always available and cannot be changed. You must create one or more custom 
profiles based on the IBM-supplied profile and use them to specify the hub monitoring server from which data is 
to be collected for display in the enhanced 3270 user interface.

To create custom site and user interface profiles, copy the IBM-supplied KOBCUA profile to a private read/write 
data set. For more information about creating a custom profile, see “Creating a custom interface profile” on 
page 94.
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Creating a custom interface profile
Create custom interface profiles to specify site or individual preferences for display colors, the initial workspace, 
and the source for the data that is displayed.

Custom profiles are stored in the &hilev.&midlev.UKOBDATF data set, which is created during configuration of 
the interface.

Procedure
In the UKOBDATF data set, create a member with the name CUASITE (for a site profile) or with the user 
ID that will be used to log on to the enhanced 3270 user interface with the profile (for a user profile). This 
is usually a TSO user ID.
Use the profile viewing and cloning feature to create the member. For more information about profile 
viewing and cloning, see “Profile viewing and cloning” on page 94.

Edit the member and modify it to reflect the site or user preferences.

To activate the changes log off the interface and then log back on again.

Profile viewing and cloning
You can use the OMEGAMON enhanced 3270 user interface to view and clone user profiles.

Use Profile viewing and cloning to customize the standard user profiles that are delivered with the enhanced 
3270 user interface.

Preparing for profile cloning
In preparation for profile cloning by a user complete the following administrative steps:

Ensure that the user has the required authority.
The cloning process copies a standard product-provided profile from a configuration runtime environment 
data set to a user profile data set. The runtime environment data set is a read only data set, the user 
profile data set is a writeable data set. The user that wants to clone a profile must have the authority to 
create new members in the user profile data set. The default user profile name is 
<hilev>.<rtename>.UKOBDATF.

Ensure that the user profile data set is the first data set that is specified in the RKOBPROF DD statement. 
The user profile data set is the data set that is pointed to by the enhanced 3270 user interface started 
task JCL UKOBDATF DD statement.
If you ensure that it is the first data set, it facilitates profile testing when customization changes are 
applied.

Minimize potential disruptions to other enhanced 3270 user interface users.
Because the cloning and customization process modifies product provided profiles, it must be done in a 
configuration that is not disruptive to ongoing normal usage of the enhanced 3270 user interface. For 
example, a separate enhanced 3270 user interface address space with a unique instance of the user 
profile data set might be used during the customization and testing process. After the customization and 
testing, the changes might be deployed to a shared development or production configuration by copying 
the customized profiles into a corresponding data set that is specified in the shared development or 
production configuration enhanced 3270 user interface started task JCL.

Related information

Cloning a Profile

Note: This process can also be completed by using the “Profile viewing and cloning” on page 94
procedure.

Important: Be sure that you specify the same <hilev>.<rtename>.UKOBDATF data set in both the 
UKOBDATF DD and RKOBPROF DD statements.
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Cloning a Profile

Use the Profiles workspace to make a copy of a profile and save it to the user profiles data set.

Before you begin
You must complete some administrative steps before a profile is cloned. For more information about these 
steps, see “Profile viewing and cloning” on page 94.

Procedure
Identify the profile to be cloned.

Go to the Runtime Environment (Profiles) workspace to browse the available profiles.
There are a number of ways you can go to Runtime Environment (Profiles) workspace:

From the menu bar, select Tools › Runtime Environment. The Runtime Environment workspace 
opens. Then move your cursor over the Profiles button and press Enter.
Move your cursor over the RTE icon in the drawer and press Enter. The Runtime Environment
workspace opens. Then move your cursor over the Profiles button and press Enter.

The Runtime Environment (Profiles) KOBPROFS workspace opens. This workspace presents two 
workspace subpanels that provide directory lists for the user profile data set (UKOBDATF DD) and the 
runtime environment profiles data set (RKOBPROF DD).

Figure 51: Runtime Environment (Profiles), locating the profile member

Place the cursor in the input field of the profile name that you want to clone and press Enter.
For example, to select the KOBCUA profile, place the cursor in the input field that precedes the profile 
name and press Enter.
The Partitioned Dataset Member (KOBPDSD) view opens showing a view of the KOBCUA profile content.

To clone the profile that is being viewed, select File › Save As .
For example, to clone the KOBCUA profile, place the cursor under File on the menu bar and press Enter. 
Then, from the File menu select option 4, Save As by typing a or 4 and pressing Enter.

Fastpath: You can fast path to File › Save As by entering f.a in the action line.
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Figure 52: Cloning a profile by using the File › Save As menu option

When you press Enter, the Member Save As dialog box opens:

Figure 53: Cloning a profile - the Member Save As dialog box

Enter the profile name that you want to use for the cloned profile.
A typical site administration task is to clone the KOBCUA profile to create a site-defined profile that must 
be named CUASITE. In this example CUASITE is entered in the New Name field.
The saved CUASITE profile is written to the user profile data set. The original IBM-provided KOBCUA profile 
is preserved intact in the runtime environment data set. Because the CUASITE profile is a special case, it is 
also written to the runtime environment data set and it takes precedence over the IBM-provided KOBCUA
profile for all users of the installation. If a name other than CUASITE is entered in the New Name field, the 
saved profile is written only to the user profile data set. To take precedence over the IBM-provided 
KOBCUA profile and the site CUASITE profile for a specific user, name the profile with the user ID of the 
specific user.
When you press Enter, the Save As action is confirmed and you are returned to the Partitioned Dataset 
Member (KOBPDSD) view.

Press PF3 (End) to return to the Runtime Environment (Profiles) KOBPROFS workspace.

Result
The profile directory view for the user profile data set now lists the cloned profile, as shown in the following 
example:
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Figure 54: User profile data set that shows a cloned profile

What to do next
When the profile cloning is complete, edit and test the profile, customizing its contents to user requirements. 
Use a file editor such as the ISPF editor to edit the profile.

Locale profiles
The locale profile controls the display of date, time, currency symbol, and thousandth separator. IBM supplies a 
default profile, KOBENUS, that defines display characteristics that are based on United States English. You can 
create profiles that specify different display characteristics.

A locale profile is a member of the data set allocated to the RKOBPROF DD statement. The name of the member 
must be KOBlocale_id, where locale_id is the 4-character identifier that is specified in the interface profile 
for the session, for example, in the member KOBENUS, ENUS is the identifier that denotes an English (United 
States) profile.

Creating a custom locale profile
Create custom locale profiles to specify your preferences for the date and time format, the currency symbol, 
and the thousands separators.

Custom profiles are stored in the &hilev.&midlev.UKOBDATF data set.

Procedure
In the UKOBDATF data set, create a member with the name KOBcccc, where cccc is the 4-character 
locale ID, for example KOBEURO for a profile with European formats.
Use the profile viewing and cloning feature of the interface to can complete this step. For more 
information about profile viewing and cloning, see “Profile viewing and cloning” on page 94.

Edit the member and modify it to reflect the user preferences.
See “Locale profile keywords” on page 98 for keyword descriptions and possible values.

Remember: Your users can use the User Profile Member workspace to set many of their profile settings 
directly. For more information about this workspace, see “Customizing a user profile” on page 53.
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To activate the changes, log off and back on to the interface .

What to do next
After you create the custom profile, update any site or user profiles that you want to reference the new profile. 
For this example, you specify LOCALEID=EURO in the site or user profiles. Code RKANWEUR DD in your 
procedure and concatenate the data sets with the workspaces to it.

Locale profile keywords
Settings in the locale profile are configured using keyword=value pairs. The keywords are grouped into two 
stanzas: LOCALE and ACTIONBAR.

The <LOCALE> stanza contains the following keywords:
LOCALEDESC

A description of the profile.

DATEFORMAT
Three date formats are supported:

MM/DD/YYYY (the default)

DD/MM/YYYY (European)

YYYY/MM/DD (global)

TIMEFORMAT
Time format can be 12 (default) or 24

CURRENCY
Not currently implemented.

THOUSANDPOS
Not currently implemented.

SCALING
Not currently implemented.

MICROSECOND
Not currently implemented.

The locale profile also contains an <ACTIONBAR> stanza that define the menus and menu options in the action 
bar that appears at the top of workspaces. These definitions cannot be changed.

Hub connectivity administration
Hub connectivity administration is used to validate that a requested hub Tivoli Enterprise Monitoring Server can 
be reached through a TCP/IP connection during the operation of the OMEGAMON enhanced 3270 user 
interface.

Hub connectivity administration provides information about the user interface address space that you are 
running in, on what LPAR, and, in what Sysplex. If your current profile does not specify a hub monitoring server 
for your user interface address space, hub connectivity administration assists you in locating all the available 
hub monitoring servers in your Sysplex. When you locate the available hub monitoring servers, hub connectivity 
administration then helps you to select and make a good connection to the hub. When you establish a good hub 
connection, the connection produces useful data on the user interface.

Hub connectivity administration also provides you with the following information:

A status overview of every hub monitoring server that is known to the user interface

The Managed System Names and Managed System Lists that are known for each hub monitoring server

Remember: If you add a new DD statement for the profile definitions, you must recycle the 
interface to activate the changes.
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The starting point for access to the IBM Tivoli Monitoring Service Index, Tivoli Monitoring Service Consoles, 
and Tivoli Monitoring SOAP servers that are known for each hub monitoring server.

Multi-hub support
You can use the multi-hub support feature to select a secondary hub monitoring server connection. When you 
select a secondary hub connection, you can switch between your primary and secondary hub connections. For 
example, if your site runs multiple hub monitoring configurations, you can use this feature to quickly switch 
between configurations. You can switch connections manually, or automatically, for example in the event of an 
unavailable hub connection.
Secondary Hub Connection

Multi-hub support does not provide a mechanism to make your secondary hub connection a backup or 
failover of your primary hub connection. Unless you have other mechanisms in place to provide a backup or 
failover hub monitoring server, it is more likely that your secondary hub connection is monitoring another 
configuration. For example, your primary hub might be monitoring the production systems configuration, 
while your secondary hub might be monitoring the test systems configuration.

Validate a requested hub Tivoli Enterprise Monitoring Server
While you are interacting with the OMEGAMON enhanced 3270 user interface, a hub Tivoli Enterprise Monitoring 
Server data source is needed to handle SQL queries that are issued by the user interface workspaces that you 
want to display.

During the installation of the enhanced 3270 user interface, part of the configuration process is to specify the 
hub monitoring server, which includes the name of the monitoring server, the IP address, and port number that 
the SQL queries are sent. For example, as shown in the following screen capture:

Figure 55: CUADATA profile definition shown during the configuration process at installation time

When you log on to the user interface, the hub monitoring server specifications are retrieved from your profile, 
and an attempt is made to connect to that hub. If the connection attempt is successful, the initial workspace 
panel for your profile is displayed, for example, the Enterprise Summary (KOBSTART) workspace.

If the hub monitoring server connection attempt fails, the Hub Connectivity Administration workspace is 
displayed, as shown in “Figure: Hub Connectivity Administration workspace that shows a connectivity failure” 
on page 102. This workspace notifies you that a failure occurred and the possible reason for the connection 
failure.

These are some of the reasons for failed connections to a requested hub monitoring server:

The name of the hub monitoring server is incorrect (names are case-sensitive).

Note: For more information about selecting a secondary hub connection, see “Selecting a secondary hub 
connection” on page 113.
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The hub monitoring server IP address is incorrect.

The hub monitoring server TCP/IP port number is incorrect.

The hub monitoring server is not operational (not started or is having communications problems).

TCP/IP or z/OS® UNIX® System Services on the z/OS system that is running the user interface address 
space is not configured to allow TCP/IP communications between the interface and the hub monitoring 
server.

A TCP/IP firewall is preventing successful communications between the interface and the hub monitoring 
server.

Logon administration and customization
When you log on to the enhanced 3270 user interface (enhanced 3270UI) for the first time, Hub Connectivity 
Administration can assist you to specify a hub Tivoli® Enterprise Monitoring Server connection.

Procedure
Log on to the user interface in the standard way.
For more information about logging on, see “Logging on” on page 16.
If a hub monitoring server is specified in your profile, and that hub is available, a connection is made to 
the hub and your initial workspace is displayed. By default, the initial workspace is the Enterprise 
Summary (KOBSTART) workspace. If a hub monitoring server is not specified in your profile, the Hub 
Connectivity Administration workspace is displayed.

Figure 56: Hub Connectivity Administration workspace that shows a hub connection is not specified for the 
current profile

To select the NEXT icon on the Hub Connectivity Administration workspace, move your cursor to the 
icon and press Enter or double-click the icon.
The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known 
to the enhanced 3270UI.
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Figure 57: Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace

On the All Known Hubs (KOBHUBS) workspace, place your cursor next to a hub monitoring server name 
and press Enter.
The Action Confirmation panel is displayed. The panel lists information about the hub monitoring server 
to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to confirm the 
action or N to cancel the action.

Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and 
shows two green information boxes that indicate a successful TCP/IP connection.

Tip: You can browse overview status information about each hub from this workspace. For more 
information about the All Known Hubs (KOBHUBS) workspace, see “The All Known Hubs 
workspace” on page 109.
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Figure 58: Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection

To save the hub monitoring server name to your user profile, select SAVE.

To use the selection for your current enhanced 3270UI session, select OK.

Result
Your session goes to the first workspace name specified in your logon profile, by default the Enterprise 
Summary (KOBSTART) workspace.

Correcting a failed hub server connection
Use Hub Connectivity Administration to assist you in locating all of the available Tivoli Enterprise Monitoring 
Server data sources. Hub Connectivity Administration helps you to correct any failed connection situations that 
prevent you from accessing the OMEGAMON enhanced 3270 user interface and your subsequent product 
workspaces.

About this task
When you log on to the user interface, if the hub monitoring server connection attempt fails, the Hub 
Connectivity Administration workspace is displayed and notifies you that a failure occurred and the possible 
reason for the connection failure. The workspace helps you to correct the connection failure and to save a 
corrected profile to prevent future failures.

Figure 59: Hub Connectivity Administration workspace that shows a connectivity failure

Procedure
On the Hub Connectivity Administration workspace that shows the connectivity failure, select the NEXT
icon by moving your cursor to the icon and pressing Enter or moving your mouse to the icon and selecting 
it.
The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known 
to the user interface.

Tip: If this is your first time logging on to the user interface and a hub monitoring server is not specified in 
your profile, you see the Hub Connectivity Administration workspace but with a different message that 
states the reason for the failure. If the message indicates that your current profile does not have a hub 
specified, see “Logon administration and customization” on page 56.
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Figure 60: Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace

On the All Known Hubs (KOBHUBS) workspace, place your cursor next to a hub monitoring server name 
and press Enter.
The Action Confirmation panel is displayed. The panel lists information about the hub monitoring server 
to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to confirm the 
action or N to cancel the action.

Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and 
shows two green information boxes that indicate a successful TCP/IP connection.

Tip: You can browse overview status information about each hub from this workspace. For more 
detailed information about the All Known Hubs (KOBHUBS) workspace, see “The All Known Hubs 
workspace” on page 109.
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Figure 61: Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection

To save the hub monitoring server name to your user profile, select the SAVE icon.

To use the selection for your current user interface session, select the OK icon.

Result
Your session goes to the first workspace name specified in your logon profile, by default the Enterprise 
Summary (KOBSTART) workspace.

Changing a hub server connection
Use Hub Connectivity Administration to change your existing hub connection.

Before you begin
If you have not yet successfully connected to a hub monitoring server, see “Correcting a failed hub server 
connection” on page 102.

About this task
When you are logged on to the user interface, and are successfully connected to a hub monitoring server, you 
can use Hub Connectivity Administration to browse other hub connections that are available. While browsing 
the available hubs, you can select and connect to a different hub. Finally you can use the workspace to save the 
newly specified hub connection to your profile, either for the current session only, or to your profile for future 
sessions.

Procedure
Go to the Hub Connectivity Administration workspace.
To go to Hub Connectivity Administration workspace, enter the HUB command, select Tools › Current 
Hub Information from the menu bar or move your cursor over HUB in the drawer and press Enter.
The Hub Connectivity Administration workspace is displayed.

Figure 62: Hub Connectivity Administration workspace that shows an existing hub connection

Tip: If you previously selected a secondary hub connection, you see more information in the Hub 
Connectivity Administration workspace. For more information about selecting a secondary hub 
connection, see “Selecting a secondary hub connection” on page 113.
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On the Hub Connectivity Administration workspace, select the NEXT icon by moving your cursor to the 
icon and pressing Enter or moving your mouse to the icon and selecting it.
The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known 
to the user interface.

Figure 63: Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace

The existing hub connection is highlighted as shown in the screen capture.

On the All Known Hubs (KOBHUBS) workspace, select a different hub by placing your cursor next to a 
hub monitoring server name and press Enter.
The Action Confirmation panel is displayed. The panel lists information about the new hub monitoring 
server to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to 
confirm the action or N to cancel the action.

Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and 
shows two green information boxes that indicate a successful TCP/IP connection.

Tip: You can browse overview status information about each hub from this workspace. For more 
detailed information about the All Known Hubs (KOBHUBS) workspace, see “The All Known Hubs 
workspace” on page 109.
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Figure 64: Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection

To save the hub monitoring server name to your user profile, select the SAVE icon.

To use the selection for your current user interface session, select the OK icon.

Result
Your session goes to the first workspace name specified in your logon profile, by default the Enterprise 
Summary (KOBSTART) workspace.

What to do next
You can optionally select a secondary hub connection. For more information about selecting a secondary hub 
connection, see “Selecting a secondary hub connection” on page 113.

Switching hub connections
When you select a secondary hub connection, you can switch between your primary and secondary hub 
connections.

Before you begin
To select a secondary hub connection, see “Selecting a secondary hub connection” on page 113.

About this task
You can manually switch between your primary and secondary hub connection, which is described in the 
following procedure.

In the event of one of the connections being unavailable, you can automatically switch between primary and 
secondary hub connections. A hub connectivity check runs when the Hub Check option is enabled in your User 
Preferences. The Hub Check option is enabled by default. If the hub connectivity check fails, an attempt is 
made to auto-switch your hub connection to your chosen secondary connection. If the switch is successful you 
see a notification similar to the one shown in “Figure: Hub Connectivity Alert Multi-Hub Switch Notification 
workspace” on page 108. For more information about the Hub Check option, see “User Preferences” on page 
53.
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Procedure
Use one of the following methods to switch hub connections.

Go to the Hub Connectivity Administration workspace and select the SWITCH icon.

Figure 65: Hub Connectivity Administration Existing Multi-Hub Configuration workspace.

Select Tools › Switch between hubs from the menu bar.
From the action or command line, enter the SWITCH command.

If the switch is successful, the Hub Connectivity Alert workspace displays a Multi-Hub Switch 
Notification to confirm that your hub connections are switched.

Note: Mechanisms are not provided to make your secondary hub connection a backup or failover of your 
primary hub connection. For more information about multi-hub support, see “Multi-hub support” on page 
99.

Tip: To go to Hub Connectivity Administration workspace, select Tools › Current Hub 
Information from the menu bar or move your cursor over HUB in the drawer and press 
Enter.

Tip: The Existing Multi-Hub Configuration panel and the Tools › Switch between hubs options are 
only available if you previously selected a secondary hub connection.
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Figure 66: Hub Connectivity Alert Multi-Hub Switch Notification workspace

Select OK.
Your session goes to the first workspace name specified in your logon profile, by default the Enterprise 
Summary (KOBSTART) workspace.

Tip:
If you attempt to switch to a hub connection that is not available, you see a Hub Connectivity Alert 
Multi-Hub Switch Warning and the switch does not occur.

Figure 67: Hub Connectivity Alert Multi-Hub Switch Warning workspace.

If either your primary or secondary hub connections are unavailable, select NEXT on the Hub 
Connectivity Alert workspace to view other possible hub connections that may be available.
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Discarding a secondary hub connection
If you previously selected a secondary hub connection, but later decide that you no longer need a secondary 
hub connection, you can discard it.

About this task
The option to discard a secondary hub connection is only available when you previously selected a secondary 
hub connection. For more information about selecting a secondary hub connection, see “Selecting a secondary 
hub connection” on page 113.

Procedure
Use one of the following methods to discard a secondary hub connection.

Select Tools › Discard the secondary hub from the menu bar.
From the action or command line, enter the DISCARD command.

The Discard Confirmation pop-up window opens.

Choose from the following options on the pop-up window.

Select OK to discard your secondary hub connection only for the current session.
Select SAVE to update your profile and discard your secondary hub connection permanently.
Select CANCEL to do nothing, your secondary hub connection is not discarded.

The All Known Hubs workspace
You can use the All Known Hubs workspace to view status information about each of the available hub Tivoli 
Enterprise Monitoring Servers in your Sysplex.

Use the All Known Hubs workspace to select and connect to an available hub monitoring server. The 
connection procedure is detailed in other topics. For more information about the connection procedure, see 
“Changing a hub server connection” on page 104, “Correcting a failed hub server connection” on page 102, and 
“Logon administration and customization” on page 56.

You can use the All Known Hubs workspace to view valuable status information about each hub monitoring 
server that can help you decide the hub to use for your monitoring activities.

The workspace can be scrolled vertically and horizontally to view all of the available hubs and their status 
information. You can use PF10 and PF11 keys to scroll horizontally and PF7 and PF8 keys to scroll vertically. 
The workspace also contains vertical and horizontal arrow keys that you can use for scrolling. Select an arrow 
and press Enter to scroll in this way.



110

Figure 68: Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace

Hub status information
The following fields are displayed for every hub in the All Known Hubs workspace
Hub Name

The name that is given to a hub monitoring server during IBM Tivoli Monitoring configuration of a runtime 
environment (RTE).

Hub Connect Status
A text value that indicates whether a TCP connection can be established between the enhanced 3270 user 
interface address space and the specific hub monitoring server and whether an SQL query can be issued to 
the hub monitoring server. This TCP connection is attempted and then immediately closed. The TCP port 
number that is used is the port number that is assigned to this hub monitoring server during Tivoli 
Monitoring configuration of an RTE (typically port number 1918). Check the user interface REXX log 
(RKANRXLG DD name) for more details if the status is not Success.
The text values in the Hub Connect Status field can be as follows:

Success
The TCP connect and a query completed at the Hub.

Data Failure
A TCP send or receive failed with the Hub.

Timed Out
A TCP connect cannot complete in the allotted time.

Connect Fail
The TCP connect cannot complete.

TCP Failure
TCP cannot connect because of a failure with a TCP socket or select call.

Query Failed
A TCP connect was successful, but an SQL query to the Hub did not complete.

CannotAccess
The TCP port number to access the Hub cannot be determined.

SAF Denied



111

The status cannot be determined because the user does not have security authorization to connect to 
the specified Hub.

ITM Service Index Status
A text value that indicates whether a TCP connection can be established between the enhanced 3270 user 
interface address space and the IBM Tivoli Monitoring Service Index component that is running at the 
specific hub monitoring server and whether the Tivoli Monitoring Service Index data can be retrieved. The 
TCP port number that is used is the HTTP port number that is assigned to this hub monitoring server during 
Tivoli Monitoring configuration of an RTE (typically port number 1920). Check the user interface REXX log 
(RKANRXLG DD name) for further details if the status is not Success.
The text values in the ITM Service Index Status field can be as follows:

Success
The TCP connect and Service Index retrieval completed at the Hub.

Data Failure
A TCP send or receive failed with the Hub.

Timed Out
A TCP connect and data retrieval did not complete in the allotted time.

Connect Fail
The TCP connect cannot complete.

TCP Failure
TCP cannot connect because of a failure with a TCP socket or select call.

No HTTP Port
The TCP port number that is needed to access the HTTP Server at the Hub cannot be determined.

Did Not Try
Because of previous connectivity failures an attempt is not made to find the value.

SAF Denied
The status cannot be determined because the user does not have security authorization to connect to 
the specified Hub.

SOAP Status
A text value that indicates whether a TCP connection can be established between the enhanced 3270 user 
interface address space and the IBM Tivoli Monitoring SOAP server component that is running at the 
specific hub monitoring server and whether sample SQL query data can be retrieved. The TCP port number 
that is used is the HTTP port number that is assigned to this hub monitoring server during Tivoli Monitoring 
configuration of an RTE (typically port number 1920). Check the user interface REXX log (RKANRXLG DD 
name) for further details if the status is not Success.
The text values in the SOAP Status field can be as follows:

Success
The TCP connect and SOAP query completed at the Hub.

Data Failure
A TCP send or receive failed with the Hub.

Timed Out
A TCP connect and data retrieval did not complete in the allotted time.

Connect Fail
The TCP connect cannot complete.

TCP Failure
TCP cannot connect because a failure with a TCP socket or select call.

No HTTP Port
The TCP port number that is needed to access the HTTP Server at the Hub cannot be determined.

Did Not Try
Because of previous connectivity failures an attempt is not made to find the value.
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SAF Denied
The status cannot be determined because the user does not have security authorization to connect to 
the specified Hub.

Hub Connect Time
The number of seconds it took to complete the TCP connection to the hub monitoring server. A value of n/a
indicates the TCP connect cannot be attempted.

Hub Time (bar graph)
A small horizontal bar graph that shows the Hub Connect Time. This field is highlighted by colors that 
depend on the threshold settings for the KOBHUBS table, which you can adjust.

ITM Service Index Time
The number of seconds it took to retrieve the IBM Tivoli Monitoring Service Index from the hub monitoring 
server. A value of n/a indicates the TCP connect cannot be attempted.

Srvc Time (bar graph)
A small horizontal bar graph that shows the Tivoli Monitoring Service Index Time. This field is highlighted by 
colors that depend on the threshold settings for the KOBHUBS table, which you can adjust.

SOAP Time
The number of seconds it took to run a simple SOAP SQL query at the hub monitoring server. A value of n/a
indicates the TCP connect cannot be attempted.

SOAP Time (bar graph)
A small horizontal bar graph that shows the SOAP Time. This field is highlighted by colors that depend on 
the threshold settings for the KOBHUBS table, which you can adjust.

HTTP Port
The TCP port number that is used with HTTP to access the IBM Tivoli Monitoring Service Index and the 
SOAP server. If there is no port number configured, the text value Missing is shown.

HTTPS Port
The TCP port number that is used with HTTPS to access the Tivoli Monitoring Service Index and the SOAP 
server. If there is no port number configured, the text value Missing is shown. HTTPS is a version of HTTP 
that supports authentication and encryption.

Hub DRA Count
The number of Data Retrieval Agents (DRAs) used by the enhanced 3270 user interface for this particular 
hub monitoring server.

Hub TCP/IP Host Name
The host name of the TCP/IP interface in use by the hub monitoring server.

Hub IP Address
The IP address in use by the hub monitoring server to which all user interface requests are directed.

Hub Port
The TCP port number in use by the hub monitoring server to which all user interface requests are directed. 
The port number is typically 1918.

Hub Start Date
The date that the hub monitoring server job was started.

Hub Start Time
The time of day that the hub monitoring server job was started.

Hub Job Name
The job name (z/OS system) or task name (Windows, UNIX, or Linux systems) under which the hub 
monitoring server is running.

Hub System Name
The operating system name under which the hub monitoring server is running.

Hub System Type
The operating system type under which the hub monitoring server is running. Typical values: z/
OS;01.13.00, Linux;2.6.9-67.EL or Win2008;6.0-SP2.
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Selecting a secondary hub connection
Use the multi-hub feature to select a secondary hub connection.

Before you begin
If you are not yet successfully connected to a hub monitoring server, see “Correcting a failed hub server 
connection” on page 102.

About this task
When you are logged on to the user interface, and are successfully connected to a hub monitoring server, you 
can use Hub Connectivity Administration to browse other hub connections that are available. While you are 
browsing the available hub connections, you can use the multi-hub feature to select a secondary hub 
connection.

When you select a secondary hub connection, you can save the connection to your profile, either for the current 
session only, or to your profile for the current and future sessions.

For more information about multi-hub support, see “Multi-hub support” on page 99

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to select a secondary 
hub connection.

Place your cursor next to the hub monitoring server name that you are interested in, type / and 
press Enter, then select Select this hub as Secondary from the Options Menu.
Place your cursor next to the hub monitoring server name that you are interested in, type B and 
press Enter.

The Secondary Hub Verification workspace is displayed. A diagram shows two colored information boxes 
that represent your hub connections. Under conditions where your primary hub connection is available, a 
green box represents the primary hub connection with an indication that it is ACTIVE. Under conditions 
where your secondary hub connection is available, a light blue box represents the secondary hub 
connection with an indication that it is READY.

Tip: Under conditions when your primary or secondary hub connections are unavailable when you 
select your secondary hub connection, you see variations of “Figure: Secondary Hub Verification 
workspace ” on page 114. Unavailable connections are indicated by yellow colored boxes on the 
workspace. In such conditions, the workspace assists you to locate available hub connections.
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Figure 69: Secondary Hub Verification workspace

To use the secondary hub selection for your current user interface session, select the OK icon.

To use the secondary hub selection for your current user interface session and to save the 
secondary hub monitoring server name to your user profile, select the SAVE icon.

Result
Your session goes to the first workspace name specified in your logon profile, by default the Enterprise 
Summary (KOBSTART) workspace.

The name of the currently active hub connection is displayed in the footer area of the workspace.

What to do next
For more information about switching between your primary and secondary hub connections, see “Switching 
hub connections” on page 106.

Displaying hub overview status
You can use the Hub Overview workspace to see overview status about a specific hub Tivoli Enterprise 
Monitoring Server.

About this task
This procedure shows you how to view status information about a specific hub monitoring server.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 
109.

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Hub 
Overview (KOBHBSTO) workspace:

Place your cursor next to the hub monitoring server name that you are interested in, type / and 
press Enter, then select Status Overview for Hub from the Options menu.
Place your cursor next to the hub monitoring server name that you are interested in, type O and 
press Enter.

The Hub Overview workspace is displayed.
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Figure 70: Hub Overview (KOBHBSTO) workspace

Displaying products installed on a hub
You can use the Installed TEMS Applications workspace to see the products that are installed on a specific hub 
Tivoli Enterprise Monitoring Server.

About this task
This procedure shows you how to view all of the installed products on a specific hub that is available from this 
workspace.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 
109.

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Installed 
TEMS Applications (KOBAPPS) workspace:

Place your cursor next to the hub monitoring server name that you are interested in, type / and 
press Enter, then select Products installed in this Hub from the Options Menu.
Place your cursor next to the hub monitoring server name that you are interested in, type P and 
press Enter.

The Installed TEMS Applications workspace is displayed.
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Figure 71: Installed TEMS Applications (KOBAPPS) workspace

Displaying Data Retrieval Agents (DRA) for a hub
You can use the Data Retrieval Agents (DRA) workspace to see the data retrieval agents for a specific hub Tivoli 
Enterprise Monitoring Server.

About this task
Data Retrieval Agents (DRA) are enhanced 3270 user interface components that manage the SQL queries sent 
from the user interface address space to a hub monitoring server. The DRA components do not gather 
performance data from Managed Systems: They manage the interactions between the user interface and the 
hub monitoring server address spaces. DRA components run within the hub monitoring server, Remote Tivoli 
Enterprise Monitoring Servers, and Tivoli Enterprise Monitoring Agents. DRA components are only on z/OS 
systems.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 
109.

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Data 
Retrieval Agents (KOBHBDRA) workspace:

Place your cursor next to the hub monitoring server name that you are interested in, type / and 
press Enter, then select DRAs connected to Hub from the Options Menu.
Place your cursor next to the hub monitoring server name that you are interested in, type A and 
press Enter.

The Data Retrieval Agents (DRA) workspace is displayed.
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Figure 72: Data Retrieval Agents (KOBHBDRA) workspace

Displaying Managed System Lists (MSL) for a hub
You can use the Managed Systems workspace to see Managed System Lists for a specific hub Tivoli Enterprise 
Monitoring Server.

About this task
This procedure shows you how to view all of the Managed System Lists (MSLs) for a specific hub that is available 
from this workspace.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 
109.

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Managed 
System Lists (KOBHBMSL) workspace:

Place your cursor next to the hub monitoring server name that you are interested in, type / and 
press Enter, then select MSLs known by Hub (Managed System Lists) from the Options Menu.
Place your cursor next to the hub monitoring server name that you are interested in, type L and 
press Enter.

The Managed System Lists workspace is displayed.
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Figure 73: Managed System Lists (KOBHBMSL) workspace

Displaying Managed System Names (MSN) for a hub
You can use the Managed Systems workspace to see Managed System Names for a specific hub Tivoli 
Enterprise Monitoring Server.

About this task
An important characteristic of a hub monitoring server is the Managed System Names (MSNs) that are managed 
by that hub. These Managed Systems are the entities that are being monitored by Tivoli Monitoring agents. This 
procedure shows you how to view the Managed System Names (MSNs) that are managed by a specific hub.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 
109.

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Managed 
Systems (KOBHBMSN) workspace:

Place your cursor next to the hub monitoring server name that you are interested in, type / and 
press Enter, then select MSNs known by Hub (Managed System Names) from the Options Menu.
Place your cursor next to the hub monitoring server name that you are interested in, type N and 
press Enter.

The Managed Systems workspace is displayed:
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Figure 74: Managed Systems (KOBHBMSN) workspace

IBM Tivoli Monitoring (ITM) Service Index
You can use the ITM Service Index workspace to see, and interact, with a list of IBM Tivoli Monitoring Service 
Points for a specific hub Tivoli Enterprise Monitoring Server.

Before you begin
Go to the All Known Hubs (KOBHUBS) workspace. For more information, see “Changing a hub server 
connection” on page 104

About this task
The IBM Tivoli Monitoring (ITM) Service Index is a feature that displays a list of IBM Tivoli Monitoring Service 
Points. A user can interact with these IBM Tivoli Monitoring Service Points. The ITM Service Index is normally 
accessed from a Web Browser running under Microsoft Windows, Linux, or UNIX, but can now be accessed 
directly from the enhanced 3270 user interface.

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 
109.

Procedure
From the All Known Hubs (KOBHUBS) workspace go to the ITM Service Index (KOBHNDX) workspace by 
using one of the following methods:

Place your cursor next to the hub Tivoli Enterprise Monitoring Server name that you are interested 
in, type / and press Enter, then select ITM Service Index for Hub from the Options Menu.
Place your cursor next to the hub Tivoli Enterprise Monitoring Server name that you are interested 
in, type I and press Enter

The ITM Service Index workspace is displayed.
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Figure 75: ITM Service Index (KOBHBNDX) workspace .

IBM Tivoli Monitoring (ITM) Service Index (secure HTTPS)
You can use the ITM Service Index workspace (secure HTTPS) to see, and interact, with a list of IBM® Tivoli®
Monitoring Service Points for a specific hub Tivoli Enterprise Monitoring Server.

Before you begin
Go to the All Known Hubs (KOBHUBS) workspace. For more information, see “Changing a hub server 
connection” on page 104

About this task
When you use the IBM® Tivoli® Monitoring Service Console and IBM® Tivoli® Monitoring SOAP Server 
workspaces within the Tivoli® OMEGAMON® Manager, you must supply a user ID and password. This 
information is sent to a Tivoli Enterprise Monitoring Server. The user ID and password (and the Service 
Console or SOAP commands and their results) are normally sent in "clear text" using TCP/IP and the HTTP 
protocol. HTTP is normally used by web browsers and servers. For the Tivoli® OMEGAMON® Manager, the Tivoli® 
OMEGAMON® Manager is acting as an HTTP client, like a web browser, while the monitoring server is the HTTP 
server.

If you want these values (especially the password) to be sent in encrypted form instead of clear text, you must 
use the secure version of these Tivoli® OMEGAMON® Manager workspaces. To be able to use the secure 
versions of these Tivoli® OMEGAMON® Manager workspaces, your Tivoli® OMEGAMON® Manager address space 
must be able to use the Hypertext Transfer Protocol Secure (HTTPS) communications protocol. HTTPS is the 
normal HTTP protocol, but uses SSL/TLS (Secure Sockets Layer and Transport Layer Security) to send 
information. The Tivoli® OMEGAMON® Manager address becomes enabled to use HTTPS by identifying the 
Tivoli® OMEGAMON® Manager address space to TCP/IP as a user of AT-TLS (Application Transparent-Transport 
Layer Security).

You identify your Tivoli® OMEGAMON® Manager address spaces as valid users of AT-TLS by creating or 
modifying an AT-TLS policy file and then refreshing a z/OS component that is known as the Policy Agent, which 
reads the updated policy file.

For more information about AT-TLS configuration, see IBM Tivoli OMEGAMON for z/OS: Planning and 
Configuration Guide.

Procedure
From the All Known Hubs (KOBHUBS) workspace, use one of the following methods to go to the ITM 
Service Index (KOBHNDX) workspace:
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Place your cursor next to the hub Tivoli Enterprise Monitoring Server name that you are interested 
in, type / and press Enter, then select ITM Service Index for Hub (secure HTTPS) from the 
Options Menu.
Place your cursor next to the hub Tivoli Enterprise Monitoring Server name that you are interested 
in, type J and press Enter

The ITM Service Index workspace is displayed.

Displaying hub topology
You can use the Hub Topology workspace to see information about nodes that are known to the hub monitoring 
server.

About this task
This procedure shows you how to view and filter information about nodes that are known to the hub monitoring 
server

For more information about the All Known Hubs workspace, see “The All Known Hubs workspace” on page 
109.

Procedure
From the All Known Hubs (KOBHUBS) workspace use one of the following methods to go to the Hub 
Topology (KOBHBTPO) workspace:

Place your cursor next to the hub monitoring server name that you are interested in, type / and 
press Enter, then select Topology: Nodes known to this Hub from the Options Menu.
Place your cursor next to the hub monitoring server name that you are interested in, type T and 
press Enter.

The Hub Topology workspace is displayed.

Figure 76: Hub Topology workspace

Optional: To see only online nodes, type a non-blank character in the Online field and leave the Offline
field empty.

Optional: To see only offline nodes, type a non-blank character in the Offline field and leave the Online
field empty.

Optional: To see both online and offline nodes, type a non-blank character in both the Offline and Online
fields.
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5. Optional: To limit the rows that are displayed, type include=value, exclude=value, or both in the 
Options field.
The value string must match part of a row value for the row to be included or excluded from the 
workspace display. If you want to use embedded blanks as part of the value string, you must enclose 
the entire value string in single or double quotations. The case of the value string (uppercase or 
lowercase) must match the row data exactly. The include and exclude keywords can be in lowercase 
or uppercase. Empty spaces are not allowed on either side of the equal sign.
The following table contains some example Options entries:

Example filter entries in the Options field.

Table 4: Example filter entries in the Options field.

Filter condition Options

Show only rows that contain DB2. include=DB2

Show only rows that contain M5 preceded and 
followed by an empty space. For example, the Prd
(Product) column entries in the workspace for the 
M5 product.

include=' M5 '

Show only Hub or remote monitoring servers but 
exclude any at version=06.23.03

include=' EM ' exclude=06.23.03

Show only nodes on Windows™ systems. include=' Win'

Tip: You can clear the Online and Offline fields by typing a space in them.
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Troubleshooting

The troubleshooting section provides problem determination and resolution for the issues that are most 
commonly encountered with the OMEGAMON® Enhanced 3270 user interface. Review the troubleshooting 
topics for a description of a problem you might experience with rendering OMEGAMON® monitoring agent data 
on the enhanced 3270UI. For issues encountered with specific OMEGAMON® monitoring agents, consult the 
troubleshooting guide for that product.

Use of DBCS characters in near term history situation names
Exercise caution when you are working with history situation names that use a double-byte character set 
(DBCS).

Problem description
Situation names for near term history collections can be created and edited both on the enhanced 3270UI and 
the Tivoli Enterprise Portal Server. The portal server supports the use of double-byte character set (DBCS) 
characters, however, the enhanced 3270UI does not.

A DBCS supports national languages that contain many unique characters or symbols. Examples of such 
languages include Japanese, Korean, and Chinese.

Near term history situation names that are created with DBCS characters on a portal server appear garbled on 
the enhanced 3270UI. For example, the name displays control and other characters that do not make sense. 
You can edit the situation names on the enhanced 3270UI, however, do not attempt to do this as the original 
name is then corrupted on the portal server.

Symptoms of this problem are that historical collection situation names that use DBCS characters become 
corrupted on the Tivoli Enterprise Portal Server when they are edited with the enhanced 3270UI.

Solution
Use one of the following workarounds:

Use only the Tivoli Enterprise Portal Server to change history collection names that use DBCS characters.

Change the history collection name to one that does not use DBCS characters.

No data condition on the OMEGAMON® Enhanced 3270 user interface
The OMEGAMON® Enhanced 3270 user interface (enhanced 3270UI) is installed and configured. The enhanced 
3270UI address space is started and you are able to log on. However, your enhanced 3270UI is showing an 
empty workspace.

Possible causes for the no data condition
There are a few causes for the no data condition after the initial log on to the OMEGAMON Enhanced 3270 user 
interface.

The following figure provides an example of the OMEGAMON Enhanced 3270 user interface initial workspace, 
KOBSTART, depicting a case of no data after the initial log on:
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Figure 77: OMEGAMON Enhanced 3270 user interface workspace depicting a case of no data after the initial log 
on

You can use the capability in the OMEGAMON Enhanced 3270 user interface for investigating the root cause of 
the no data condition.

Custom log on profiles have not been created or the hub monitoring server 
settings have not been configured

Depending on the version of the enhanced 3270UI that you are using there are different procedures that you 
can use to troubleshoot this issue.

Tivoli Management Services V6.3.2 (APAR OA42127) or later
Hub Connectivity Administration assists you to specify and save a hub Tivoli Enterprise Monitoring Server 
connection.

About this task
When you log on to the enhanced 3270 user interface for the first time, Hub Connectivity Administration can 
assist you to specify a hub Tivoli Enterprise Monitoring Server connection.

Procedure
Log on to the user interface in the standard way.
If a hub monitoring server is specified in your profile, and that hub is available, a connection is made to 
the hub and your initial workspace is displayed. By default, the initial workspace is the Enterprise 
Summary (KOBSTART) workspace. If a hub monitoring server is not specified in your profile, the Hub 
Connectivity Administration workspace is displayed.

Note: The initial workspace parameter setting is specified in the log on profile with the FIRSTWS
parameter.
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Figure 78: Hub Connectivity Administration workspace that shows a hub connection is not specified for the 
current profile

To select the NEXT icon on the Hub Connectivity Administration workspace, move your cursor to the 
icon and press Enter or double-click the icon.
The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known 
to the enhanced 3270 user interface.

Figure 79: Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace

Tip: You can browse overview status information about each hub from this workspace. For more 
information about the All Known Hubs (KOBHUBS) workspace, see “The All Known Hubs 
workspace” on page 109.
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b.

1.

On the All Known Hubs (KOBHUBS) workspace, place your cursor next to a hub monitoring server name 
and press Enter.
The Action Confirmation panel is displayed. The panel lists information about the hub monitoring server 
to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to confirm the 
action or N to cancel the action.

Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and 
shows two green information boxes that indicate a successful TCP/IP connection.

Figure 80: Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection

To save the hub monitoring server name to your user profile, select SAVE.

To use the selection for your current enhanced 3270 user interface session, select OK.

Result
Your session goes to the first workspace name specified in your logon profile, by default the Enterprise 
Summary (KOBSTART) workspace.

Tivoli Management Services V6.3 or earlier (pre-APAR OA42127)
Verify that you created your site and or user_ID named logon profile members.

About this task
Use the OMEGAMON Enhanced 3270 user interface to assign values for your site and or user ID named logon 
profile.

Procedure
From the OMEGAMON Enhanced 3270 user interface, select View › 2. Hub Information. The Current Hub 
TEMS Information panel is displayed.
If you see a panel similar to the following panel that indicates no values are assigned, either no site and or 
user ID-named logon profile is created, or the profile for this session is not customized to specify hub 
monitoring server settings.
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2.

Figure 81: Tivoli Enterprise Monitoring Server information with no settings specified

Verify that a site (CUASITE) or user_ID named data set member exists in rte.UKOBDATF.

Verify that the hub monitoring server settings in the profile for the current session is customized to 
specify the hub monitoring server configured values.
For example, see “Figure: Current hub Tivoli Enterprise Monitoring Server settings” on page 127.

After you customize the logon profile member, log off the OMEGAMON Enhanced 3270 user interface and 
log on to pick up the profile changes.

Result
If you repeat Step 1, you see the hub settings that you specified as shown in the following panel.

Figure 82: Current hub Tivoli Enterprise Monitoring Server settings

The hub monitoring server settings in the log on profile do not match the 
hub monitoring server configured values

Depending on the version of the enhanced 3270UI that you are using there are different procedures that you 
can use to troubleshoot this issue.

Tivoli Management Services V6.3.2 (APAR OA42127) or later
Hub Connectivity Administration helps you to correct any failed connection situations that prevent you from 
accessing the OMEGAMON enhanced 3270 user interface and your subsequent product workspaces.

About this task
When you log on to the user interface, if the hub monitoring server connection attempt fails, the Hub 
Connectivity Administration workspace is displayed and notifies you that a failure occurred and the possible 
reason for the connection failure. The workspace helps you to correct the connection failure and to save a 
corrected profile to prevent future failures.
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Figure 83: Hub Connectivity Administration workspace that shows a connectivity failure

Procedure
On the Hub Connectivity Administration workspace that shows the connectivity failure, select the NEXT
icon by moving your cursor to the icon and pressing Enter or moving your mouse to the icon and selecting 
it.
The All Known Hubs (KOBHUBS) workspace is displayed showing all of the available hubs that are known 
to the user interface.

Tip: If this is your first time logging on to the user interface and a hub monitoring server is not specified in 
your profile, you see the Hub Connectivity Administration workspace but with a different message that 
states the reason for the failure. If the message indicates that your current profile does not have a hub 
specified, see “The hub monitoring server settings in the log on profile do not match the hub monitoring 
server configured values” on page 127.
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Figure 84: Hub Connectivity Administration All Known Hubs (KOBHUBS) workspace

On the All Known Hubs (KOBHUBS) workspace, place your cursor next to a hub monitoring server name 
and press Enter.
The Action Confirmation panel is displayed. The panel lists information about the hub monitoring server 
to be used for your workspace queries. On the Action Confirmation panel, you can enter Y to confirm the 
action or N to cancel the action.

Enter Y to confirm the action. The Hub Verification Complete (KOBHUB04) workspace is displayed and 
shows two green information boxes that indicate a successful TCP/IP connection.

Tip: You can browse overview status information about each hub from this workspace. For more 
information about the All Known Hubs (KOBHUBS) workspace, see “The All Known Hubs 
workspace” on page 109.
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Figure 85: Hub Verification Complete (KOBHUB04) workspace that shows a successful hub connection

To save the hub monitoring server name to your user profile, select the SAVE icon.

To use the selection for your current user interface session, select the OK icon.

Result
Your session goes to the first workspace name specified in your logon profile, by default the Enterprise 
Summary (KOBSTART) workspace.

Tivoli Management Services V6.3 or earlier (pre-APAR OA42127)
Verify that the rte.UKOBDATF profile members specify the configured hub monitoring server settings and that 
these settings match the hub monitoring server configured values.

The settings that are shown in the Current Hub TEMS Information panel in “Figure: Current hub Tivoli 
Enterprise Monitoring Server settings” on page 127 indicate that a custom profile member is created and 
customized; however, the no data condition persists. Inspect the profile for the current session to determine if 
the specified settings match the configured hub monitoring server settings.

For example, “Figure: Current hub Tivoli Enterprise Monitoring Server settings” on page 127shows that the 
server name is set to RTE1.CMS , with a period. However, the actual configured hub monitoring server name is 
RTE1:CMS , with a colon.

Correct the settings in the rte.UKOBDATF profile member, then log off and log on to the OMEGAMON Enhanced 
3270 user interface to pick up the profile changes.

The Current Hub TEMS Information panel displays the correct settings as shown in the following example:

Figure 86: The current hub Tivoli Enterprise Monitoring Server information with the correct server name

There are no OMEGAMON Enhanced 3270 user interface data retrieval 
agents registered

Verify that there are registered OMEGAMON Enhanced 3270 user interface data retrieval agents online.

The OMEGAMON Enhanced 3270 user interface startup process discovers WLM-registered data retrieval agents 
and connects to the data retrieval agents to retrieve hub monitoring server information about OMEGAMON 
agent data sources. This information is stored in the OMEGAMON Enhanced 3270 user interface local registry. 
By default, the registry information is refreshed every 5 minutes.
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If you verified the existence of a custom profile, in which the hub monitoring server settings are correctly 
specified, but the no data condition persists, you need to verify that there are registered data retrieval agents.

From the OMEGAMON Enhanced 3270 user interface, you can open a workspace that displays DRA information. 
Use the following procedure to open the workspace.

Procedure
From the All Known Hubs (KOBHUBS) workspace, place your cursor next to the hub monitoring server name 
that you are interested in, type A and press Enter.

The Data Retrieval Agents (DRA) workspace is displayed.

Figure 87: Data Retrieval Agents (KOBHBDRA) workspace.

The three rows that are shown in the Data Retrieval Agents (DRA) workspace indicate that there are three 
registered data retrieval agents for the hub monitoring server as RTE1:CMS running in the same Sysplex as the 
OMEGAMON Enhanced 3270 user interface address space. Assuming that there are no problems with agent 
data collection, the OMEGAMON Enhanced 3270 user interface is able to connect to any one of these data 
retrieval agents to retrieve OMEGAMON data from a V5.1.0 or later monitoring agent that is connected to the 
RTE1:CMS hub monitoring server.

If data retrieval agents are not registered for a specific hub monitoring server, the KOBHBDRA workspace is 
empty.

If the All Known Hubs (KOBHUBS) workspace list does not contain the hub monitoring server that is specified in 
the OMEGAMON Enhanced 3270 user interface logon profile, a high probability exists that the OMEGAMON for 
z/OS agents and or related monitoring server address space are offline.

The hub monitoring server is off line; verify initialization and data request 
reception

Verify the hub monitoring server is started, initialized, and prepared to receive data requests; listening on the 
configured TCP/IP port.

Your hub monitoring server might be running on either a z/OS LPAR or on a distributed system. Verify that the 
monitoring server has been started and has successfully completed initialization.

The following monitoring server log messages are a good indication regarding the health of hub monitoring 
server operations:
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..
KDSMA001 Tivoli Enterprise Monitoring Server (TEMS) data collection server started
...
KO4SRV032 Tivoli Enterprise Monitoring Server (TEMS) startup complete
..

If you cannot find these messages in the hub monitoring server log, examine the log for indications of potential 
problems. For example:

The monitoring server startup is in progress and initialization has not completed

The monitoring server initialization failed; for example, the monitoring server was not able to bind to its 
configured TCP/IP port

The monitoring server is not properly configured

Unexpected messages in the monitoring server log

See the “Monitoring server troubleshooting” section of this book for more information.

Application product support (seed data) has not been added to the hub 
monitoring server

Verify the hub monitoring server has the product version (for example, V5.1.0) application support (seed data) 
loaded.

If you did not complete this configuration step, your OMEGAMON Enhanced 3270 user interface might be 
missing data for one or more OMEGAMON products.

For a hub monitoring server on a z/OS system, see the “Adding application support to a monitor server on z/OS”
section in the IBM Tivoli Monitoring Installation and Setup Guide.

For a hub monitoring server on a distributed system, see the “Installing application support on monitoring 
server” section in the IBM Tivoli Monitoring Installation and Setup Guide.

Also, see “The OMEGAMON Enhanced 3270 user interface local registry does not contain required agent 
information” on page 134.

Note: The following message, which shows an example of the OMEGAMON for CICS log, might appear in 
the OMEGAMON Enhanced 3270 user interface when the add application support configuration step has 
not been completed; this might also be true when the add application support step was completed after 
the initial startup of the product agent. For the later case, the hub Tivoli Enterprise Monitoring Server and 
agent should be recycled after performing the add application support step.
...
RRUIA-DMSL: MSL "KCP_CICSplex_CICSPLXS" does not exist or contains no online
accessible MSNs.
...

Note: The V5.1.0 product application support files must also be loaded in the run time environment 
libraries that are associated with the OMEGAMON Enhanced 3270 user interface started task. For a new 
or upgraded run time environment, the run time environment load configuration step updates the 
application support.
You will see the following messages in the OMEGAMON Enhanced 3270 user interface log file when the 
application support files are back-leveled or missing:
...
KOBUIGP1I Source ODI does not contain table Kppxxxxx ... 
KOBUIGP9I ERROR: No ODI will cause an erroneous display ...
KOBUIGP1W ODI Failure ignoring SORTCOLS='...
...
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The OMEGAMON monitoring agent is offline or is not started
You can employ multiple methods to investigate the online status of an OMEGAMON agent.

One method is to examine the content of the local registry.

Tivoli Management Services 6.3.1 (APAR OA42127) or later

From the All Known Hubs (KOBHUBS) workspace, place your cursor next to the hub monitoring server 
name that you are interested in, type N and press Enter. The Managed Systems workspace is displayed and 
lists the available names of the local registry managed systems. The information that is displayed is similar 
to that shown in “Figure: Only Managed Systems panel that lists the available names of the local registry.” 
on page 133.

Tivoli Management Services 6.3 or earlier (pre-APAR OA42127)

From the OMEGAMON Enhanced 3270 user interface, select View › 4. Managed Systems. The Only 
Managed Systems panel is displayed and lists the available names of the local registry managed systems.

Figure 88: Only Managed Systems panel that lists the available names of the local registry.

The various OMEGAMON monitoring agents employ unique conventions to identify agents and managed 
systems. For example, in the previous figure, the rows that display names that end in :MVSSYS and :SYSPLEX
along with a Y in the MS Online Status column are an indication that OMEGAMON for z/OS agents are online, 
which means the interface can retrieve data for the product.

The following table lists the conventions that are used by individual OMEGAMON products to compose managed 
system names.

Table 5: Managed System naming conventions for OMEGAMON products

Product name Managed System naming convention

OMEGAMON for z/OS SYSPLEX:SYSPLEX:PLEXVIEW

sysplex_name:MVS:SYSPLEX

sysplex_name:lpar_smfID:MVSSYS

OMEGAMON for CICS cics_region_name:lpar_smfID:CPIRA

cics_region_name:lpar_smfID:CEIRA

cics_tg_ID:lpar_smfID:CICSTG

OMEGAMON for Db2 PE DB2plex:DB2plex:Plexview

db2_ID:lpar_smfid:DB2

XEDB2:lpar_smfid
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Product name Managed System naming convention

OMEGAMON for IMS on z/OS IMSplex:IMSplex:Plexview

ims_ID:lpar_smfid:CONNECT

ims_ID:sysplex_name:SQGROUP

ims_ID:lpar_smfid:IMS

XEIMS:lpar_smfid:MVS

OMEGAMON for Networks agent_jobname:lpar_smfid:KN3AGENT

tcpip_ID:lpar_smfid

vtam_ID:lpar_smfid

OMEGAMON for Messaging mq_ID:lpar_smfid:MQESA

OMEGAMON for Storage on z/OS agent_jobname:lpar_smfid:STORAGE

When you examine the Managed Systems (KOBHBMSN) workspace or the Only Managed Systems (KOBMSNS) 
workspace content and it indicates that there are no online agents for a specific product, examine the agent 
address space to verify that it is started and it is successfully initialized online. In some cases, it might be 
necessary to verify that the corresponding monitored systems or subsystems (for example, CICS regions) are 
also running.

The OMEGAMON Enhanced 3270 user interface local registry does not 
contain required agent information

The OMEGAMON Enhanced 3270 user interface local registry must have accurate information about the 
configuration of the environment to enable the composition and routing of data queries to appropriate 
OMEGAMON agent managed systems.

The registry is initially populated during the address space initialization process and thereafter, by default, at 5-
minute intervals.

Given the startup considerations for OMEGAMON monitoring components and monitored systems and or 
subsystem, it is possible for the local registry content to take up to 10 minutes to stabilize; assuming you have 
fairly stable configuration.

Use the Options menu of the enhanced 3270UI to examine the local registry.

Examine the following items:

Verify the existence of online registered enhanced 3270UI data retrieval agents. From the All Known Hubs
(KOBHUBS) workspace, place your cursor next to the hub monitoring server name that you are interested 
in, type A and press Enter. The Data Retrieval Agents workspace must contain a minimum of one data 
retrieval agent row to enable data retrieval.

Verify the existence of the OMEGAMON agent list for managed systems:
Tivoli Management services 6.3.1 (APAR OA42127) or later

From the All Known Hubs (KOBHUBS) workspace, place your cursor next to the hub monitoring server 
name that you are interested in, type L and press Enter. The Managed System Lists workspace lists 
the rows with managed system list names. The information that is displayed is similar to that shown in 
“Figure: Online Managed Systems Lists panel of the local registry” on page 135

Tivoli Management services 6.3 or earlier (pre-APAR OA42127)

Select View › 5. Managed Systems Lists. For example:



135

•

Figure 89: Online Managed Systems Lists panel of the local registry

The Online Managed Systems Lists workspace lists the rows with managed system list names.

The following table lists the naming conventions for the OMEGAMON products of the managed systems list 
names:

Table 6: Managed System List naming convention for OMEGAMON products

Product Managed System List naming convention

OMEGAMON for z/OS *MVS_SYSPLEX

*MVS_SYSTEM

OMEGAMON for CICS *CPIRA_MGR *GWIRA_MGR

*IBM_CICSplexes

*IBM_CICSplex

*MVS_CICSTG

*MVS_CICS

KCP_CICSplex_plex_name

OMEGAMON for Db2 PE *MVS_DB2

OMEGAMON for IMS on z/OS *MVS_IMSPLEX

KIP_ims_system_IMS

OMEGAMON for Networks *OMEGAMONXE_MAINFRAME_NTWK_TCP

*OMEGAMONXE_MAINFRAME_NTWK_VTAM

*OMEGAMONXE_MAINFRAME_NTWK

OMEGAMON for Messaging mq_ID:lpar_smfid:MQESA

OMEGAMON for Storage on z/OS agent_jobname:lpar_smfid:STORAGE

Verify the existence of online OMEGAMON agents managed systems:
Tivoli Management services 6.3.1 (APAR OA42127) or later

From the All Known Hubs (KOBHUBS) workspace, place your cursor next to the hub monitoring server 
name that you are interested in, type N and press Enter. The Managed Systems workspace is 
displayed and lists the available names of the local registry managed systems.

Tivoli Management services 6.3 or earlier (pre-APAR OA42127)
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Select View › 4. Managed Systems. The Only Managed Systems workspace (KOBMSNS) shows rows 
with managed system names.

See “The OMEGAMON monitoring agent is offline or is not started” on page 133.

Data retrieval delays/timeouts causing no data conditions
OMEGAMON enhanced 3270 user interface logs are written to the address space SYSPRINT DD statement.

By default, the OMEGAMON enhanced 3270 user interface is configured with the request timeout parameters 
shown in the following table:

Table 7: OMEGAMON enhanced 3270UI request timeout parameters

Parameter name Description Defaults and overrides

QUERYTIMEOUT User interface workspace query timeout 10 seconds

PNG_TIMEOUT DRA ping health check (endpoint ping) 
timeout

One second

SO_TIMEOUT DRA data request (socket) timeout 15 seconds

DIS_TIMEOUT Registry refresh (discovery data request 
timeout

Two seconds

CON_TIMEOUT Conduit manager connect to a DRA 
socket timeout

If parameter PNG_TIMEOUT is specified, 
the CON_TIMEOUT parameter defaults 
to the value specified in PNG_TIMEOUT.
If parameter PNG_TIMEOUT is not 
specified, the default value is one 
second.

These parameter defaults have been established for reasonable or normal operational conditions. There might 
be unique operational conditions in your environment where the defaults are not optimal. In that case, you can 
modify the defaults by creating customized OMEGAMON Enhanced 3270 user interface workspaces or 
specifying parameter overrides in the OMEGAMON Enhanced 3270 user interface environment parameters file 
(rte.RKANPARU(KOBENV) that is referenced by the address space RKANPAR DD statement. It is recommended 

Note: In a case where the configuration is running multiple versions of the OMEGAMON for z/OS 
agents (V4.2.0 and V5.1.0), only remote server address spaces that are upgraded to the latest 
version can be configured as Sysplex-proxy-eligible. You might get a workspace notice that says, 
Sysplex Data Unavailable: Enter 'ZOSLPARS' for LPAR Data for the case where the Sysplex 
proxy is started in a back-leveled remote server address space. The result is that the OMEGAMON 
Enhanced 3270 user interface is unable to render Sysplex data.

Note: In the case where multiple instances of IBM Tivoli Monitoring configurations are running in a 
common Sysplex, the configurations must be configured with unique names; at least one of the 
configurations must provide an override Sysplex name (pseudo name) so that both configurations 
are able to start a Sysplex proxy (and agent). The workspace notice, Sysplex Data Unavailable: 
Enter 'ZOSLPARS' for LPAR Data can depict the case where these conditions are not satisfied and 
the Sysplex proxy is unable to start in one of the configurations; the result is that the OMEGAMON 
Enhanced 3270 user interface is unable to render Sysplex data for that Sysplex.

Note: Some workspace queries 
are delivered with a timeout 
override; where the composition 
of data requests anticipates an 
elongated response.



137

•

•

•

•

•

•

•

that you use embed members so that your override settings persist. For more information, see Enhanced 3270 
user interface (KOB) parameters .

Elongated response times when interacting with the OMEGAMON Enhanced 3270 user interface might be a 
symptom of timeout conditions. For example, during log on, the initial Enterprise Summary (KOBSTART) 
workspace might take a significant amount of time (more than a few seconds) to render and or the workspace is 
rendered with partial or no data.

The following items identify the common causes for delay and or timeout conditions. Investigation of these 
conditions might be complex, this information provides you with some hints for further investigation:

The hub monitoring server is running under degraded system conditions (heavy system workload or an 
under-capacity system) and is being delayed when attempting to service OMEGAMON Enhanced 3270 user 
interface data requests. In this example, examine the availability and priority of the system resources 
provided to the hub monitoring server.

The OMEGAMON agent is running under degraded system conditions (heavy system workload or an under-
capacity system) and is being delayed when attempting to service OMEGAMON Enhanced 3270 user 
interface data requests. In this example, examine the availability and priority of the system resources 
provided to the OMEGAMON agent.

Data requests submitted from the OMEGAMON Enhanced 3270 user interface to a given Data Retrieval 
Agent, thorough a TCP/IP conduit, are being impacted by degraded network conditions. In this case, the 
availability, priority, and configuration of network resources and paths associated with communications 
between the OMEGAMON Enhanced 3270 user interface and the hub monitoring server and OMEGAMON 
agents should be examined.

An OMEGAMON component (monitoring server or agent) that played a role in a given data request path has 
gone off-line; the LPAR was terminated, or the address space was terminated. In this case, “The 
OMEGAMON Enhanced 3270 user interface local registry does not contain required agent information” on 
page 134 to investigate the status of OMEGAMON components, (Managed Systems: on line or off line).

The hub and or a remote monitoring server is experiencing operational issues and is being delayed when 
attempting to service OMEGAMON Enhanced 3270 user interface data requests. A misconfiguration or a 
special site or environmental configuration requirements might lead to operational issues.
For example:

Operational issues might arise if a monitoring server running on a z/OS operating system is 
experiencing problems writing to its’ Historical Persistent Datastore files.

Operational issues might occur if a monitoring server is unable to bind to its configured TCP/IP port 
number.

The IP domain name resolution is not fully configured on the z/OS operating system where the OMEGAMON 
Enhanced 3270 user interface, Tivoli Enterprise Monitoring Server and or agent address spaces are 
running. Also, there might be more than one TCP/IP task running on the z/OS operating system; for these 
cases, the OMEGAMON address spaces, the OMEGAMON Enhanced 3270 user interface, Tivoli Enterprise 
Monitoring Server and or agent started task JCL procedures must specify the IP name resolution 
configuration data set to be specified through the SYSTCPD DDNAME statement.

The hub Tivoli Enterprise Monitoring Server is running on a system that has multiple network interfaces and 
perhaps the preferred and or universally known interface is not being employed; this results in IP 
connection issues that manifest on the interface as a possible sporadic, no data condition. For more 
information related to this type of configuration, including the use of the KDEB_INTERFACELIST
parameter, see technote KDEB_INTERFACELIST and it variants ("*" and "!*") are misunderstood (https://
www.ibm.com/support/docview.wss?uid=swg21282474) .

RAS1 Tracing

The following topics describe how to enable RAS1 tracing.

Note: The following message is written to the SYSPRINT log files when request timeouts occur:
KOBCM0010E: conduit manager Recv Error, rc = -1, microseconds = nnnnnnnn 

https://www.ibm.com/docs/SSAUBV/commonparmref/itm_commonparm_kob_parms.html
https://www.ibm.com/support/docview.wss?uid=swg21282474
https://www.ibm.com/support/docview.wss?uid=swg21282474
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Enabling RAS1 Tracing for the enhanced 3270UI
You can choose from several different types of tracing that can be enabled to debug the OMEGAMON enhanced 
3270 user interface (enhanced 3270UI) and Tivoli OMEGAMON Manager Address Space.

Tracing can be enabled at Tivoli OMEGAMON Manager startup, at user start, or dynamically turned on and off for 
either the Address Space or a particular user. Trace messages are produced in the Tivoli OMEGAMON Manager's 
SYSPRINT location, SYSTRACE DD location, or both.

An enhanced 3270UI user can use TRACE commands or pull-down menus to enable UI tracing. Both of these 
methods enable UI tracing for actions that are initiated only by that particular user. To enable tracing for the 
entire Tivoli OMEGAMON Manager Address Space, use modify commands to the Tivoli OMEGAMON Manager 
Address Space, or use enhanced 3270UI TRACE commands or pull-down menus.

The pull-down method is initiated by clicking (or positioning the cursor and pressing Enter) on the Tools pull-
down. A pull-down menu appears where you can select either UI tracing or Address Space tracing.

After you select one of the tracing options, a Trace menu pop-up will display all of the components that can be 
selected for tracing.

The command method is initiated by entering a TRACE command on the command line, or the action line, on the 
enhanced 3270UI.

After you initiate tracing, a TRACE indicator is displayed the drawer section of the footer.

Clicking (or positioning the cursor and pressing Enter) on the TRACE box displays the Trace menu where more 
tracing can be initiated, or turned off altogether.

Additionally, the Modify system command can be used to directly communicate with the Tivoli OMEGAMON 
Manager started task to start and stop address space level tracing. The syntax of the modify command is: /F 
tomjobname, TRACE KOBcomp n, where - tomjobname is the Tivoli OMEGAMON Manager started task name. 
IBMTOM is the default started task name. - comp is the component for which you want to start/stop tracing, 
and - n is the trace level, which can have the value 0 - 4. A trace level of 0 indicates that no tracing takes place, 
and disables tracing if it was already enabled. A trace level of 1 - 4 enables tracing; 1 generates the least 
number of trace messages, while 4 generates the most trace messages.

This table lists the pull-down options that are available to the user, and the corresponding TRACE and modify 
commands:

Options for UI tracing and Address Space tracing

Note: Tracing can cause excessive output to the Tivoli OMEGAMON Manager job log. Consult IBM Service 
Personnel for advice before you enable tracing.
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Table 8: Options for UI tracing and Address Space tracing

UI trace pulldown options: Corresponding TRACE command: Corresponding modify command: 
(that is, /F IBMTOM, TRACE 
KOBcomp where n is the level of 
tracing)

1. B Basic UI Flow of Control TRACE BASIC (not applicable)

2. V VTAM Data Stream Analysis TRACE VTAM (not applicable)

3. I Input Field Processing TRACE INPUT (not applicable)

4. P 3270 Presentation Services TRACE 3270 (not applicable)

5. O Source ODI Interchange TRACE ODI (not applicable)

6. Q SQL and Live Data Analysis TRACE DATA (not applicable)

7. U Screen Popups TRACE POPUP (not applicable)

8. S Screen Scrolling TRACE SCROLL (not applicable)

9. R REXX Processing TRACE REXX (not applicable)

10. X Turn All UI Trace Off TRACE OFF (not applicable)

Address Space pulldown options:

1. R Request Router TRACE RR TRACE KOBRRWKR 1, KOBRRUIA 
1

2. C Conduit Manager TRACE CM TRACE KOBGWCND 1

3. G Registry TRACE RG TRACE KOBGWREG 1

4. T Status and Thresholding TRACE ST TRACE KOBTHRMT 1, KOBTHRSH 
2

5. S Session Control TRACE SC TRACE KOBOBVAP 1, KOBGWOBV 
2

6. W OMEGAMON Gateway TRACE GW TRACE KOBGATW0 1

7. O Binary ODI TRACE BO TRACE KOBODUTL 1, KOBODILD 1

8. A SAF Authorization TRACE SAF TRACE KOBCRACF 1

9. X Turn All Component Trace Off TRACE MOFF TRACE KOBcomp 0

Enabling RAS1 Tracing at startup for an enhanced 3270UI user
You can initiate UI tracing at session startup for an enhanced 3270UI user by updating the TRACE statement in 
the user's UI profile.

Procedure
Select Edit › Preferences

Click the Session/Logon tab. Alternatively, position the cursor over the Session/Logon tab and press 
Enter.

Change the Engage Trace at session start setting from N to Y.

Save the profile.

The user must re-login to the enhanced 3270UI.

Result
Trace data is now collected during session startup.

Note: Be sure to change the Engage Trace at session start setting back to N when you finish debugging



140

•

•

Enabling Address Space tracing at startup
You can initiate Address Space tracing for one or more components at startup.

To initiate Address Space tracing for one or more components at startup, add a TRACEV1 statement in the Tivoli 
OMEGAMON Manager's RKANPARU(KOBENV) member and specify the component (or components) and level of 
tracing.

For example:

TRACEV1=TRACE KOBxxxxx n

where:

The variable n is the trace level and has a value of 0 - 4, where 0 indicates no tracing, 1 is the minimum 
amount of tracing and 4 is the most tracing.

The value of KOBxxxxx is as follows:

KOBRRUIA KOBRRWKR KOBCSOCK KOBTHRSH KOBTHRMT KOBODUTL KOBODISC KOBODILD KOBOBVAP 
KOBGWREG 
KOBGWOBV KOBGWLPA KOBGWCVA KOBGWCND KOBGATW0 KOBCZDIO KOBCWTOL KOBCVSTG KOBCUXIO 
KOBCTREE 
KOBCTHRD KOBCSTRN KOBCSTLB KOBCSTIO KOBCMAPI KOBCLOCK KOBCIOST KOBCIOBE KOBCENVV 
KOBCENVG 
KOBCDYNA KOBCDSIO KOBCDMSG KOBCBLKQ KOBLISTN KOBCRACF KOBCUNIS KOBFLG01 KOBFLG02 
KOBFLG03 
KOBFLG04

RAS1 Tracing for the OMEGAMON Subsystem
You can start and stop tracing for the OMEGAMON Subsystem.

Tracing for the OMEGAMON Subsystem is dynamically started and stopped using modify commands. Trace 
messages are produced in the OMEGAMON Subsystem's SYSPRINT location, the SYSTRACE DD location, or both. 
For example:

/F IBMCN,TRACE KOBHTTPW 1

You can initiate tracing for one or more components at startup by adding a TRACEV1 statement in the 
OMEGAMON Subsystem's RKANPARU(KOBENV) member and specifying a component (or components) and level 
of tracing.

For example:

TRACEV1=TRACE KOBxxxxx n

Note: Tracing can be dynamically turned off by issuing a Modify command with a value of 0 for the trace 
level. For example:

/F IBMTOM, TRACE KOBRRWKR 0

Multiple components can be specified on the TRACEV1 statement. For example:

/F IBMTOM, TRACE KOBRRWKR 1, KOBCSOCK 2

Be sure to comment or remove the TRACEV1 statement in the KOBENV member when debug messages 
are no longer needed.

Note: Tracing can cause excessive output to the Tivoli OMEGAMON Manager job log. Consult IBM 
Software Support for advice before you enable tracing.
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where:

The variable n is the trace level, and has a value of 0 - 4. A trace level of 0 indicates that no tracing takes 
place and disables tracing if it was already enabled. A trace level of 1 - 4 enables tracing; 1 generates the 
least number of trace messages, while 4 generates the most trace messages.

The value of KOBxxxxx is as follows:

KOBHTTPS KOBHTTPL KOBHTTPW KOBHTTP$ KOBHTTP@ KOBHTTP# KM5JLFRD

KOB messages
Messages that begin with the KOB prefix are associated with the OMEGAMON Enhanced 3270 User Interface, 
which is part of the OMEGAMON Base component. By default, trace and error logs are created in SYSPRINT. (An 
alternate log location may have been specified, using standard JCL services.) Most of the messages are prefixed 
by a timestamp and thread ID.

For the complete list of messages, see KOB messages.

Note: Tracing can be dynamically turned off by issuing a modify command with a value of 0 for the trace 
level. For example:

/F IBMTOM,TRACE KOBHTTPW 0

Multiple components can be specified on the TRACEV1 statement. For example:

/F IBMTOM,TRACE KOBHTTPW 1, KOBHTTPS 2

Be sure to comment or remove the TRACEV1 statement in the KOBENV member when debug messages 
are no longer needed.

https://www.ibm.com/docs/SSAUBV/messages/kob_messages.html
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Reference

The keywords that are used in the definitions of panels and profiles. The commands you can use to start and 
stop the interface address space or refresh the local registry.

About panels
Workspaces are composed of two types of panels: workspace panels and popup panels.

Workspace panels are typically used to present data. A workspace panel can contain up to 15 subpanels. Each 
subpanel in a workspace can contain data from a different attribute group or even a different application. 
Subpanels can be linked to other workspace panels using context-sensitive links, so that the data displayed in 
the target workspace reflects values in the linked-from workspace (see “Figure: A workspace with several 
subpanels” on page 142).

Figure 90: A workspace with several subpanels

Popup panels overlay workspace panels and are typically used to provide navigation, action options, or help for 
a particular field, or additional information about actions (see “Figure: Workspace with popup panel” on page 
142). Popup panels are also used to confirm an action.

Figure 91: Workspace with popup panel
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Workspace and popup panels are created using panel definitions. Panel definitions are members of a data set 
allocated to RKANWENU (the default for English; the ddname is dependent upon the locale ID). The name of a 
data set member is the name of the panel it defines.

A panel definition consists of one or more stanzas that specify the panel type or elements and keyword = value 
pairs that specify the appearance and content of the panel.

Workspace panel definitions
Workspaces panel definitions consist of an opening and closing stanza tag and a set of keywords that specify 
the global properties and content of the workspace. A workspace panel definition can contain up to 15 subpanel 
definitions. Subpanel definitions specify navigation and display options for the subpanel and the data query. 
Subpanels can be linked to other workspace panels using links, so that the data displayed in the target 
workspace reflects values in the linked-from workspace.

A workspace panel definition begins with a <WORKSPACE> tag as the first noncomment line and ends with a 
<WORKSPACEEND> tag. In addition to a set of supported keywords that specify global settings for the 
workspace, a workspace definition can contain the following stanzas:
ALIASCOMMANDS

<ALIASCOMMANDS><ALIASEND>
In an ALIASCOMMANDS stanza, the aliases for workspace panel IDs to be used in fastpath navigation are 
defined with SET statements. By default, alias commands apply only to the current panel. For the aliases to 
persist, the scope must be set to GLOBAL. If the scope is global, after an alias has been set, it is available to 
every subsequent panel until the alias is either updated or deleted. The SET statement for the alias can also 
specify whether the resulting workspace is always presented in realtime mode, even if the user is in history 
mode when issuing the alias command.

The use of <ALIASEND> it prevents subsequent SET statements from generating alias variables instead of 
normal variables.

For example:

<ALIASCOMMANDS>
SET HEALTH=KPPASTO SCOPE=LOCAL REALTIME
<ALIASEND>

ONENTRY

<ONENTRY><ONENTRYEND>
An ONENTRY stanza contains SET statements that are executed only once, when the workspace is loaded 
during "forward" navigation. This prevents the statements from being redriven, for example, when a filter is 
invoked.

SUBPANEL

<SUBPANEL>
Subpanel definitions are introduced by a <SUBPANEL> statement. Subpanels do not require a 
corresponding <SUBPANELEND> statement. The occurrence of a new <SUBPANEL> tag or a 
<WORKSPACEEND> tag functions as an indication of the end of the preceding subpanel.

In each subpanel, you can control the type of subpanel (summary, detail, text, action), the number of lines 
and rows that are displayed, the data that is queried, and the columns that are displayed. You can specify 
what controls are available (such as scrolling and minimizing and maximizing subpanels) and define 
navigation options for drilldown to other workspace or popup panels. The order of some keywords is 
restricted.

Subpanels may contain several types of stanzas:
ISPF

<ISPFPANEL><ISPFPANELEND>
ISPF stanzas support a subset of the standard ISPF statements. See “Supported ISPF statements” on 
page 180.

PROLOG and EPILOG

<PROLOG><PROLOGEND> and <EPILOG><EPILOGEND>
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PROLOG and EPILOG stanzas optionally bracket a QUERY keyword and allow for the definition of local 
variables and for pre- and post-processing of the queried data using REXX EXECs. PROLOG and EPILOG 
stanzas can contain the following elements:

SET commands

REXX EXEC commands

ZOOMCOLS=&varname statements

ONACTION

<ONACTION><ONACTIONEND>
This stanza is executed once when the workspace is first displayed during forward navigation. 
ONACTION stanzas can contain the following elements:

SET commands.
SET commands coded in an ONACTION stanza are executed directly after key column assignment 
when an action is driven from the subpanel (see “KEYCOLS” on page 160).

Used with the system variable ZFILTERnn, SET commands in the ONACTION stanza can be used to 
created filters for columns that have been designated as eligible using the FILTERCOLS keyword. 
For example:

<ONACTION>
SET ZFILTER01=CICSNAME=C*                               
SET ZFILTER02=SOS=1
SET ZFILTER03=TASKS>100
<ONACTIONEND>

REXX exec calls. For example:

<ONACTION>
CALL MYREXX
<ONACTIONEND>

Example

Here is an example of a simple workspace panel definition:

<WORKSPACE>
HEADER='Address Spaces for Service Class'
NAV1TEXT='Plex ID'
NAV2TEXT='SMF ID'
SET ZOMEGNAV2=''
SET ZOMEGLOCK1=NO
SET ZOMEGLOCK2=YES
IMBED=KM5NAV1

/********************************************************************/
/*                                                                  */
/*  SUBPANEL 1 - Address Spaces for Service Class                   */
/*                                                                  */
/********************************************************************/

<SUBPANEL>
HEADER='Service Class &CLSNAME' 
TYPE=SUMMARY  
/********************************************************************/ 
/*                       Data Query                                 */ 
/********************************************************************/  
QUERYTYPE=ROUTER 
QUERYMODE=LIVE 
QUERYREGTYPE=DRA  
QUERY='SELECT MADDSPC.ORIGINNODE,MADDSPC.ASNAME, 
MADDSPC.VSYSTEMNAM,MADDSPC.ASID,MADDSPC.ASRCNAME, 
MADDSPC.VELOCITY,MADDSPC.PAGERATE,MADDSPC.ASCSTOR, 
MADDSPC.ASESTOR,MADDSPC.IORATE,MADDSPC.CPUPCNT, 
MADDSPC.IFAPCNT,MADDSPC.IFCPCNT,MADDSPC.SUPPCNT, 
MADDSPC.SUCPCNT,MADDSPC.CLSNAME, 
FROM KM5.MADDSPC, 
WHERE ORIGINNODE='&PLEXORIG', 
AND MADDSPC.CLSNAME='&CLSNAME', 
ORDER BY VELOCITY DESC;'  
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/********************************************************************/ 
/*                  Data Status                                     */ 
/********************************************************************/  
/********************************************************************/ 
/*                  Session Data Row Key Fields                     */ 
/********************************************************************/  
/********************************************************************/ 
/*                  Default list of fields to display               */ 
/********************************************************************/ 
STATICCOLS=2  
SORTCOLS='ASNAME,ASID,PAGERATE,ASCSTOR,ASESTOR,IORATE,CPUPCNT, 
IFAPCNT,IFCPCNT,SUPPCNT,SUCPCNT,VELOCITY'  

DISPLAYCOLS='ASNAME,ASID(HEXDISP),VSYSTEMNAM(W=4), 
ASRCNAME,CPUPCNT,VELOCITY,ASCSTOR,ASESTOR,IORATE, 
PAGERATE,IFAPCNT,IFCPCNT,SUPPCNT,SUCPCNT'  
/********************************************************************/ 
/*                  Navigation Options                              */ 
/********************************************************************/  
/* ACTION=ASNAME(?,"Help Assistance",KOCHELP1)  
/********************************************************************/ 
/*  SUBPANEL 1 END                                                  */ 
/********************************************************************/ 
<WORKSPACEEND>

Popup panel definitions
Popup panels overlie a portion of a workspace panel. Popup panels are typically used to display navigation or 
action options, to supply information for a particular field, or to provide additional information about actions. 
Popup panels are also used to confirm actions. Popup panels are linked to a subpanel through an ACTION 
setting in a subpanel definition.

Popup panel definitions begin with <POPUP> and end with <POPUPEND>. Popup panels may contain a header, 
free-form text, and a subpanel.

Popup panels suspend Auto update in the parent workspace: until the popup panel is dismissed, the Auto 
update field in the workspace displays SUS instead of Off or Interval.)

Popup panels can contain variables. The variables must be set in the parent workspace or in a previously 
accessed workspace.

As in workspace definitions, stanzas that define subpanels are introduced by a <SUBPANEL> statement. A 
corresponding <SUBPANELEND> statement is not required. Unlike workspace panels, which may contain up to 
15 subpanels, popup panels can contain only one subpanel. Moreover, subpanels in popup panels cannot 
contain the QUERY keyword or PROLOG and EPILOG stanzas. Subpanels may contain ONACTION and ISPF 
stanzas. As in subpanels, ONACTION stanzas may contain SET commands and REXX exec calls. See “Supported 
ISPF statements” on page 180 for more information allowable ISPF statements.

Example 1

The following example shows the use of a subpanel with actions defined, an ISPF )LIST statement with the 
POPUPACTIONS argument, with the width of the popup panel specified. The POPUPACTIONS argument 
displays the actions defined in the popup panel in a numbered list, in a popup panel with a width of 50 
characters.
Figure 92: Example of a popup panel definition

/********************************************************************/
/*                                                                  */
/*        OMEGAMON BASE EXIT CONFIRMATION                           */
/*                                                                  */
/********************************************************************/
<POPUP>                                                               
<SUBPANEL>
ACTION=(X,"Exit and terminate the session (X)",=LOGOFF)
ACTION=(R,"Resume (R)",=END)
<ISPFPANEL>
)LIST POPUPACTIONS
)BODY WIDTH(50)
                 Exit Menu

Type a selection number, enter X to exit,
enter R to resume, or press PF3 to return.
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)INIT
)PROC
)END
<ISPFPANELEND>
<POPUPEND>

Example 2

This is a sample popup panel action , which takes the actions defined in the subpanel from which the popup 
panel is invoked and inserts them after the text in the )BODY statement. A color variable is used to apply color 
to text .:
Figure 93: Example of action popup that inserts actions from the subpanel definition

/********************************************************************/  
/*                                                                  */  
/*        OMEGAMON ACTION CHARACTER LIST                            */  
/*                                                                  */  
/********************************************************************/  
<POPUP>                                                                 
<SUBPANEL>                                                              
<ISPFPANEL>
)ATTR                                          
@ TYPE(TEXT)  SKIP(ON) COLOR(&ZCLRTEXT))
)LIST PANELACTIONS
)BODY WIDTH(50)                                                         
          Action Command Menu 
Select an action and then press Enter.

)INIT
)PROC
)END                                                                    
<ISPFPANELEND>
<POPUPEND> 
******************************** Bottom of Data ************************

Guidelines for constructing panel definitions
Panel definitions are constructed according to specific guidelines. You should be aware of these guidelines if 
you are constructing a panel definition from scratch, instead of copying and modifying an existing definitions

The first non-comment line of a workspace panel definition must contain a <WORKSPACE> tag. The first 
noncomment line of a popup panel must contain a <POPUP> tag.

The end of a workspace panel definition must be marked by a corresponding <WORKSPACEEND> tag. The 
end of a popup panel definition must be marked by a corresponding <POPUPEND> tag. Anything after this 
tag is ignored.

Any text values that contain a space must be enclosed in single or double quotation marks. If text contains 
a single quotation mark, it must be enclosed in double quotation marks. Any comma-delimited list (for 
example, DISPLAYCOLS='CICSPLEX,PLEXRATE,PLEXCPUP') must also be enclosed in quotation marks.

Some keywords must be specified in a particular order (see “Panel definition keywords” on page 146). 
Comments (/*) are allowed anywhere in the definition.

Comment lines and blank lines are ignored.

Panel definition keywords
Keyword/value pairs are used to define the properties of panels. There are keywords that affect the workspace 
as a whole, and subpanel keywords that apply only to specific subpanels.

Note: If you do not specify an end tag, the end of the file is the interpreted as the end of panel 
definition. Since the rest of the file is ignored, using an explicit end tag allows you to ignore part of 
the file, for example if you are testing a panel definition.
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Workspace keywords
The keywords in this section define global properties for workspace panels.

CURSOR

Defines the default cursor position on an initial workspace.

CURSOR=[HOME|COMMANDLINE|SUBPANEL|ASIS]
Possible values

HOME
Row 00, Column 1

COMMANDLINE
Cursor appears after Command ==>.

SUBPANEL
Cursor appears in first selectable field of the first subpanel.

ASIS
The cursor remains on the workspace wherever the user placed it.

Default value
HOME

Example

CURSOR=COMMANDLINE

CURSORREFRESH

Defines where the cursor position is after a workspace has been refreshed.

Possible values

HOME
Row 00, Column 1

COMMANDLINE
Cursor appears after Command ==>

SUBPANEL
Cursor appears in first selectable field of the first subpanel.

ASIS
The cursor remains on the workspace wherever the user placed it.

Default value
ASIS

Example

CURSORREFRESH=SUBPANEL

HEADER (workspace)

The text to be displayed at the top of the workspace.

Possible values
Any text up to 46 characters. Any characters that exceed the maximum length are truncated. The text is 
case-sensitive.
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Default value
No header is displayed.

Example

The following example illustrates the use of the HEADER keyword to define text “Enterprise Overview” as the 
workspace header.

HEADER='Enterprise Overview'

shows

Command ==>__________________________________________
 PANELID                  Enterprise Overview              

IMBED

Specifies a subpanel definition to be imbedded. Can be used to reuse a subpanel in several workspaces, or to 
imbed a subpanel definition provided by another product. If an imbed subpanel for another product allows for 
take actions (like cancelling a CICS task), then security for those actions is governed by the resource rules for 
the product providing the imbed.

IMBED =[subpanelid|&panelid]
This keyword is placed at the location where the imbedded subpanel will appear, if available. This keyword 
requires a standalone subpanel definition in a separate PDS member. The member must consist of only the 
<SUBPANEL> stanza containing the subpanel definition. You can imbed multiple subpanel members.
Possible values

subpanelid: the name of the PDS member that contains the subpanel definition

&panelid: a variable set to the member name

Default value
None

Example

IMBED=&imbwait

MODE (workspace)

Specifies that the workspace should not be displayed. This keyword is used to "hide" a workspace that is used 
to collect data for a workspace that is displayed subsequently or to silently perform an action.

Use of MODE=SILENT disables any other display-oriented keywords in the workspace definition, such as 
DISPLAYCOLS, SCROLLBAR, and MINMAX. A workspace that is specified as SILENT must create a new variable 
called ZDESTID which contains the panel ID of the destination workspace. This can be accomplished either in a 
REXX EXEC, or in a workspace definition by specifying SET ZDESTID=panelid. Although MODE is a 
<WORKSPACE> setting, SET ZDESTID is a <SUBPANEL> setting.
Possible values

SILENT

Default value
None

Example

<WORKSPACE> 
MODE=SILENT
<SUBPANEL>
SET ZDESTID=KCPPRGD
<WORKSPACEEND>
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NAV1TEXT

Specifies the text used to label the field that filters for data from a specific plex.

Valid values
Any text up to 8 characters. Any additional characters are truncated.

Default value
Plex ID

See also: “NAV2TEXT” on page 149

Example

NAV1TEXT='CICSPLEX'

NAV2TEXT

Specifies the text used to label the field that allows a subsystem filter (such as a region or LPAR) to be placed on 
the data.

Possible values
Any text up to 8 characters. Additional characters are truncated.

Default value
Sys ID

See also: “NAV1TEXT” on page 149.

Example

NAV2TEXT='Region'

QUERYWHEN (workspace)

Forces data collection for all subpanels within the workspace when the workspace is returned to using 
backwards navigation.

QUERYWHEN= RETURN
By default, data collection is driven only when the Enter key is pressed and no screen operations are requested. 
Screen operations include pulldown or popup panels, collapsing and expanding, minimizing and maximizing, 
scrolling, or backwards navigation.

WHENNOHEADER

Replaces the entire subpanel header with the specified text when rows are empty and the subpanel is 
collapsed.

WHENNOHEADER="text"
If there is no data returned in a subpanel, the subpanel is automatically collapsed and the header displays the 
text “No data.” You can override the header with alternative text, up to a maximum of 64 characters.

Example

WHENNOHEADER=“No data is available because the task has ended”

WHENNOTEXT

Replaces the text “No data” when there is no data in the rows and a subpanel is collapsed.

WHENNOTEXT="text"
If there is no data returned in a subpanel, the subpanel is automatically collapsed and the header displays the 
text “No data.” You can replace “No data” with alternative text, up to a maximum of 15 characters.
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Example

WHENNOTEXT=“task has ended”

Subpanel keywords
The keywords in this section define the properties of a subpanel. The keywords must be preceded by the 
<SUBPANEL> tag. A <SUBPANELEND> tag is optional. The occurrence of another <SUBPANEL> or a 
<WORKSPACEEND> tag is taken as the close of the subpanel definition.

ACTION

In a summary subpanel, defines a list of navigation and action options from which a user can select. You can 
define up to 16 actions for a selectable field for a subpanel. A popup panel with a list of all possible options is 
dynamically defined. A default action can be defined. These options are displayed in a popup when a user enters 
a slash ("/") on the selectable row associated with the actions.

ACTION=columnname(action_character,"action_text_description",destination_panelid[,DEFAULT][,CONFIRM]
[,REALTIME])
where:
columnname

The name of the column with which the action is associated.

action_character
The character associated with the action.

action_text_description
A description of the action to be taken, enclosed in single or double quotation marks.

destination_panelid
The panel ID of the workspace to which users are taken. Specify NULLDEST for no navigation.

DEFAULT
Defines the action as the implicit navigation behavior. If only one action is specified, it is taken as the 
default. If multiple actions are defined for a subpanel, one must be defined as the default.

CONFIRM
Invokes a confirmation popup panel (KOBCONFM) before proceeding to the specified panel ID.

REALTIME
Renders the destination workspace in realtime mode, even if the user is in history mode when selecting this 
action.

ENTER
ENTER can be used instead of an action character. Using ENTER changes the behavior of a popup panel so 
that the Enter key can implement navigation instead of data collection and redisplay. The destination panel 
ID can be any workspace or popup panel or the special keyword END. END indicates navigate backwards 
(save and PF3). If a REXX EXEC sets the ZDESTID in an ONACTION stanza, the ENTER key options are 
ignored, and the popup panel is redisplayed with any updates that the REXX EXEC may have made.

Example 1

This example illustrates an action selection menu:

ACTION=HUBNAME(?,"Help Assistance",KOCHELP1,DEFAULT)
ACTION=HUBNAME(S,"Select a hub",KOBPANE1)   
ACTION=HUBNAME(K,"Kill a hub",KOBPANE2,CONFIRM)

Example 2

These examples illustrates the use of the ENTER and END keywords:

ACTION=(ENTER,,MYNEXTWS)
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or

ACTION=(ENTER,,END)

These two examples are mutually exclusive.

AUTOSELECT

For subpanels with MODE=SILENT that contain a query, automatically selects the first data record returned 
from the query. If you specify AUTOSELECT, you do not need to specify MODE=SILENT.

BOXTOP

Determines whether a top border is displayed for a subpanel.

Possible values
NO, YES

Default value
YES

Example

BOXTOP=NO

BOXBOTTOM

Determines whether a bottom border is displayed for a subpanel.

Possible values
NO, YES

Default value
YES

Example

BOXBOTTOM=NO

COLHEADERS

Determines whether column headings are displayed. This setting applies only to SUMMARY displays.

Possible values
N, Y, n, where N means that no column headings are displayed, Y means that column headings are 
displayed, and n is 1, 2, or 3 indicating how many lines are allowed for the column header.

Default value
Y,2

Example

COLHEADERS=Y,3

COLUMNS

Determines how many columns are displayed. A maximum of 100 columns can be displayed on a subpanel.

Possible values

DYNAMIC
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The width of an individual column, and therefore the number of columns displayed, is determined by 
the width of the column header or the data, whichever is larger. If the column is defined in 
DISPLAYCOLS with the BAR option, the width may be also be controlled.

MAX(IMUM)
The maximum number of columns available for your screen size:

7 for a screen size of 80
10 for a screen size of 132
14 for a screen size of 160

Optionally, you can specify a number of columns fewer than the maximum, by specifying MAX-n.

N
An integer in the range 1 through x, where x is the maximum number of columns for the screen size.

Default value
DYNAMIC

Example

COLUMNS=6

COLUMNS132

Specifies how many columns should appear on screen if the screen is 27x132. Use this keyword to adjust for 
screen size if you have specified a specific number of columns using the COLUMNS keyword.

COLUMNS132=nn
Maximum value

10

Example

To limit the number of columns displayed in a 27x132 screen to 5:

COLUMNS132=5

COLUMNS160

Specifies how many columns should appear on-screen if the screen is 62x160. Use this keyword if you have 
indicated a specific number of columns using the COLUMN keyword.

COLUMNS160=nn
Maximum value

14

Example

To specify 10 columns:

COLUMNS160=10

DISPLAYCOLS

Lists the columns that are returned from the QUERY command that are to be displayed on the subpanel. 
Columns containing integers or percentages can be displayed in either numeric or analog (bar graph) form.

This setting must be specified after the QUERY statement for the subpanel.
Possible values

ALL displays all columns specified in the query

A comma-separated list of column names specified in the query, enclosed in single quotes.

column_name
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If the column width is dynamic (COLUMN=DYNAMIC) and the data is an integer or a timestamp, you 
can optionally specify a display format:

column_name(options),column_name(options),column_name(options)

The display options available depend upon the data type of the column:

The following options can be used for columns of any data type:
Width=nnnn or Width=nnn%

Specifies the width of the column of data in number of characters or as a percentage of the 
number of characters that can appear on the screen. For example, W=16 or W=25%.

CAPTION=&varname or 'textstring'

Specifies the column caption that overrides the column caption for the attribute being 
graphed. Use the SET command to specify the value for the variable name.

INDENT

Indents a caption in a detail subpanel. For example:

DISPLAYCOLS='SYSTEMID,CICSNAME(ASCII),WSERVCLAS,
WPERFINDX(CAPTION="Region's_Worst_Perf._Index"),
CPUUTIL(INDENT),TODUPDT,TRANRATE,PCNTMXT,       
ENQWAIT(INDENT),REMQUEUE,SOS(INDENT),           
STGVIOL(CAPTION="Stg._Violations_last_hour"),   
AIDS,ICES(INDENT),                             
CSTRINGW,CBUFFW,WSFAULT,WSTIMOUT,
CICSTODB(TIME),VERSION(INDENT)'

results in the following subpanel:

If the column contains Date/Time (T,16) data, you can use the following format options for the 
display:

DATETIME

Displays YY/MM/DD HH:MM:SS

DATE

Displays as YY/MM/DD

TIME

Displays as HH:MM:SS

None

Data is shown in any of the following formats, based on the value:
12m 31d
31d 23h
23h 59m
59m 59s
59.1234s
1.12345s

For example:

DISPLAYCOLS='CICSPLEX,PLEXRATE,EIBTIME(DATETIME),PLEXMAXT'

If the column is an IPV6 address, then the options are:
None
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Displays the IPV6 according to normal rules

IPV6

Displays an IP address with the ::ffff: stripped off

Example: DISPLAYCOLS=HUBIPADDRESS(IPV6)

If the column contains integer data, you can use the following options:
BAR

Displays an integer as an analog horizontal bar. The bar is green if the value is 33% or less of 
the column width; yellow up between 33% and 66% of the column width; and red if the value 
is over 66% of the column width.
Control the bar display with the following options:
THRESH=NO

Suppresses color indicators for thresholds.

UNIT=nnn

Specifies how many integers a single character represents. The default is 1. Decimal 
places are not supported.

For example:

SET KOB_HEADER="Graphical Display"
DISPLAYCOLS='CICSPLEX,PLEXRATE,PLEXCPUP,PLEXCPUP(W=22%,BAR,UNIT=20,
CAPTION=&KOB_HEADER),PLESOS,PLEXMAXT,PLEXENQW,PLEXHSCI'

HEXDISP

Converts values to hexadecimal for display. HEXDISP supports an offset. For example, if you 
have an integer field column containing the decimal value 254:

(HEXDISP)        displays 000000FE
(HEXDISP+1)     displays 0000FE
(HEXDISP+2)    displays 00FE
(HEXDISP+3)    displays FE

.

HEXVAR

Converts values being passed in variables set by KEYCOLS to hexadecimal. For example,

column_name(HEXVAR)

BKMG (Bytes to Kilo to Mega to Giga).

Converts values expressed in bytes to kilobytes, megabytes, or gigabytes, as appropriate. For 
example, column_name(BKMG).

KMGT

Converts values expressed in kilobytes to megabytes, gigabytes, or terabytes, as appropriate. 
For example, column_name(KMGT).

NOUNIT

No units are displayed. For example, column_name(NOUNIT).

PERCENT

Appends a percent symbol (%) after the value on the screen.

If the column contains strings or enumerations:
ALIGNRIGHT

Align text to the right hand side of the column.

If the column contains just text strings:
ASCII
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•

Forces an ASCII translation of a field prior to display.

SCROLL

Enables cursor-sensitive lateral scrolling for up to 10 columns on a subpanel. Supported only 
for strings, where WIDTH= (or W=) is specified. Places left and right arrows in the column 
heading. Pressing PF10 or PF11 in the data area of a lateral data scroll column also performs 
lateral data scrolling for just that column. For example, the following subpanel definition:

DISPLAYCOLS='HUBNAME(W=20,SCROLL.)
DRAIPAD(IPV6,W=16,SCROLL),
HUBIPAD(IPV6,W=16,SCROLL),
HUBPORT(ALIGNRIGHT)

produces the following subpanel:

For columns that consist of multiple sub-columns:
VALUE='X'

Display the specified character instead of the actual data value. For example X may be a blank, 
underscore, and so on.

SUBWIDTH=n

For an RLE-Composite column, this specifies the display width of a single sub-column.

SUBGROUP=n

For an RLE-Composite column, this specifies the number of sub-columns to concatenate together.

SUBGAP=n

For an RLE-Composite column, this specifies the number of blanks between sub-groups.

Default value
ALL

DISPLAYOPTION

Removes all units from every column in DISPLAYCOLS.

Default value
NOUNIT

Possible values
NOUNIT

Example

DISPLAYOPTION=NOUNIT

Note: DISPLAYCOLS column(KMGT) overrides a DISPLAYOPTION=NOUNIT statement.
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EXPANDCOLAPS

Determines whether or not the subpanel can be collapsed and expanded. If a subpanel is collapsed, only the 
subpanel heading is displayed.

A value of YES causes a down arrow  to appear in the left corner of the subpanel header. Placing a cursor on 
the down arrow and pressing Enter collapses the panel so only the subpanel heading line is visible, and turns 
the down arrow into a right arrow . Placing the cursor on the right arrow expands the subpanel again.
Possible values

YES, NO

Default values
YES

If Yes is specified, you must specify a subpanel HEADER, so that the expand and collapse icons are available.

Example

EXPANDCOLAPS=YES

enables a subpanel to be collapsed so only the header is displayed, as in the following example where the LPAR 
Utilization subpanel is collapsed:

FILECOMMENTS

Specifies whether to remove comment lines from the auxiliary file.

FILECOMMENTS=KEEP | REMOVE
Possible values

KEEP
Do not remove comment lines from the auxiliary file.

REMOVE
Remove comment lines from the auxiliary file.

Default value
REMOVE
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Example

FILECOMMENTS=REMOVE

FILEDD

This is the Job Control Language (JCL) Data Definition (DD) name of the PDS from which the 'FILENAME' should 
be read. The value must match one of the DD statements in your enhanced 3270UI address space's start up 
JCL.

FILEDD=DDNAME | &NAME
Possible values

DDNAME
Load an auxiliary file from this PDS concatenation.

&NAME
File DDname can be a variable.

Example

FILEDD=RKANWENU

FILENAME

This is the Partitioned Data Set (PDS) member name containing information needed within the subpanel. That 
member can contain things such as a JSON definition of a Status Tree or Help text.

FILENAME=JSONFILE | &NAME
Possible values

JSONFILE
Load an auxiliary file to be used by the REXX EXECs associated with this tree.

&NAME
Filename can be a variable.

Example

FILENAME=KOBSIT01

FILTERCOLS

Specifies columns to which filtering has been or can be applied.

This keyword must be specified after the QUERY statement for the subpanel. Filters are set in the ONENTRY 
stanza of the workspace panel definition, using SET ZFILTERnn commands.
FILTERCOLS=’columnname,columnname’
Possible values

A comma-delimited list of column names, with a maximum of 10 columns.

Default value
None

Example

FILTERCOLS='CICSNAME,SOS,TRANRATE,AIDS,WORKSET,CPUUTIL'
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FILTERNULLVAL

Specifies whether or not predicates in a query should be removed if their values are unresolved variables.

FILTERNULLVAL=KEEP | REMOVE
Possible values

KEEP
Keeps all predicates in a query even if the values of the predicates are unresolved variables.

REMOVE
Removes all predicates in a query if the values of the predicates are unresolved variables.

Default value
KEEP

Example

FILTERNULLVAL=REMOVE

FILTERSTRIP

Specifies whether or not filtering removes all predicates from the existing query.

FILTERSTRIP=YES | NO
Possible values

YES
Filtering removes all predicates except for SYSTEM.PARMA and ORIGINNODE from the existing query.

NO
Filtering retains all existing predicates and dynamically appends the filter predicates.

Default value
NO

Example

FILTERSTRIP=YES

FILTERVIEW

In subpanels that are reusing data from another subpanel, indicates which ZVIEWnn filter definition, or "view", 
to use.

FILTERVIEW=n

Parameters

Possible values
1 to maximum number of possible reuses

Default value
None

See also “FILTERVIEWS” on page 159.

Example

The following subpanel definition describes a subpanel that has 2 filtered views of a single query. The subpanel 
definition uses the FILTERVIEW keyword to indicate what view the subpanel is associated with.
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<SUBPANEL>          Subpanel containing the live query 
NAME=SUBPANEL1
QUERY='SELECT A,B,C FROM APP.TABLENAME'          
/***************************************************/   
FILTERVIEWS=2  Number of filtered views of this query in this workspace 
/***************************************************/        

<SUBPANEL>        Next subpanel 
QUERY=REUSE(SUBPANEL1)         This reaccesses data collected by SUBPANEL1 
/***************************************************/         
FILTERWHERE=LOCAL      
FILTERVIEW=1  ZVIEWnn system variable containing filter predicates   
<ONENTRY>
SET ZVIEW01=AIDS=1,SOS<>NO           Can be set/altered programmatically                   
     
<ONENTRYEND>
/***************************************************

<SUBPANEL>                  Next subpanel 
QUERY=REUSE(SUBPANEL1)         This reaccesses data collected by SUBPANEL1 
/***************************************************/         
FILTERWHERE=LOCAL      
FILTERVIEW=2          ZVIEWnn system variable containing filter predicates   
<ONENTRY>
SET ZVIEW02=CICSNAME=>CICSABCD,MAXOSCOR<=999    Can be set/altered programmatically         
               
 /***************************************************/        

FILTERVIEWS

Indicates the number of filtered re-uses of the data in this subpanel by other subpanels in this workspace.

FILTERVIEWS=n
Possible values

1 to maximum number of subpanels

Default value
None

See also “FILTERVIEW” on page 158.

Example

See example for “FILTERVIEW” on page 158.

FILTERWHERE

Specifies where filtering is applied.

FILTERWHERE=AGENT | LOCAL

Parameters

Possible values

AGENT
Filtering dynamically modifies the SQL to include filter predicates and drives collection.

LOCAL
Filtering applies filter predicates to an existing row-set.

Default value
AGENT

Example

FILTERWHERE=LOCAL
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FOOTER

Specifies that a footer is displayed at the bottom of a subpanel.

Possible values
A text string of up to 68 characters, enclosed in quotation marks. You can use variables in the string. The 
value is case-sensitive.

Default value
None

Example

FOOTER='Welcome to &ZSYSID'

HEADER (subpanel)

The text to be displayed at the top of the subpanel.

Possible values
Any text up to 63 characters. Any characters that exceed the maximum length are truncated. The text is 
case-sensitive.

Default value
No header is displayed.

Example

HEADER='Details for Address Space'

JOINPREV

Determines whether to adjoin a subpanel to the previous subpanel.

Possible values
YES, NO

Default value
NO

Example

JOINPREV=YES

KEYCOLS

Creates a variable of the same name for any columns in a query and assigns the value of the variable to this 
name. Creating a variable allows fields that uniquely identify a row of data to be saved for a subsequent query 
(drilldown) using that row of data. KEYCOLS is invoked only after a row of data is selected. This setting must be 
specified after the subpanel's QUERY statement.

Possible values
ALL
displays all the columns specified in the query.

One or more column names specified in the query
Use a comma-delimited list to specify more than one column name. Enclose the list in quotation marks.

Note: Using ALL results in increased overhead.
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Default value
None

Example

KEYCOLS='HUBNAME, LPAR, TRANSID'

allows these variables to be used in a future query such as:

SELECT ... WHERE HUBNAME=&HUBNAME AND LPAR=&LPAR AND TRANSID=&TRANSID

LINES

Determines the number of data rows displayed in a subpanel. The value can be expressed as an absolute 
number or as percentage of the available workspace, or can be set to adjust dynamically to the data and space 
available.

Possible values

An integer in the range 1 - 56
The number of rows of data requested. Six lines are dedicated to the workspace header, including 
subpanel header, column headings, and separator lines.

A percentage in the range 1% - 100%

DYNAMIC
The subpanel uses the available space of the 3270 session.
The first subpanel is allocated as many rows as it has data. Each subsequent panel is allocated as many 
of the remaining lines as are available.

Default value
DYNAMIC

Examples

LINES=33% or LINES=10

MINMAX

Determines whether or not the subpanel can be minimized, maximized, and closed.

Possible values
YES, NO

Default value
YES

If Yes is specified, you must specify a subpanel HEADER, so that the minimize and maximize icons are available.

Example

MINMAX=YES displays the minimize, maximize, and close boxes in the upper right corner of the subpanel.

Note: Maximize is currently disabled.
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•

MODE (subpanel)

Indicates that a subpanel should not be displayed. This keyword is used to "hide" a subpanel that is used to run 
a query, establish variables, or perform an action required by a subsequent panel.

MODE=SILENT

NAME

Assigns a unique name to a subpanel. Naming a panel allows you to reuse its query.

A subpanel name is 3 to 8 characters, beginning with an uppercase alphabetical character.

Example

The following example shows four subpanel definitions with each panel assigned a distinct name (ALPHA, BETA, 
GAMMA, and DELTA).

<SUBPANEL>         This is subpanel #1 with a query 
NAME=ALPHA         This is its name 
QUERY="SELECT ......... 

<SUBPANEL>         This is subpanel #2 with a query 
NAME=BETA          This is its name 
QUERY="SELECT ......... 

<SUBPANEL>         This is subpanel #3 with no query 
NAME=GAMMA         This is its name 
QUERY=REUSE(ALPHA) Re-using first query 

<SUBPANEL>         This is sub-panel #4 with no query 
NAME=DELTA         This is its name 
QUERY=REUSE(BETA)  Re-using second query

PARTIALCOLS

The dynamic columns feature attempts to put as much information on the screen as possible, which can result 
in the rightmost column being displayed as only a partial column. Use the scroll bar to see the rest of the 
column. If you would rather not see a partial column, code PARTIALCOLS=NO .

Possible values
YES, NO

Default value
YES

Example

PARTIALCOLS=NO

QUERY

The SQL query that will be used to collect data from the application.

Possible values

A valid SQL SELECT statement

REUSE(subpanel_name)
uses the data retrieved by the query in the specified subpanel.

All columns (attributes) in a query must be from the same table (attribute group), with a maximum of 100 
columns specified on the query. Variables can be used anywhere in the QUERY statement, but only columns 
specified in a preceding panel can be used as variables.
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Default value
None

Example 1: Queries with SELECT statement

QUERY='SELECT CICSPLEX, PLEXCPUP, PLEXSOS, PLEXRATE, PLEXMAXT, 
PLEXENQW, PLEXHSCI, FROM OMCICS.PLEX'

QUERY='SELECT TRANID, TASKNO, RTYPE, RNAME, STATE, CPUTIME, SUSPTIME,
ELAPTIME, USEDA16, USEDB16, ATCHTIME, TIMEOFSU, SUSPDUE, FACTYPE, 
FACID, ORIGTRID, UMBTRID, QUEUE, FIRSTPGM, CURRPGM, USERID, EXECCMD, 
PURGEABL, PURGSTAT, SUSPTYPE, UOWSTATE, 
FROM OMCICS.CICSTRD,                                           
WHERE ORIGINNODE = "&SYSTEMID.&CICSNAME"           
AND CICSTRD.TRANID = "&TRANID"                                  
AND CICSTRD.TASKNO = "&TASKNO"'

Example 2: Reused query

<SUBPANEL>         This is subpanel #1 with a query 
NAME=ALPHA         This is its name 
QUERY="SELECT ......... 

<SUBPANEL>         This is subpanel #2 with a query 
NAME=BETA          This is its name 
QUERY="SELECT ......... 

<SUBPANEL>         This is subpanel #3 with no query 
NAME=GAMMA         This is its name 
QUERY=REUSE(ALPHA) Re-using first query 

QUERYLOGIC

Special logic rules needed to generate the result rows of the associated QUERY statement.

Example

The QUERYLOGIC contents are used only for QUERYTYPE=REXX. The QUERYLOGIC='...' statement controls how 
data columns and rows are combined from the earlier input queries. The QUERYLOGIC references earlier query 
results by specifying the subpanel 'name' of the earlier queries. This means you should supply the NAME=xxx 
statement in each subpanel in your workspace and then reference those NAME values in your final SQL query. 
See the examples below.

The QUERYLOGIC section is interpreted by a program named KOBQRYEX, which is named in the 
QUERY='...AT(KOBQRYEX)...' statement for your output table.

The QUERYLOGIC contains sections marked by left and right braces for every column in your output table. The 
QUERYLOGIC statements must contain the same number of {...} sections as there are columns in the SELECT 
clause of your QUERY statement.

Within each {...} section, there is an 'assignment' statement that contains an output column name, an equal sign 
(=), and then the value to be assigned to the column. For example:

{ROLLAVG=QRMSUCAP.ROLLAVG}

This assignment statement says that the ROLLAVG column in your output table is to get its data from the 
ROLLAVG column in an earlier <SUBPANEL> query. That earlier query is the one contained in the <SUBPANEL> 
that contains a NAME=QRMSUCAP statement.

Note: Variables can be used anywhere in the QUERY statement. Column names do not need to be 
preceded by table names.
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{ROLLAVG    = QRMSUCAP.ROLLAVG    }                                   
    +            +        +                                              
    |            |        |                                              
    |            |        +----------- input column name                 
    |            |                                                       
    |            +-------------------- input subpanel name               
    |                                                                    
    +--------------------------------- output column name  

The earlier subpanel would look like this:

<SUBPANEL>
NAME=QRMSUCAP
...
QUERY="SELECT ROLLAVG, ...
FROM KM5.KM5MSUCAP WHERE SYSTEM.PARMA('NODELIST','*MVS_SYSTEM',11)
AND RECTYPE = 1 ORDER BY PCTMSUCP DESC"
...
<SUBPANELEND>

That assignment statement in the QUERYLOGIC is simply copying a column value from one of the input tables 
into a column of your output table.

Possible Values
See examples below and the online Help information within the Enhanced 3270 User Interface.

Default Value
None

Example:

   QUERYLOGIC="                                                      
   {ROLLAVG    = QRMSUCAP.ROLLAVG    }                               
   {LPARCAPLIM = QRMSUCAP.LPARCAPLIM }                               
   {PCTMSUCP   = QRMSUCAP.PCTMSUCP   }                               
   {SMFID      = QRSYSCFG.SMFID[ORIGINNODE=QRMSUCAP.ORIGINNODE]    } 
   {LPARNAME   = QRSYSCFG.LPARNAME[ORIGINNODE=QRMSUCAP.ORIGINNODE] } 
   {PLXNAME    = QRSYSCFG.PLXNAME[ORIGINNODE=QRMSUCAP.ORIGINNODE]  } 
   "                                                                 

QUERYTIMEOUT

Specifies the amount of time, in seconds, that can elapse before a query expires if no data is returned. The 
default is 10 seconds.

Possible values
1 - 99

Default value
10

Example

QUERYTIMEOUT=30

QUERYTYPE

The type of query to be used. This setting is valid only if QUERYMODE=LIVE.

Possible values
REGISTRY
ROUTER
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INTERNAL
PDS
REXX

Default value
ROUTER

Example

QUERYTYPE=ROUTER

QUERYWHEN (subpanel)

Forces data collection when the default behavior is to not drive data collection, or surpresses collection until 
user types in information.

QUERYWHEN= [ENTER | RETURN | MIN | COLLAPSE | ZQUERY]
Possible values

ENTER
Drives query when Enter key is pressed

RETURN
Drives query when user returns to the workspace.

MIN
Drives query when subpanel is minimized.

COLLAPSE
Drives query when subpanel is collapsed.

ZQUERY
Suppresses a query until the user types something in, even when the Enter key has been pressed. For 
example, you might want to suppress a Take Action command or Get Response query until the user 
has actually entered some kind of command. So, the REXX EXEC that builds the data field used in the 
query will also set the variable ZQUERY=YES. The subpanel in question is be coded with 
QUERYWHEN=ZQUERY, so it will only be driven when the variable is set (that is, a positive value like 
YES). If ZQUERY is null, the query is not driven.

Default value
By default, no data collection is driven when subpanels are scrolled, expanded, collapsed, or minimized. No 
collection is driven during when pulldown or popup panels are being displayed, and no collection is driven 
during backward navigation.

Example

QUERYWHEN=COLLAPSE

SCROLLBAR

Determines whether the subpanel displays the right, left, up, and down arrows for scrolling. This setting applies 
only to SUMMARY type displays.

Possible values
YES, NO

Default value
YES

Example

SCROLLBAR=YES displays
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SCROLLCOLS

Suppresses column FROM TO indicators if only one column is displayed and no scrolling is required.

SCROLLCOLS=NO

SCROLLROWS

Suppresses row FROM TO indicators if only one row is displayed and no scrolling is required.

SCROLLROWS=NO

SELECTROW

This is a formula that controls the selectability of each row in the subpanel (whether an action command is 
allowed for the row, as indicated by an underscore character). For each row of data in the subpanel, the value of 
the specified column is compared against a constant value you supply. If the comparison between the column's 
value and the constant value is true, then the row is selectable. The value may be a string enclosed in single or 
double quotes or a decimal integer value.

For TYPE=TREE subpanels, the allowed formats are:
SELECTROW=column_name>value

SELECTROW=column_name<value

SELECTROW=column_name>=value

SELECTROW=column_name<=value

SELECTROW=column_name=value

SELECTROW=column_name<>value

SELECTROW=column_name\=value

SKIP

The number of rows to skip before the first data row.

Possible values
0 - 2

Default value
0

Example

SKIP=1

SORTCOLS

Lists the columns that are returned from the QUERY command that are eligible to be sorted. This value must be 
specified after the subpanel's QUERY statement.

Possible values

ALL (displays all columns specified in the query)

A comma-separated list of column names specified in the query, enclosed in single quotes. Up to 30 
column names can be specified.

Note: The number of columns to be sorted can have performance implications for loading a workspace. 
See “Workspace sort columns” on page 78 for considerations related to the SORTCOLS keyword.
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• None

Default value
None

Example

SORTCOLS='CICSPLEX,PLEXRATE,PLEXCPUP'

SPACE

The number of blank lines between rows of data.

Possible values
0-2, optionally followed by the ONBREAK control (ONBREAK=columnname). The ONBREAK control indicates 
that a space should be inserted only when the value in a particular column changes in the following row.

Default value
0

Example

SPACE=1,ONBREAK=UOWID

STARTCOLAPS

Determines whether or not the subpanel is collapsed when the workspace is initialized.

Possible values
YES, NO

Default value
NO

Example

STARTCOLAPS=YES

STARTMIN

Determines whether or not the subpanel is minimized when the workspace is initialized.

Possible values
YES, NO

Default value
NO

Sample

STARTMIN=YES

STATICCOLS

Specifies the number of static columns of a subpanel. These columns stay in place while a user scrolls right or 
left. This setting applies only to SUMMARY type subpanels and must be specified after the subpanel's QUERY 
statement. Applies to the column order indicated in the DISPLAYCOLS statement, unless DISPLAYCOLS is ALL, 
in which case the order of the columns is the same as specified in the query.

Possible values
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A number in the range 0–n, where n is the maximum number of columns that will fit on the screen, minus 1. 
If the number of static columns exceeds the screen capacity, scrolling is disabled.

Default value
0

Example

STATICCOLS=2

STATUSCOLS

Specifies which columns in a summary are assessed for status. This setting must be specified after the 
subpanel's QUERY statement.

Possible values
ALL
Names of one or more columns returned by the QUERY command. Use a comma-delimited list for more 
than one name, enclosed in quotation marks.

NO

Default value
None

Sample

STATUSCOLS='PAGERATE,CPUUTIL'

TEXT

Specify the content of subpanels of TYPE=TEXT.

The text that follows TEXT= can include a small set of HTML and proprietary markup tags (see “Tags for 
formatting text” on page 181). If the text consists of more that one word, it must be enclosed in single quotation 
marks. Variables can be used in the text.

Example

The following definition illustrates the use of HTML and proprietary tags in the definition of a subpanel:

 <SUBPANEL>
TYPE=TEXT                                                          
MINMAX=NO                                                          
EXPANDCOLAPS=N                                                     
BOXBOTTOM=NO                                                       
TEXT='<color=yellow
<H1><center>Existing Hub Connection Unavailable</H1></color>
<br>
Your current profile
<color=white>(&ZPROFILE)</color>
specified TEMS
<color=white>&ZHUBNAME</color>
using port number
<color=white>&ZHUBPORT.</color>

Important: Using ALL results in increased overhead. Use ALL only for Overview-type subpanels, if at 
all.

Tip: Using NO bypasses assessing status for the subpanel, reducing overhead.
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The initial attempt to contact it has failed                       
for one of the following reasons:
<ul>
<li>It is no longer running or online </li>
<li>Some of the above information is no longer valid</li>
</ul>
<p>
This Connectivity dialog will assist you in locating all available 
TEMS data sources within your Sysplex.                             
Select the
<color=white>NEXT</color>
pushbutton to proceed. If your 3270 emulator is not                
enabled for mouse click operations,                                
place your cursor on the NEXT pushbutton and press ENTER.
<br>'        

produces the following subpanel:

TOFROMHEADER

Determines whether to display a header that indicates how many rows and columns the subpanel is displaying, 
out of the total number of rows and columns. Applicable only to SUMMARY type displays.

Possible values
YES, NO

Default value
YES

Example

TOFROMHEADER=YES shows

TREEBRANCHES

Indicates whether or not to display branches of tree.

Possible values
VISIBLE, INVISIBLE

Default value
VISIBLE

Example

TREEBRANCHES=VISIBLE

TREEBUTTONS

Specifies whether or not the Expand/Collapse push-buttons should be displayed.

TREEBUTTONS=YES | NO
Possible values
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YES
Keeps the Expand/Collapse buttons displayed.

NO
Removes the Expand/Collapse buttons.

Default value
YES

Example

TREEBUTTONS=YES

TREECOLLAPSE

Determines whether tree is collapsed or open; and if open, to what level.

Possible values
ALL, NONE, n, where ALL means that the tree is totally collapsed, NONE means that the tree is totally open, 
and n is an integer that specifies the collapsed tree level on entry into the workspace. A value of 0 indicates 
that the tree is totally open.

Default value
NONE or 0

Example

TREECOLLAPSE=NONE

TREEHSEP1

Specifies the number of blanks between tree widget and the node icon.

TREEHSEP1=n
Default value

1

Example

TREEHSEP1=1

TREEHSEP2

Specifies the number of blanks between tree icon and node name.

TREEHSEP2=n
Default value

2

Example

TREEHSEP2=2

TREEICON

Specifies whether or not to display an icon associated with this tree node.

TREEICON=YES | NO
Possible values
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YES
Display an icon to be associated with this tree node.

NO
Do not display an icon to be associated with this tree node.

Default value
NO

Example

TREEICON=NO

TREELEVEL

This is the name of one of the columns within the QUERY="..." statement that contains an integer value that 
defines the 'tree level' for a Status Tree or a Help Tree. The TREELEVEL column you select controls the visual 
hierarchy of the branches (their indentation level).

TREELEVEL=column_name

Example

TREELEVEL=LEVEL

TREEROOT

Indicates which tree level represents the root level.

Possible values
0, 1

Default value
0

Example

TREEROOT=0

TREEROWTYPE

This is the name of one of the columns within the QUERY="..." statement that contains an integer value that 
defines the 'row type' for a Status Tree or a Help Tree. The TREEROWTYPE column you select controls the types 
of actions that are allowed for particular rows in a Tree.

TREEROWTYPE=column_name

Example

TREEROWTYPE=ROWTYPE

TREESTATE

This is the name of one of the columns within the QUERY="..." statement whose value is used to color an 
optional icon that appears near the left edge of the tree.

TREESTATE=column_name

Example

TREESTATE=REALTIME
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TREEWIDGET

Specifies whether to color code the tree widgets in reverse video white.

Possible values
HIGHLIGHT, NOHIGHLIGHT, where NOHIGHLIGHT specifies to color code the tree widgets in reverse video 
white.

Default value
HIGHLIGHT

Example

TREEWIDGET=HIGHLIGHT

TYPE

Determines the formatting of the subpanel.

TYPE=[SUMMARY|DETAIL|TEXT|ACTION|PUSHBUTTON|TABDIALOG|TREE]
Possible values

SUMMARY
Displays queried data for multiple targets (such as plexes, LPARs, and address spaces) in tabular form, 
with each column displaying the values for a particular property, or attribute, for each target (“Figure: 
Example of a SUMMARY subpanel” on page 172).

DETAIL
Displays queried data for a selected target in columns of attribute/value pairs (“Figure: Example of a 
DETAIL subpanel” on page 173). In detail subpanels, all data is right-aligned.

TEXT
Allows use of freeform text and a subset of HTML formatting tags. Text is entered using the TEXT=
keyword. No QUERY or QUERY-related keywords can be used with subpanels of this type.

ACTION

For use with workspaces specified MODE=SILENT. Allows actions, like queries, to be executed from 
the panel, without the users seeing the panel. The panel is invoked as many times as selections are 
passed to it.

PUSHBUTTON
Use this type to code one or more reverse video push-buttons. This type is a special version of 
<ISPFPANEL> that supports the PS (Point and Shoot) field type.

TABDIALOG
Use this type value to implement subpanel tabs. This type require the special keyword TAB. An example 
is shown in “Figure: Example of a TABDIALOG subpanel definition and the resulting subpanel” on page 
173.

TREE
Sub-panel will render display column #1 as a tree structure.

Default value
SUMMARY

Example 1: TYPE=SUMMARY

Specifying TYPE=SUMMARY results in a subpanel like the one in “Figure: Example of a SUMMARY subpanel” on 
page 172:



173

Figure 94: Example of a SUMMARY subpanel

Example 2: TYPE=DETAIL

Specifying TYPE=DETAIL results in a subpanel like the one in “Figure: Example of a DETAIL subpanel” on page 
173.

Figure 95: Example of a DETAIL subpanel

Example 3: TYPE=TEXT

Specifying TYPE=TEXT results in a subpanel like the one shown in “Figure: Example of a TEXT subpanel” on 
page 173.

Figure 96: Example of a TEXT subpanel

Example 4: TYPE=ACTION

Example 5: TYPE=PUSHBUTTON

Specifying TYPE=PUSHBUTTON results in a subpanel like the one shown in “Figure: Example of a PUSHBUTTON 
subpanel” on page 173.

Figure 97: Example of a PUSHBUTTON subpanel

Example 6: TYPE=TABDIALOG

“Figure: Example of a TABDIALOG subpanel definition and the resulting subpanel” on page 173 specified by 
using TYPE=TABDIALOG.

Figure 98: Example of a TABDIALOG subpanel definition and the resulting subpanel
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<SUBPANEL>
TYPE=TABDIALOG               
TAB="Date/Time",KOBPRFDT     
TAB="Colors",KOBPRFCL        
TAB="Session/Logon",KOBPRFSS 
TAB="Auto/Update",KOBPRFAU   
TAB="Hub Check",KOBPRFHB 
<SUBPANELEND>

Example 7: TYPE=TREE

Specifying TYPE=TREE results in a subpanel like the one shown in Example of a TREE subpanel.

Figure 99: Example of a TREE subpanel

VSEPARATORS

Determines whether or not a subpanel displays vertical separators between columns .

Possible values
YES, NO

Default value
YES

Example

VSEPARATORS=NO

WHENDATA

Determines whether to expand, maximize, or shrink a subpanel when the subpanel has data to display.

Possible values

Expand

Maximize

Shrink. The row count of the subpanel is dynamically decreased to the number of rows of collected 
data and subpanel is automatically expanded if collapsed, or maximized if minimized.

Default value
Shrink

Note: If Expand is specified, code EXPANDCOLLAPSE=Y, so users can collapse the subpanel.
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Example

WHENDATA=M

WHENNODATA

Determines whether to collapse, minimize, or shrink a subpanel when the subpanel has no data to display.

Possible values

Collapse

Minimize

End (close)
If no data is retrieved on the initial query or entry to the workspace, the subpanel is "deleted" and any 
query it contains is not run again on a refresh until the panel is reentered.

Shrink (the number of rows in the subpanel is dynamically decreased to null when there is no data).

Hide. Use instead of End if you want the subpanel to reappear when data is available again.

Default value
Collapse

Example

WHENNODATA=COLLAPSE

ZOOMCOLS

Specifies the columns that can be selected for cursor-sensitive navigation (zooming) to another panel. The 
target panel ID for each column is specified immediately after the column name. In columns that are zoomable, 
the text is white. This setting must be specified after the subpanel's QUERY statement.

When the cursor is placed on the field for which zooming is defined and user presses ENTER, forward navigation 
occurs, except when column 1 in a summary panel is selectable. In this case, the subpanel ACTION statements 
define the destination. By default, S and its associated panel ID are used when column 1 is implicitly selected, 
but a workspace developer can indicate DEFAULT on any action statement.
Possible values

None

A comma-delimited list of names of one or more columns specified in DISPLAYCOLS, followed by the 
name of a target workspace in parentheses

In a PROLOG or EPILOG stanza, a variable

Default value
None

Example 1: multiple columns with multiple destinations

In this example, multiple columns are assigned multiple destinations:

ZOOMCOLS='CICSPLEX(KOCCICS1),PLEXRATE(KOCOVER1),PLEXCPUP(KOCTRAN1)'

Note: If Collapse is specified, code EXPANDCOLLAPSE=Y so users can expand the subpanel.



176

Example 2: a variable in an EPILOG stanza

In this example, a developer-supplied REXX EXEC called MYEXEC sets a variable X = 
COLUMN1(DEST01),COLUMN2(DEST02) inside of MYEXEC. The zoom is then dynamically assigned to those 
columns.

<EPILOG>
EXEC MYEXEC 
ZOOMCOLS=&X
<EPILOGEND>

Popup keywords
The keywords described in this section are used in popup panels.

DISPLAYWHEN

Causes a popup panel to be redisplayed when you return to the popup panel from a called workspace or action.

DISPLAYWHEN=RETURN

Example

The popup panel that lists the filter summary uses DISPLAYWHEN to redisplay the list when the Filter Details 
popup panel is closed. The filter popup panel also uses QUERYWHEN to redisplay the calling workspace:

QUERYWHEN (popup panel)

In a popup panel, forces data collection in the calling workspace when the popup panelis closed.

QUERYWHEN=RETURN
By default, data collection occurs only when the Enter key is pressed and no screen operations are requested. 
(Screen operations include pulldown or popup panels, collapsing and expanding, minimizing and maximizing, 
scrolling, or backwards navigation.)

Variables in panel definitions
Some panel definition keywords (such as HEADER, TRAILER, QUERY, ACTION) allow the use of variables. The 
enhanced 3270 user interface supports both system and user-defined variables.

Variable representation
The enhanced 3270 user interface supports the standard z/OS variable format: &varname

For example,

HEADER='PLEX:&ZSYSPLEX VER(&ZOMEGVRM) LPAR:&ZSYSID'

which results in the following string appearing in the header:

PLEX:LPAR400J VER(V700) LPAR:SP22

.
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System variables
The enhanced 3270 user interface supports the use of both ISPF and OMEGAMON-specific system variables. 
These variables are discovered automatically.

“ISPF variables supported by the enhanced 3270 interface” on page 177 lists the supported ISPF variables. 
These variables are documented in ISPF Reference Summary (SC34-4816), Chapter 6. System Variables.

Table 9: ISPF variables supported by the enhanced 3270 interface

Variable Name Description

ZUSER User ID

ZSYSID LPAR name

ZSYSPLEX Sysplex name

ZAPPLID Applid of application

ZIPADDR IP address

ZIPPORT IP port

ZSPLIT Split-screen mode in effect (YES or NO)

ZTS Multicultural support time separator character (:)

ZSCREENW Screen width

ZSCREEND Screen length

ZDATEF Date MM/DD/YYYY

ZSTDYEAR 4-digit year YYYY

ZYEAR 2-digit year YY

ZMONTH 2-digit month MM

ZDAY 2-digit day DD

ZDAYOFWK Full word day of week

ZJDATE Julian date YY.DDD

ZJ4DATE Julian date with 4 digit year YYYY.DDD

ZCS Currency symbol

ZTHS Thousands separator

ZTIME 5-digit time HH:MMM

ZCMDLINE Contains whatever is entered on the command line, 
in all upper case.

ZCMDLINEMC Contains whatever is entered on the command line, 
in mixed case.

“Supported OMEGAMON variables” on page 177 lists the OMEGAMON-specific variables that are supported by 
the enhanced 3270 user interface.

Table 10: Supported OMEGAMON variables

Variable name Description

ZJOBNAME Started task name

ZVTAMNETID VTAM net ID

ZVTAMSSCP VTAM subsystem control point

ZIPHOSTNAME IP host name

ZOMEGVRM OMEGAMON version level

ZOMEGLVL OMEGAMON build level

ZDOW 3-letter day of week
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Variable name Description

ZACTIONFILTER Optionally set by a REXX EXEC to an array of one or 
more alphanumeric characters that map to the 
ACTION command characters.

ZFILTERnn Specifies the filter for filtering at the agent (where 
FILTERWHERE=AGENT). nn is a 2-digit number from 
01 to 10. The value of the variable must be a column 
name followed by a comparator, followed by a value.
Column names can be 1 to 10 characters, with no 
trailing blanks. Comparators can be one of the 
following four symbols: =, <, >, or <>, with no 
trailing blanks. Values can be alphanumeric and can 
currently support a trailing asterisk.

For example:

SET ZFILTER01=CICSNAME=C*
SET ZFILTER02=SOS=1
SET ZFILTER03=TASKS>100

ZHEADER For header in message popup panels. Supports up to 
46 bytes. For use with ZMESSAGE.

ZMESSAGE General purpose message service for display on 
screen. Supports up to 256 bytes. For use with 
ZHEADER.

ZOMEGLOCK1 If the value is set to N, unlocks the plex field in the 
workspace so the value can be overtyped. As you 
navigate forward, the new value is perpetuated and 
the field is locked again.

ZOMEGLOCK2 If the value is set to N, unlocks the system field in the 
workspace so the value can be overtyped. As you 
navigate forward, the new value is perpetuated and 
the field is locked again.

ZOMEGNAV1 The plex for which data is being displayed.

ZOMEGNAV2 The system, region, or subsystem for which data is 
being displayed.

ZQUERY Engages or disengages a query being driven. The 
REXX EXEC that builds the data field used in the 
query also sets ZQUERY=YES. The subpanel is coded 
with QUERYWHEN=ZQUERY so it is driven only when 
the variable is set (that is, with a positive value like 
YES). If ZQUERY is null, the query is not driven.

ZSELACTION Passed into a REXX EXEC in an ONACTION stanza, 
contains the single character entered by the user. 
(May be null if user pressed PF3.)

ZVIEWSnn Specifies the filter for filtering existing data (where 
FILTERWHERE=LOCAL). nn is a 2-digit number from 
01 to 10. The value of the variable must be a column 
name followed by a comparator, followed by a value.
Column names can be 1 to 10 characters, with no 
trailing blanks. Comparators can be one of the 
following four symbols: =, <, >, or <>, with no 
trailing blanks. Values can be alphanumeric.

For example:

SET ZVIEW01=CICSNAME=CICSABCD
SET ZVIEWS02=SOS=1
SET ZVIEWS03=TASKS>100



179

•

•

•

•

•

Variable name Description

ZCLRBOXL Color variable for box lines.

ZCLRABAR Color variable for the action bar.

ZCLRCMDL Color variable for command line

ZCLRABKW Color variable for action bar keywords

ZCLRPANH Color variable for panel header

ZCLRPKEY Color variable for panel keywords

ZCLRPID Color variable for panel ID

ZCLRPANT Color variable for panel trailer

ZCLRSUBH Color variable for subpanel header

ZCLRTEXT Color variable for standard text

ZCLRCOLH Color variable for column headers

ZCLRPB Color variable for push buttons

ZCLRGOOD Color variable for status OK/Good

ZCLRWARN Color variable for status Warning/caution

ZCLRERRC Color variable for status Error/Critical

User-defined variables
The enhanced 3270 user interface supports the use of user-defined variables. Variables can be created and set 
anywhere in a workspace definition using a SET statement. In addition, columns names specified using the 
KEYCOLS keyword in a previously invoked workspace can be used as variables in subsequent panels, without 
using a SET statement.

Variables can be set anywhere in a definition, but they are processed differently depending upon where the SET 
statement appears.

Variables set in an ALIASCOMMANDS stanza can be used in fastpath commands from that workspace, if 
SCOPE=LOCAL, or from any workspace after they have been defined until they are deleted, if 
SCOPE=GLOBAL.

Variables set in PROLOG stanzas are assigned during PROLOG execution. Assignment occurs after any 
imbeds and before data collection. If a REXX exec is also present, the SET commands are evaluated 
according to their placement, before, or after, the REXX EXEC call.

Variables set in EPILOG stanzas are assigned during EPILOG execution. Assignment occurs after data 
collection or status assessment and before the screen is constructed. If a REXX exec is also present, the 
SET commands are evaluated according to their placement, before, or after, the REXX EXEC call.

Variables set in an ONACTION stanza are executed directly after key column assignment, and just before 
any navigation that results from an action command. (Key columns are assigned before navigating forward 
if any action command is driven from a particular subpanel.)

Variables set anywhere else are processed when the workspace is loaded.

Variable names may consist of up to 16 characters.

Variable data may consist of up to 64 characters and can be set to specified values or to other variables. For 
example:

Note: Use color variables instead of hard coding a color in an ISPF attribute

Note: Do not create variables that begin with Z (or z). That letter is reserved for system variables.
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SET &var1=mytext
SET &var2=&colname

There is a limit of 20 deferred SET commands for a workspace. (Deferred SET commands are those in PROLOG, 
EPILOG, and ONACTION stanzas.)

Example: column names as variables

Column names specified using the KEYCOLS keyword in a previously invoked panel can be used as variables in 
subsequent panel definitions, without using a SET statement. For example, if the following column names have 
been set in a previous panel:

KEYCOLS='TRANID,USERID,TASKNO,TERMID,CICSNAME,SYSTEMID,ORIGINNODE'

one or more of these names can be used as variables in a header, query, or any text in a panel navigated to from 
the first panel. For example:

HEADER='Details for Transaction &TRANID Task &TASKNO'  
QUERY='SELECT TRANID, TASKNO, RTYPE, RNAME, STATE, CPUTIME, .SUSPTIME,   
ELAPTIME, CICSTRD.USEDA16, USEDB16,                
ATCHTIME, TIMEOFSU, SUSPDUE, FACTYPE, FACID, ORIGTRID, UMBTRID, 
QUEUE, FIRSTPGM, CURRPGM, USERID, EXECCMD, PURGEABL, PURGSTAT,
SUSPTYPE, UOWSTATE, 
FROM OMCICS.CICSTRD,
WHERE ORIGINNODE = "&SYSTEMID.&CICSNAME"
AND CICSTRD.TRANID = "&TRANID"
AND CICSTRD.TASKNO = "&TASKNO"'.

Supported ISPF statements
The enhanced 3270 user interface supports a subset of ISPF statements.

The following statements are supported in an ISPF stanza in a subpanel or popup panel:

)LIST
)BODY
)INIT
)ATTR
)PROC
)PNTS
)END

LIST supports the following arguments:
POPUPACTION

Lists the actions in a subpanel in the popup panel definition.

PANELACTION

Lists the actions in the subpanel from which the popup panel was invoked.

DYNAMIC

Lists actions from dynamically generated list, such as a list generated by a REXX exec.

TRACETABLE

STACK

BODY supports the following arguments:
WIDTH (n)

WINDOW (DYNAMIC|width,depth)

)ATTR supports the following field types:

INPUT

OUTPUT
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TEXT

PS (Point-and-Shoot)

)ATTR supports the following keywords:

CAPS

COLOR

HILITE

JUST

INTENS

SKIP

)INIT supports up to 32 system (Z) variables.

Tags for formatting text
The enhanced 3270 user interface supports the use of a small subset of HTML tags and some proprietary tags 
that can be used to format the text specified using the TEXT keyword in a subpanel of TYPE=TEXT.

Note that formatting is not required. Freeform text is supported in these subpanels.

HTML tags
The enhanced 3270 user interface supports use of the HTML tags shown in “Supported HTML tags” on page 
181.

Table 11: Supported HTML tags

Type Tagging Description

Heading <h1></h1> Text enclosed by h1 tags is displayed in all capitals and 
is followed by a line break. The text can be centered 
using a <center> tag. For example: <h1><center>TEXT 
IN CAPS</h1>

Paragraph <p></p> Inserts two line breaks (that is, an empty line) before 
the text.

Unordered 
list

<ul></ul> Displays the list items between the tags in a bulleted 
list.

Ordered list <ol></ol> Displays the list items between the tags in a 
sequentially numbered list.

List items <li></li> Contains the text for an entry in a bulleted or numbered 
list.

Line break <br> Forces a line break. Can be used to create an empty 
line.

Hypertext 
link

<a href="panelid"></a> Text enclosed by the <a></a> (anchor) tags is white 
(selectable) and underlined. Cursoring over the text and 
pressing Enter displays the workspace referenced. Only 
links to other workspace panels are supported.

Emphasis <em></em> Text enclosed by the tags is underlined.

Comment <!– –> Text is not displayed.

Spaces between words within tags are preserved, so spaces can be used to align text.

Additional tags
The enhanced 3270 user interface supports the proprietary formatting tags shown in “Non-HTML formatting 
tags” on page 182.
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Table 12: Non-HTML formatting tags

Type Tagging Description

Color <color=color></color> Can be placed around any word or element. The color is 
in effect until the end tag or the end of the subpanel if 
there is no end tag. Any color name supported by the 
3270 interface is supported.

Alignment <center> Centers text. The center alignment is in effect until the 
end tag for the element.

Example
The following example shows the use of the TEXT keyword to specify the text to appear in the subpanel.

/********************************************************************/
/*                                                                  
/*        TEXT SUBPANEL                   
/*                                                                 
/********************************************************************/
<WORKSPACE>

 <SUBPANEL>
 TYPE=TEXT                                                              

HEADER='Help for &INSPECT' 

TEXT='<h1><center>This is a centered H1 Header</h1>
<br>
Welcome to SYSPLEX <color=yellow>&ZSYSPLEX</color>. 
<WORKSPACEEND>

Associating a mouse click with the Enter key
Many 3270 emulators support an option to associate a mouse click with the Enter key.

About this task
You might prefer to associate a mouse click with the Enter key in your 3270 emulator session. After you make 
this association, in contexts where you normally “click and enter”, you can instead “double click.”

Procedure
Locatepoint and selectormouse clickconfiguration options for your emulator.
For example, in an IBM Personal Communications emulator window, select Edit › Preferences › Hotspots. 
The Hotspots Setup window opens. Select ENTER at cursor position and click OK.

Result
You can now “double click” with your mouse in place of clicking and pressing Enter for your 3270 emulator 
session.

Accessibility features for OMEGAMON® Enhanced 3270 user 
interface

Accessibility features help users who have a disability, such as restricted mobility or limited vision, to use 
information technology products successfully.

The major accessibility features in this product enable users in the following ways:
Use assistive technologies, such as screen-reader software and digital speech synthesizer, to hear what is 
displayed on the screen. Consult the product documentation of the assistive technology for details on using 
those technologies with this product.

Operate specific or equivalent features using only the keyboard.

Magnify what is displayed on the screen.

In addition, the product documentation was modified to include the following features to aid accessibility:
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All documentation is available in both HTML and convertible PDF formats to give the maximum opportunity 
for users to apply screen-reader software.

All images in the documentation are provided with alternative text so that users with vision impairments 
can understand the contents of the images.

Accessibility features
The following list includes the major accessibility features supported by the OMEGAMON® Enhanced 3270 user 
interface:

Keyboard-only operation

Interfaces that are commonly used by screen readers

Keys that are discernible by touch but do not activate just by touching them

Industry-standard devices for ports and connectors

The attachment of alternative input and output devices

The OMEGAMON® Enhanced 3270 user interface guide and its related publications are accessibility-enabled.

Navigating the interface using the keyboard
Standard shortcut and accelerator keys are used by the product and are documented by the terminal emulator 
product. See the documentation provided by your terminal emulator for more information.

Magnifying what is displayed on the screen
The Enhanced 3270 user interface can be used with any 3270 emulator that supports the APL character set. 
The interface supports screen sizes of 24 x 80, 32 x 80, 43 x 80, 27 x 132, and 62 x 160. Choose the resolution 
that best suits your requirements. PTF UA76751 enables some 3270 emulators that do not support all APF 
characters to be used for the Enhanced 3270 user interface.

Interface information
The OMEGAMON® Enhanced 3270 user interface supports all the accessibility features supported by your 
emulator. If you are using IBM® Personal Communications, for information on its accessibility features, see 
Using Emulator Sessions. If you are using a third-party emulator, see the documentation for that product for 
accessibility information.

IBM® and accessibility
See the IBM® Human Ability and Accessibility Center for more information about the commitment that IBM® has 
to accessibility.

https://www.ibm.com/docs/en/SSEQ5Y_latest/info_docs/useses.html
http://www.ibm.com/able/index.html


184

Notices
This information was developed for products and services offered in the U.S.A. IBM® may not offer the products, 
services, or features discussed in this document in other countries. Consult your local IBM® representative for 
information on the products and services currently available in your area. Any reference to an IBM® product, 
program, or service is not intended to state or imply that only that IBM® product, program, or service may be 
used. Any functionally equivalent product, program, or service that does not infringe any IBM® intellectual 
property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation 
of any non-IBM product, program, or service.

IBM® may have patents or pending patent applications covering subject matter described in this document. The 
furnishing of this document does not give you any license to these patents. You can send license inquiries, in 
writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM® Intellectual Property 
Department in your country or send inquiries, in writing, to:
Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions 
are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT 
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